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Preface 

Vocational Education is a dynamic and evolving field, and ensuring that every 

student has access to quality learning materials is of paramount importance.  The 

journey of the PSS Central Institute of Vocational Education (PSSCIVE) toward 

producing comprehensive and inclusive study material is rigorous and time-

consuming, requiring thorough research, expert consultation, and publication by 

the National Council of Educational Research and Training (NCERT). However, the 

absence of finalized study material should not impede the educational progress of 

our students. In response to this necessity, we present the draft study material, a 

provisional yet comprehensive guide, designed to bridge the gap between teaching 

and learning, until the official version of the study material is made available by 

the NCERT. The draft study material provides a structured and accessible set of 

materials for teachers and students to utilize in the interim period. The content is 

aligned with the prescribed curriculum to ensure that students remain on track 

with their learning objectives. 

The contents of the modules are curated to provide continuity in education and 

maintain the momentum of teaching-learning in vocational education. It 

encompasses essential concepts and skills aligned with the curriculum and 

educational standards. We extend our gratitude to the academicians, vocational 

educators, subject matter experts, industry experts, academic consultants, and all 

other people who contributed their expertise and insights to the creation of the 

draft study material. 

Teachers are encouraged to use the draft modules of the study material as a guide 

and supplement their teaching with additional resources and activities that cater 

to their students' unique learning styles and needs. Collaboration and feedback are 

vital; therefore, we welcome suggestions for improvement, especially by the 

teachers, in improving upon the content of the study material. 

This material is copyrighted and should not be printed without the permission of 

the NCERT-PSSCIVE.   

 

Deepak Paliwal 

(Joint Director) 

PSSCIVE, Bhopal 

Date: 12 September, 2024 
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Module 1 Rotoscopy Technique 

 

Module Overview  

Rotoscopy is a technique of manually altering film or video footage frame by frame. These 

frames can be painted or traced. It is similar to trace a photograph over a blank paper 

by using carbon paper and then filling colour on it. However, in rotoscopy, you need to 

trace each frame of the video footage to use it in animation and visual effects. If you 

paint the frame, it will be converted into animation. Rotoscoping can also be used in 

visual effect. For this, you have to isolate or extract the object from video frames and 

change the background. To change the background of the main object, first extract the 

object from original video footage and place it on desired background. This is the 

simplest example of visual effects and the technique used to extract the object from 

video footage is called rotoscoping. 

As rotoscoping is the post production technique, it is done after video shooting. Modern 

film and video production are extremely dependent on the art of matte creation or object 

isolation. 

This unit gives an overview about the media and entertainment industry. It explains 

various aspects of its sub-sectors animation and visual effects, which are the part of 

post-production process. Hence the various steps of post-production workflow are 

explained. In Post production workflow, various steps of visual effects such as 

organizing the footage, naming convention and exporting the footage for visual effects 

are discussed. Further the concept of rotoscoping, its origin and use in animation and 

visual effects are explained. Finally, the roles, responsibilities and job opportunity of 

roto-artist are explained. 

 

Learning Outcomes 

After completing this module, you will be able to: 

• Understand the integration of animation and visual effects in storyboarding and their 

impact on the final product. 

• Learn the key stages of post-production and how they refine and finalize visual media. 

• Explore the evolution of rotoscopy and its current and future applications in 

animation and visual effects. 

• Identify the roles and responsibilities of a roto artist in the production pipeline. 

 

Module Structure  

Session 1: Animation and Visual Effects 

Session 2: Post Production Process  

Session 3: Rotoscopy – Past, present and future 

Session 4: Roto Artist – Roles and Responsibility 
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Session 1: Animation and Visual Effects 

One day, Nia went to watch movie ‘Lion King’ with her mother. Nia saw ‘Box Office’ 

written over the ticket counter. She asked her mother, what is the meaning of box office? 

Her mother replied, Box Office means the collection centre of the movie, or it shows total 

earning of the movie. Meanwhile, they entered cinema hall. While watching the movie, 

Nia asked her mother that these Lions are real or fake. Her mother said that these are 

not real Lions, they may be created otherwise may be some sort of animation. (Figure 

1.1) Nia thought, is it same as Chhota Bheem? But it looks so realistic. How is it 

possible? 

 

Fig. 1.1 Nia with her mother 

Let’s find all the answers of the questions, which arises in the mind of little girl Nia. For 

that, we should know about Animation and Visual Effects (VFX). These two fields are 

different, but often used in combination. Most people consider, these two are the same. 

Imagine a waterfall scene of movie Bahubali, do you really believe it exists or a lion in 

‘Life of Pie’, is that real or fake as shown in Figure 1.2. 

 

Fig. 1.2 VFX Scene from movie Life of Pie Courtesy: Fox 2000 pictures 

You will be surprised to know that both doesn’t exist, rather they are created by 

Computer Generated Imagery (CGI). In simple term, it is generated with the help of 

computer software. In this way Nia understood about the Visual Effects (VFX). Let’s 

move towards animation. 

Nia is much familiar with animation. From ‘Tom and Jerry’ to ‘Chhota Bheem’ animation 

cartoon characters are the source of children entertainment as shown in Figure 1.3. 
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Fig. 1.3 Animation Scene from Cartoon series ‘Chhota Bheem’ Courtesy: Green 

gold animation 

Animation is a technique of applying motion and gives realistic effects to painting, 

sketching, drawing or human figure, so that they can move and act as we have seen in 

the real life. Table 1.1 gives some of the difference in Animation and VFX. 

Table 1.1 Differences between Animation and VFX 

 Animation VFX (Visual Effects) 

Definition Animation is the technique of 

designing, drawing, making the 

layout and preparation of a 

photographic sequence to 

combine with multimedia. 

VFX is the technique of actual 

mixing of the special effect shots 

within live action footage. 

Software 2D animation – Toon Boom 

Studio, Adobe Animate. 

3D Animation – Autodesk Maya 

and 3Ds Max. 

Autodesk Maya, 3Ds Max, Foundry’s 

Nuke, Blackmagic fusion, Adobe 

Photoshop, Adobe after effects, 

Silhoutte FX. 

Source Pictures or drawings of puppets. Real things/scenes/ people 

Applications Animation Film, Animated 

Logos, Advertising campaigns, 

TV cartoon series, E-Content 

Films and Documentaries 

Examples Chaar Sahibjade, Chhota 

Bheem, Motu Patlu 

Baahubali the begining, Spiderman, 

Avatar, Pirates of the Caribbean. 

 

More to know … 

2D animation – 2D animation means two-dimensional animation. In this animator 

draw each frame or cell. After that when all frames are completed, the sequence is 

edited and screened at the rate of 24 frames per second. 

3D animation – 3D animation means three-dimensional animation or animating 

objects that appear in a three-dimensional space. They can be rotated and moved like 

real objects. 

Assignment 1 

Identify the following characters and classify them as Animation or VFX. 

Character Image Character Name Film Name Whether animated 
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or VFX Character? 
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Animation and VFX are sub sectors of Media and Entertainment industry. First we will 

discuss about Media and Entertainment. 

1.1 Media and Entertainment 

Generally, people thought media means the News channel, Reporter, Newspaper, 

Hoardings and Movie posters as shown in Figure 1.4. 

 

Fig. 1.4 Man thinking about different media Courtesy: Author 

Media is a tool of mass communication, used to deliver information through various 

channels such as Television, Radio, Newspaper and many more. 
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Entertainment word, immediately refreshes your mood. It may be any games which you 

like to watch or movies that helps you to be relaxed. So, entertainment encompasses 

events that allow peoples to spend a good time. Entertainments include film, games, 

cartoon, television serial and many more. Hence, media and entertainment represent a 

range of fields that can inform, teach and entertain you. 

1.1.2 Media and Entertainment Industry in India 

Media and Entertainment (M&E) industry has multiple sectors namely Movies, 

Television, Print, Music, Radio, Advertising, Gaming, Animation and VFX. (Figure 1.5) 

 

Fig.1.5 Different segments in M&E Industry Courtesy- : KPMG – FICCI Report, 

2018 

The Indian Media and Entertainment (M&E) industry is a booming sector for the 

economy and is making high growth. The M&E industry in India displays the solid 

growth of 13% during the year 2019-20. (Figure 1.6) 

 

Fig. 1.6 Comparison of growth rate, Courtesy: KPMG India analysis, 2019 

Animation and Visual effect (VFX) is also one of the fastest growing sectors of M&E 

Industry. Indian animation and VFX services continued to rise among international 

production houses. They provide a cost efficiency up to 50% compared to other 

countries. Animation and VFX industries have higher growth rate of 18.7% during 

financial year 2018-19 over 2017-18. 

1.1.3 Media and Entertainment Sector growth rate 

At present, India is one of the largest broadcasters in the world with approximately 800 

TV channels, 242 FM channels and over 100 community radio networks working at 

present. Indian film industry is the largest producer of films around the globe with over 

1500-2000 films every year. The Indian M&E industry is growing rapidly. It reached INR 

1.63 trillion, a growth of 13.2% over 2018. With its current trajectory, we expect it to 

grow to INR 2.35 trillion by 2021. (Source: KPMG India analysis, 2019) 
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Table 1.2 Indian Media and Entertainment Industry size 

Overall 

industry size 

(INR billion) 

FY 15 FY 16 FY 17 FY 18 FY 19 Growth in FY19 

over FY18 

CAGR 

(FY15-

FY19) 

Digital 47 65 86 121 173 43.4% 38.5% 

TV 490 552 595 652 714 9.5% 9.9% 

Print 268 288 308 319 333 4.5% 5.6% 

Films 127 137 145 159 183 15.1% 9.6% 

Animation 

and VFX 

47 53 62 74 88 18.7% 17.2% 

Gaming 24 28 32 44 62 41.6% 26.4% 

OOH 22 26 29 32 34 5.0% 11.2% 

Radio 20 23 24 26 28 6.2% 8.6% 

Music 10 11 13 14 17 15.3% 13.0% 

Total 1055 1183 1295 1440 1631 13.2% 11.5% 

The Animation and Visual Effect (VFX) segment witnessed a strong growth of 18.7 

percent in FY-19. Expanding audience for animation content on OTT (Over The Top) and 

rising demand of animation services from non-entertaining sectors such as education 

and healthcare were primary factor of robust growth of animation sub segment. 

The Government of India keeps on pushing the Media and Entertainment industry by 

launching various schemes such as digitizing the cable TV, raising the foreign 

investment from 74 percent to 100 percent in cable and DTH satellite platforms. 

Government has also allotted industry status to the film industry for easy finance. 

More to know … 

OTT – In the field of broadcasting it is known as ‘Over the Top’ content. In OTT the 

content is delivered through Internet connection. 

OOH – It stands for Out-of-Home advertising. It is visual advertising media found 

outside the home, which includes billboards and signs, ads on street furniture like bus 

stops or benches, in transit areas such as airports or train stations, and place-based 

ad media like you might see at a stadium or in the cinema. 

1.2 An Overview of Indian Animation and VFX industry 

Indian Animation Industry enriched by 300 animation, 40 Visual effects and 85 Gaming 

development studios with 15000 plus professionals working in this sector. The Industry 

is continuously providing services to International production houses. India has now 
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became a favorite destination for animation services because of cost efficiency in 

animation services up to 50 percent. 

According to a recent study, after pre-production, 90 percent of American television 

animation work is produced in Asia. Indian animators have also major contribution in 

Hollywood projects like Kung Fu Panda, The Jungle Book and Shaun-The Sheep. Various 

processes like Lighting, Rotoscoping, Matte painting in various Hollywood projects were 

made by various studios situated in India. For example, Dedicated Dream Works Unit 

(DDU) India delivered the animation character FX, FX and lighting work for Kung Fu 

Panda 3 and Penguins of Madagascar 3 as shown in Figure 1.7. Prime Focus company 

crafted and delivered the entire VFX pipeline for Sin City 2. 

 

Fig. 1.7 Still from movie ‘Kung Fu Panda 3’ Courtesy: DreamWorks animation 

Not only International film projects even Indian animated films like Chaar Sahibzaade 

(2014), a 3D animated historical movie, made in low budget of INR 20 Crore and has 

generated box office revenue of approximately 50 Crore. This film was solely created in 

India. Disney’s The Jungle Book – which has grossed about $1000 million worldwide, as 

per the box office. It has a major portion created by Indian artists. Another Indian 

blockbuster Baahubali: The Beginning (2015) delivered 4000 to 5000 VFX shots with a 

high budget of $18 million and gained $90 million in India. 

Bollywood Industry has also shown more interest in animation and VFX. Films like Fan, 

Krrish-3 and RaOne have used considerable visual effects which have been completely 

created in India. 

Indian Studios currently moved beyond traditional mediums like television and Cinema 

halls to showcase their contents. They start using digital platforms such as YouTube, 

Netflix, VOOT and other OTT platforms. 

Assignment 2 – Search from Internet the movies that include both Visual Effects and 

animation. 

Assignment 3 – Search from Internet and list top 5 highest grossing Indian movies in 

a current year. 

1.2.1 Animation and VFX in Advertising 

Innovation in animation has been constantly evolving. In fact ‘Change is the only 

constant’ in this space. Varied techniques and styles of animation like stop-motion, 

claymation, puppet animation, 2D, 3D and live action animation have been incorporated 

mainly in the television commercial space as advertising allows a platform for 

experimentation. 
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The famous Vodafone Zumi 3D advertisement has been created using computer 

generated imagery (CGI). In this advertisement as shown in Figure 1.8, character Zoo 

Zoos was not an animated characters. They were the real human, wore the costumes. 

 

Fig. 1.8 Vodafone Zoo Zoos Campaign Courtesy: Nirvana films 

The use of high end visual effects is no longer limited to big budget films, as advertising 

agencies using VFX to create innovative advertisement. 

Key factor of Indian Animation and VFX Industry 

Cost efficiency and improved quality 

International producers are attracting towards Indian Animation and VFX services. It is 

happening, because of those two reasons, firstly we have the cheapest animation and 

VFX services all over the world, that is 1/3rd to 1/4th lesser than North America and 25% 

cheaper than Korea and Philippines. Secondly, the quality of animation and visual 

effects services has improved tremendously. 

Episodic Content generated major revenue 

In India, Episodic content has the biggest revenue share (58% in FY-19) in animation 

and VFX services (Figure 1.9). Episodic content denotes the work for 11 or 22 minute 

program, which is prepared for television and OTT platform. 

 

Fig. 1.9 Breakup of India’s animation services Courtesy: KPMG in India’s 

analysis and estimates, 2019-20 

Motu Patlu is an example of Indian animated television series. The series is produced 

by Cosmos-Maya. It is adapted from the classic comic strip on Lot Pot. 

More to know… 

Episodic Content – It is an animated television series, which telecast daily in television 

set and through OTT. Some examples are Ben10, Gattu battu, Steven universe future 

and many more. 

Assignment 4 – Search from internet the prominent Animation and Visual Effects 

Studios situated in India. 
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1.3 Job opportunity in Animation 

In animation every character and their action are in your control and you can create 

anything possible. It is a reality of animation world. Figure 1.10, shows the three stages 

of animation, Pre-production, Production and Post-production. 

Suppose you have an Idea, you discuss it with your team, the script writer 

conceptualizes the story around your idea(s) and write a script. Later you discuss this 

script with the storyboard artist to breakdown it into scenes and convert them into 

sketches according to story. Once storyboard is finalized, it sends to pre-visualization 

team. Then, pre-visualization team creates animatic, which includes the storyboard 

images, scratch voices, temporary music and sound effects. In this way, it becomes the 

foundation of the movie. 

 

Fig. 1.10 Graphical breakdown of the 3D animation pipeline Courtesy: Author 

Story Broad Artist – They are the people with astonishing knowledge of anatomy of 

humans as well as any organism and have marvelous drawing skills. They visualise a 

series of events of a story and convert the word/text into sketches and graphics, which 

narrates the story from one animation frame to another. 

Modeller – A person having sound knowledge of form, volume, shapes and anatomy. 

The role of a modeler is to create 3D models for animation. 

Texture Artist – Texture is an important part of any object, which gives the information 

about the nature of the surface of the subject and anybody can feel it by seeing it. 

Texture artist plays a major role in giving the surface details of an object according to 

its nature. This is the reason to display the realistic environment and creatures on the 

screen.   

Digital Ink and Paint Artist – Color is important aspect, which interpret the nature of 

an object, character and environment. The paint artist add colours to each frame using 

digital ink. The background artists, paint the background of the characters/scenes 

involved in the project. 

Lighting Artist – Lighting plays an important role in any video/ animation production. 

Lighting creates variations of shades, colour tints, hues, colour intensity and shadows. 
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Lighting Artist designs such variation. They should have a keen observation about light. 

They create lighting in the scene as much as it is close to real. 

Layout Artist – Layout for the animation is a necessary element in which placements 

of lights, camera angles and background design are decided. It is done by the Layout 

Artist. 

Rigger /Rigging Artist – It refers to the process of creating the bone structure of a 3D 

model. The bone structure is used to manipulate the model like a puppet for animation. 

It is a very complex job. It involves lots of Mathematics and Physics to make constraints 

for an object to behave same as it is in real world. 

Morphing Artist – Organisms contains several emotions which cannot be shown on 

screen from a single model. A series of different deformation of a object is created by 

Morphing artist and the process is known as Morphing which can change a shape of an 

object into another shape which is different in nature. 

Character Animator – They are the key person, which brings characters to life. 

Generally, he/she have the knowledge about the walk-cycles of organism, traditional 

animation and stop-motion animation. 

2D Animator – The basic job of 2D animator is to create a very high volume of separate 

drawings that define an animated sequence of character. 

Key Frame Animator – Key frame as the name suggests the important frame, which 

contains initial pose and final pose of a movement of an object or character in a scene. 

The job of key frame animator is to draw those key frames. 

Clean-up Artist – A person who traces the animator’s rough sketches and drawings. It 

allows him to check the accuracy, continuity and consistency of a design. A cleanup 

artist is basically assisted to character animator. 

Compositor – A person who brings, all the different characters, backgrounds and 

environment into a single animation frame is known as Compositor. Along with, it can 

make changes in the composition of the pictures or frames and combine live-action 

footage with computer generated graphics. 

Rendering artist – Person who gives finished project and responsible for the output of 

animation into a movie, combine models, textures, animation, lighting and to produce 

the correct blend in the form of individual frames of animation. 

1.4 Job opportunity in VFX  

They are various types of job opportunity in VFX production pipeline as shown in Figure 

1.11. 
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Fig. 1.11 VFX Production Pipeline Courtesy: Author 

Roto Artist – Person who does the Rotoscoping work is known as Roto Artist. S/he 

carefully traces, creates motion path, selects a moving character or object and ingest 

into another motion picture. 

Paint/Prep Artist – In fighting sequence or super natural scene, paint artist cleanup 

the unnecessary items from the scene such as wire removal. 

Dust buster – A person who paints out dust on scanned film or glitches in digital 

capture footage. They, typically clone from an adjacent frame or area next to the spot. 

Layout Artist – A person, who does the same work as the camera operator on a live 

action set, but here lighting is not involved. Layout Artist creates the camera moves for 

full CG features. 

Compositor – The Compositor Artist combines layers, which is already prepared such 

as rendered animation, special effects, graphics, live action, static background plates, 

rotoscoping footage and pre-elements to create final images that meet art direction. 

Lighter / Lighting TD – He/She focuses on the lighting of a computer graphics scene. 

Used interchangeably with technical director at some companies. He works in a visual 

effects or animation team. In this way, he is responsible for applying all lighting effects 

in a scene. 

Rendering Artist – Combine models, textures, animation, lighting and to produce the 

correct blend in the form of individual frames of animation. 

Render Wrangler – Person who monitors the computers and render farm, rendering CG 

images and digital composites. They are involved in calculating the number of procs 

(processor unit time) available. 

Matte Painter – One who creates backgrounds, unlike concept artists, matte painters 

must create environments that feel absolutely photo real and are tightly and seamlessly 

integrated into the footage. 

Match mover – Match CG camera to live action camera. Use of both automated tools 

and manual alignment. Match mover is also responsible for camera tracking. 

Color Grader / Color Timer – One is responsible to adjust color in shots to keep a 

consistent look for the sequence. 

Summary 

• Animation is a method used to apply motion in painting, sketching, drawing or 

human figure. 

• VFX is a technique of mixing special effect shots within live action footage. 

• The M&E Industry in India display the solid growth of 13% during the year 

2019-20. 

• Animation and VFX industries have higher growth rate of 18.7% during 

financial year 2018-19 over 2017-18. 

• India nowadays became a favorite destination for animation services because of 

cost efficiency in animation services up to 50 percent. 

• Indian animators have also major contribution in Hollywood projects like Kung 

Fu Panda, The Jungle Book and Shaun-The Sheep and many more. 

• Various VFX processes like Lighting, Rotoscoping, and Matte painting in 

different Hollywood projects were made by many studios situated in India. 
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Check Your Progress 

A. Multiple Choice Questions 

1. What is animation is (a) Electronic medium of recording (b) A series of pictures 

projected on screen. (c) Copying and broadcasting of moving visual images (d) 

Illusion of motion through the successive display of still images. 

2. What type of software is Toon boom (a) Animation (b) Visual Effect (c) Video 

Editing (d) Image Processing 

3. Animation and VFX are the sub-sectors of _______  (a) Print Industry (b) Digital 

Industry (c) Television Industry (d) Media & Entertainment Industry 

4. Media & Entertainment Industry in India display the growth rate of _____ in the 

year 2019-20 (a) 10% (b) 12% (c) 13% (d) 15% 

5. Dedicated Dream Works Unit (DDU) delivered the animation work for (a) Kung 

Fu Panda-3 (b) Sincity 2 (c) The Jungle book (d) Baahubali – the beginning 

6. VFX work of Hindi Movie ‘Raees’ is done by (a) Makuta VFX (b) Red chillies 

Entertainment (c) Prime Focus Ltd. (d) Prana Studio 

7. The famous Vodafone Zoo-Zoos was (a) Animation Character (b) Human 

wearing the costumes (c) Puppet (d) Clay Models 

8. IP content in animation stands for (a) Internet Protocol (b) Intellectual property 

(c) Imaginary Plane (d) Ingest Picture 

9. The basic job of 2D animator is to create. (a) Very high volume of separate 

drawing. (b) Trace the animator drawing. (c) Draw the picture of a movement 

beginning and ending. (d) Bring all the different characters in to single 

animation frame. 

10. Compositing Artist _____ (a) Combines layers which is already prepared. (b) 

Combines models, textures, animation (c) Carefully cuts a moving character or 

object  (d) Creates backgrounds 

B. Fill in the blanks 

1.  VFX is used in __________ Production. 

2.  Indian Film Industry Produces approximately_______ films in a year. 

3.  Animation and VFX Industry shows the growth rate of _____% in FY19 

     over FY15. 

4.  According to current study ______ percent of American television animation 

Work is produced in Asia. 

5.  VFX work of 'The Lion King' is done by ________ 

6.  'Motu Patlu' famous animation character is adapted by ________. 

7.  Ching’s Secret advertising and promotional budget is _______ 

8.  Name the artist responsible to add colours to each frame_________ 

9.  Name the artist who change a shape of an object into another shape _______. 

10. Bone structure of a 3D model is created by ____________. 

C. State True or False 

1. Waterfall of movie ‘Bahubali’ exist in real world. 

2. Autodesk Maya is an animation and VFX software. 

3. Television sector comes under the Film Industry. 

4. Animation and VFX sector shows the highest growth rate in FY-2019 over 2018. 

5. Prime Focus has delivered the entire VFX work of Sin city 2. 
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6. In Animation services, Digital advertising has the biggest revenue share. 

D. Short answer questions 

1. What is full form of VFX? 

2. What is Animation and VFX? 

3. Write the difference between animation and VFX? 

4. What is Media and Entertainment Industry? 

5. Write different sector of Media & Entertainment Industry. 

6. Define Indian animation and VFX Industry. 

7. List 5 Indian movies which include VFX. 

8. What are the key factor of Indian Animation and VFX Industry. 

9. Explain the responsibility of  (a) Story board Artist (b) Texture Artist (c) Paint 

Artist (d) Rigging Artist 

 

 

Session 2: Post Production Process 
 

 

Animation and VFX are segments of the post production process and post production 

is also a part of production process. (Figure 2.1) To simplify this, we will first learn video 

production process. 

 

Fig. 2.1 Video production Process Courtesy: Author 

Suppose in a rainy night, you are alone at home and reading a haunted novel. 

Momentarily, you fall asleep. You imagine, those scary characters creeping around and 

moving in your dream which you have read in the novel. Eventually, you wake up and 

got scared. Short while you sleep again. But at this time, the scenario of the dream has 

been changed. 

Video Production process is just like above dream. You can compare and resemble that 

haunted novel with pre-production, which ingest the story in your mind. Dream match-

up with the production because here you can see the conversion of your thought process 

in the form of moving visuals and next dream with post-production where dream 

scenario and sequence has been changed. (Figure 2.2) 

So in general video production is the process of shooting a video by using video camera 

based on idea/concepts, and edit it with editing application. 
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Fig. 2.2 A girl see scary dream after reading horror story Courtesy: Author 

Video production is divided into three major phases – (i) Pre-production, (ii) Production, 

(iii) Post Production 

2.1 Preproduction is the phase pre-planning of a film or movie or animation took place 

with the spawn of an idea. Further, the entire planning takes place, before the 

production begins. It is segmented into different parts which include – Idea, Concept, 

Script, Storyboard, Location hunting, Casting, and Budget. 

2.2 Production phase begins, once the shooting/recording started. This phase mostly 

depends upon the pre-production. It solely depend on the things planned in pre-

production phase. It is is better if pre-production or planning done better. 

2.3 Postproduction After finishing shooting, large amount of data gets stored in hard 

disk. The data produced needs to be edited to produce the desired outcome. Post-

production phase is segmented into editing, special effects, visual effects, animation, 

colour grading, and sound mixing. It also include distribution, such as sending video 

out to television channels or uploading the video online. Figure 2.3, shows the post 

production process workflow. 

 

Fig. 2.3 Post Production Workflow Courtesy: Author 

In current scenario, post production workflow has following steps. 

1. Storage 
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2. Editing 

3. Sound Editing 

4. Motion Graphics/Visual Effects 

5. Music 

6. Sound Editing/Sound Mixing 

7. Conforming 

8. Colour Grading 

9. Finishing 

10. Mastering 

11. Create deliverable 

12. Achieving 

2.3.1 Storage 

Once the video/film shooting is completed, you need store it in some storage device. 

Some of the storage devices are discussed below. 

Hard Disk Drive (HDD) – It is a the most commonly used data storage device with 1 TB 

or 2 TB storage capacity. It is motor driven spinning disk inside the computer system 

or can be external HDD, which can be connected to computer through USB. A typical 

internal HDD is shown in Figure 2.4. 

 

Fig. 2.4 Hard disk Drive 

Solid State drive (SSD) – It is a type of nonvolatile storage media, which stores 

persistent data on solid-state flash memory. A typical SSD is shown in Figure 2.5. 

 

Fig. 2.5 Solid State Drive 

Raid 0/5/6/10 – It stands for Redundant Array of Inexpensive (Independent) Disks. It 

is a combination of Hard-drive. A typical Raid is shown in Figure 2.6. 
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Fig. 2.6 RAID 

Direct-attached storage (DAS) – It is a digital storage device that is connected directly 

to a computer or server. It is like an external hard drive. 

Network-attached storage (NAS) – It provides dedicated file serving and sharing 

through a network. One centralized, shared storage system can save money in long term 

scenario. 

Storage Area network (SAN) – It is a dedicated, high-performance storage system that 

transfers block-level data between servers and storage devices. SAN is typically used in 

data centers, enterprises or virtual computing environments. It offers the speed of DAS 

with the sharing, flexibility and reliability of NAS. It is shown in Figure 2.7. 

 

Fig. 2.7 DAS, NAS and SAN Courtesy: Author 

Organising 

Organising the footage is a major task in post-production. After shooting a film, the 

large amount of data is stored in hard disk drive. Initially the data is unorganized. Since 

film/video is never picturized in sequence, as you are shooting for number of days with 

multiple takes. Some of them are worth and some are not appropriate. Audio is also 

recorded in in separate file. You have to organise the shooted data in proper sequence 

for final editing. You can organize video footage in two level. Organising is the first stage 

in post-production. 

Organising the footage in storage Device 

Organize video and audio Clip separately in folder with specific file name as shown in 

Figure 2.8. After organising the footage, copy the data in different storage device for 

backup. 
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Fig. 2.8 Organise the footage in Hard Drive 

Naming Conventions 

Name the files in specific format as shown in Table 2.1. 

Table 2.1 Different formats of File Naming 

Style Format Examples 

Index Filename_001 Fire_001 

 001_Filename 001_Fire 

Version Numbers Filename_v3 Fire_v3 

 Filename_V03 Fire_V03 

Time Stamps Filename_YYMMDD_HHMM Fire_200112_0812 

 Filename_MMDDYY Fire_011220 

Hybrids Filename_YYMMDD_V01 Fire_200112_V01 

 001_Filename_MMDDYY 001_Fire_011220 

Organising the footage in Editing Application – Once you stored the entire backup 

and footage is organised in HDD, the next step is to import the footage in editing 

application and organise it again. There is a project panel inside editing program, where 

you can assemble all the footage in logical order. 

Here you may arrange footage in following way. 

• 1. Create a “Bin” as shown in Figure 2.9 (a) and (b). You can also rename it as per 

your choice to recall the type of footage require. Import footage in it. 

 
Fig. 2.9 (a) Create Bin by 

clicking on ‘New Bin’ Icon 

 
Fig 2.9 (b) New bin is created in 

project panel, in which footage 

can imported 
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2. Import, organised folder in project panel as shown in Figure 2.10. 

 
Fig. 2.10 Import Folder at Project panel 

Practical Activity 1 – To Create Bin in Adobe Premiere pro Editing Software and 

Import the footage. 

Material Required 

Computer work station, Video Clips or Video Footage, Adobe Premiere Pro editing 

software. 

Procedure 

Step 1. Open the Adobe Premiere Pro software. For that, type ‘Adobe Premiere Pro’ on 

Windows 10 search bar and click on application or double click on desktop shortcut 

as shown in Figure 2.11. 

 

Fig. 2.11 Searching Adobe Premier Pro application 

Step 2. Adobe Premiere Pro Splash screen appears on desktop, as shown in Figure 

2.12. 

 

Fig. 2.12 Adobe Premiere Pro Splash screen 

Step 3. Now, Premiere Pro welcome screen will appear. Click on New Project as shown 

in Figure 2.13. 
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Fig. 2.13 Clicking on ‘New Project’ icon 

Step 4. A window will appear. Browse Project location and write Project name as 

shown in Figure 2.14. 

 

Fig. 2.14 Browse project location and write the project name 

Step 5. In new project dialog box, there are some other options like video and audio 

display format, capture format. Select appropriate format as shown in Figure 2.15 (a), 

(b) & (c) and click on OK. 

 

 

 

Fig. 2.15(a), (b) & (c) Select appropriate format 

Step 6. Adobe Premiere Pro interface will open as shown in Figure 2.16. 
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Fig. 2.16 Adobe Premiere Pro software interface 

Step 7. In project window, click on New bin Icon as shown in Figure 2.17. 

 

Fig. 2.17 Click on ‘New Bin’ icon 

Step 8. Rename the Bin folder as shown in Figure 2.18(a) & (b) for organizing your 

footage. 

 

 

Fig. 2.18 (a) & (b) Rename the bin folder 

Step 9. Right click on bin folder and select Import, as shown in Figure 2.19. 
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Fig. 2.19 Right click on bin folder 

Step 10. Import dialog box pop-up, search project folder location in explorer and 

double click on footage folder, as shown in Figure 2.20 (a) & (b). 

 

 

Fig. 2.20 (a) & (b) Search the desire footage for import 

Step 11. Select single file or all files and click on open tab as shown in Figure 2.21. 

 

Fig. 2.21 Select the footage for import 

Step 12. After clicking Open tab, file starts to import in adobe premiere pro software, 
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as shown in Figure 2.22. 

 

Fig. 2.22 Import process initiated in software 

Step 13. Once the Import process completed, file saves in ‘Raw Footage’ bin, as 

shown in Figure 2.23. 

 

Fig. 2.23 Footage imported within the software 

Step 14. Footage is imported in Bin Folder of editing application. Here, you can 

organise all your footage. 

 

Practical Activity 2 – To import the Footage Folder in Editing Application Software. 

Procedure 

First follow the Steps 1-5 of Activity 1. 

Step 1. Go to the File menu and Click Import, as shown in Figure 2.24. 

 

Fig. 2.24 Click on ‘Import’ on ‘File’ menu 

Step 2. Import window appears. Now search your project folder in explorer, select the 

footage folder and click Import Folder tab, as shown in Figure 2.25. 
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Fig. 2.25 Browse desired folder for importing the footage 

Step 3. File import process is in progress, as shown in Figure 2.26. 

 

Fig. 2.26 File import process has been started 

Step 4. Import Folder is displayed in Project Window, as shown in Figure 2.27. 

 

Fig. 2.27 Import folder is displayed on project window 

Step 5. Finally, the footage folder is saved in Adobe Premiere pro. 

2.3.3 Interpret the Footage 

Next step in the process is to interpret means read the footage in correct way. If you 

shoot a short video clip using your smartphone. Then the biggest challenge is to edit 

this video on editing application. 

Suppose, you spent vacation in hill station, where you captured mesmerizing videos and 

beautiful pictures, using DSLR camera and smartphone. Now you want to make a travel 

video blog by using these photos and videos. How you can assemble all these different 

footage? as you have different files with different image sizes, frame-rates and 

resolutions. 
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For this, you need to work on editing software like Adobe Premiere pro. It allows you to 

combine multiple files with different frame rates, video resolution and aspect ratio in a 

same sequence and creates a single video file from it. 

Once you add and interpret these files in an editing timeline, you can adjust image size, 

aspect ratio, video cropping. When you export the video sequence; it will confirm the 

entire file automatically. However, if you have multiple files in different formats, then it 

can cause video frame lagging or even software may crash. So remember the following 

settings in software while editing the multiple format or mix format footage. 

Setting up a sequence 

Sequence setting of the project determines the technical specification and response of 

added video footage as shown in Figure 2.28. You may create new sequence by clicking 

on Adobe premiere pro > File > New > Sequence 

 

Fig. 2.28 Sequence Setting 

You can also create a new sequence from a single clip, but remember the sequence 

setting because this setting is applicable for all video clips as shown in Figure 2.29 and  

Figure 2.30. 

 
Fig. 2.29 Dragging the footage to make sequence from video footage 
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Fig. 2.30 Sequence is created from video footage 

After creating the sequence from a single video footage, if you try to insert other video 

footage of different technical specification on a timeline, then you get a clip mismatch 

warning by software as shown in Figure 2.31. 

 

Fig. 2.31 Clip Mismatch warning when video clip inserted in timeline 

Click on “Keep Existing Settings” to keep the sequence setting same as decided prior to 

footage insertion and adjust the new clip around it. To change the sequence setting 

according to the clip which you are inserting on timeline, click “Change sequence 

settings”.   

Select the appropriate frame rate 

The term frame rate means number of still frames per second. While shooting, you 

encounter different frame rate like 23.97, 23.98, 24, 25 (PAL), 29.97, 30, 48, 50 and 

more. Frame rates for various medium are as follows. 

Feature Film – 24fps 

Television Broadcasting – 25(PAL), 29.97(NTSC) 

Web Videos – 30 fps 

Selection of the frame rate at the beginning provides liberty to manage footage later in 

editing timeline as shown in Figure 2.32. 
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Fig. 2.32 Select the frame rate according to project 

Aspect Ratio and Resolution 

Resolution is the measurement of the frame by its height and width. The frame height 

is number of vertical pixels and frame width is the number of horizontal pixels. While 

the aspect Ratio is the ratio between frame height and width. 

Resolution and aspect ratio are inter connected terms, because number of horizontal 

pixels decided by the aspect ratio of the frame. For example if a video has 1080p 

resolution with aspect ratio of 16:9. Then, 1080 stands for total number of vertical pixels 

while number of horizontal pixels will be 1080*16/9=1920. 

Thus, the frame resolution will be 1920 x 1080 as shown in Figure 2.33. 

 
Fig. 2.33 Resolution and Aspect Ratio Courtesy: Author 

While, interpreting the video footage you may face following problems related to 

Resolution and Aspect Ratio. 

1. Video frame size may be larger or smaller than sequence setting as shown in Figure 

2.34 (a) & (b). 

 
Fig. 2.34 (a) Video frame size larger than sequence setting 
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Fig. 2.34 (b) Video Frame size smaller than sequence setting 

Practical Activity 3 – Scale a video footage which has larger video size than sequence 

setting. 

Procedure 

(A) First option; resize the video frame by using ‘Scale to frame size’ option. 

Step 1. After creating new sequence as mentioned in previous activities, insert video 

footage in timeline by drag and drop method, as shown in Figure 2.35. Here you can 

observe that video frame size is larger than footage. 

 

Fig. 2.35 Video footage is inserted in timeline by using ‘Drag and drop method’ 

Step 2. Right click over footage in the timeline and select the option ‘Scale to frame 

size’ to fit the footage within frame, as shown in Figure 2.36. 

 

Fig. 2.36 Select ‘Scale to frame size’ to fit the footage within frame 

Step 2. Video Footage fitted within the frame in program monitor, as shown in Figure 
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2.37. 

 

Fig. 2.37 Video footage fitted within the frame 

(B) Second option; resize the video frame through motion control. 

Step 3. Click on – Adobe premiere pro > window > effect control 

Now, Effect Control panel will be displayed, as shown in Figure 2.38. 

 

Fig. 2.38 Enable effect control window 

Step 4. Select Clip (Footage) in a timeline, now, the Effect Control window is showing 

the motion control option of that selected clip, as shown in Figure 2.39. 

 

Fig. 2.39 Motion control option of selected clip 

Step 5. Adjust the scale of video by sliding the scale value in motion control or fill 

the desired scale size value, as shown in Figure 2.40(a) & (b). 
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Fig. 2.40 (a) & (b) Adjusting the scale of video by using motion control 

Step 6. In this way larger or smaller video frame can be scaled within the sequence 

setting. 

Now, you can adjust the video size, which have higher or lower resolution as compared 

to sequence settings. But what do you think about aspect ratio? 

Suppose, you are editing a video which has project setting suitable for high definition 

(1920x1080) video size, with aspect ratio 16:9. Suddenly, you need an archival footage 

or footage from video library, which has 4:3 aspect ratios. Then, What will you do? 

 

Fig. 2.41 Video footage with standard Definition (4:3) Aspect Ratio 

In such situation, you have three possible solutions, Use the footage, with same aspect 

ratio as shown in Figure 2.41. 

• Place the background (photo or video) below the video clip in a timeline, as shown 

in Figure 2.42. 

• Stretch the video until it fills the frame, but doing this affect the aspect ratio of 

video, it will look dramatic or abnormal, as shown in Figure 2.43. 
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Fig. 2.42 Background image is placed below the video clip 

 
Fig. 2.43 Video Footage stretched 

More to know … 

Pillar boxing – This term is used, when you boxed the frame with two vertical black 

or blank video bars on both side of the video. 

Letter boxing – This term is used, when we have black bars on the top and bottom 

of the video. 

2.3.4 Editing 

It is the process of footage sorting, assembling, arranging according to story or script, 

inserting motion graphics, titles, logo, animation and render the final project. The 

overview and basic working of of editing software “Adobe `Premiere Pro” is already 

covered above in this chapter. The process to make a new project, organise the footage 

in storage device, creating the time line, interpret or manage footage with different 

format, resolution and aspect ratio is explained. 

Before we begin, let’s take an overview of editing workspace. 

1. Project Panel – In this panel, you can store entire raw element, which is used in 

editing. It contains video footage, audio clips, animation, graphics, music, titles, 

supers and many more.  
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2. Timeline – After you import video on project panel, arrange it in sequence. In a 

timeline, video takes shape. You can drag the footage either directly from project 

panel or insert selected video clip from source monitor to a timeline. Placing them in 

desired order, you can create a sequence in a timeline, which can playback on 

program monitor. 

3. Source Monitor – The video clips can be previewed in source monitor (left screen) 

before inserting in a timeline, as shown in Figure 2.44. 

 

Fig. 2.44 Adobe Premiere Pro Editing Interface 

4. Program Monitor – In this monitor, you can see the edited footage as well as final 

shape of the video (output) from a timeline. 

5. Video and Audio track – These are the tracks located in a timeline panel, you can 

insert 99 audio and video track separately in a timeline. These tracks give you liberty 

to perform multi-layer editing. 

6. Audio Meter – It shows the audio level of the timeline. Its standard unit is decibel 

(dB). It is used to monitor the audio level. 

7. Tools – It contains several tools as shown in Figure 2.45, which are used to perform 

various editing operations in a timeline. 

 
Fig. 2.45 Various tools in Adobe Premiere Pro Editing Software 

Selection Tool – It perform basic selections and edits. You can select single clip or 

multiple clips and move them around within a timeline, from track to track as shown in 

Figure 2.46. 
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Fig. 2.46 Selection Tool 

Track Select Forward Tool – This tool allows to select all the tracks in a sequence as 

shown in Figure 2.47. If you hold shift key, the tool will select only one track instead of 

all tracks. 

 

Fig. 2.47 Track Selection Tool 

Ripple Edit – It is used to trim a clip and closing the gap between two edit points, as 

shown in Figure 2.48. Keep in mind that layer should not lock while using this tool 

because it will leave locked clip and your timeline will be disturbed. 

 

Fig. 2.48 Ripple Edit 

Razor Tool – It is the most useful tools in editing. It is used to cut the clip wherever 

required. Figure 2.49 shows the Razor tool before clicking on timeline and Figure 2.50 

shows the Razor tool after clicking. Holding shift key while using the Razor will cut clips 

across all tracks, as long as they are not locked. 

 
Fig. 2.49 Razor Tool-before clicking on timeline 
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Fig. 2.50 Razor Tool-After click 

Slip Tool – Slips the clip’s source In and Out point, but doesn’t move it on the timeline 

therefore no change in duration of the clip. 

Pen Tool – With the help of Pen tool you can add key frames on both the audio and 

video clips as shown in Figure 2.51. You can key frame a wide number of attributes, 

including opacity, scale, position and even volume of an audio clip. 

 
Fig. 2.51 Pen tool 

Hand Tool – With the help of Hand Tool, you can navigate in timeline forward and 

backward, as shown in Figure 2.52. 

 
Fig. 2.52 Hand tool 

Type Tool – It allows creating text on program monitor as shown in Figure 2.53. You 

may choose text font, colour, background, stroke and various attributes regarding text. 

 
Fig. 2.53 Text Tool 

The following activity will illustrate editing in Adobe premiere software. 

Practical Activity 4 – To perform a basic editing in Adobe premiere software. 

Procedure 

Step 1. In Adobe Premiere Pro software, Click File > New > Sequence, as shown in 
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Figure 2.54. 

 

Fig. 2.54 Select new sequence 

Step 2. Sequence Setting window open, Select appropriate file setting, and type the 

Sequence Name, as shown in Figure 2.55. After this, click on OK button. 

 

Fig. 2.55 Sequence setting 

Step 3. New Sequence is created in a timeline, as shown in Figure 2.56. 

 

Fig. 2.56 New sequence is created 

Step 4. Click on Footage folder in project window, as you double click on required 

footage. Preview of this clip will be displayed on Source monitor, as shown in Figure 

2.57. 



 

Roto Artist, Grade XI 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

36 

 

Fig. 2.57 Preview of video clip on source monitor 

Step 5. Mark I (In point) and O (Out Point) in source monitor. Now the video between 

these two points are selected, as shown in Figure 2.58. 

 

Fig. 2.58 Selection of desired video clip by marking in and out 

Step 6. Select Video and Audio track so that video clip can be inserted on this track. 

Place the CTI slider from where you want to insert the video clip, as shown in Figure 

2.59. 

 

Fig. 2.59 Select video and audio track an d place CTI slider 

Step 7. Now, you are ready to insert footage in a timeline, click on insert tab and 

selected video clip (between In and Out Mark) will be inserted on timeline, as shown 

in Figure 2.60. 
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Fig. 2.60 Video clip inserted into the timeline 

Step 8. Repeat this procedure to insert selected video clips in your Timeline, as shown 

in Figure 2.61. 

 

Fig. 2.61 Footage is arranged into the timeline 

Step 9. This is the basic procedure of video editing. Adobe Premiere pro contains 

multiple tracks where you can insert necessary audio and video clips such as 

background music, special effect sound, motion graphics, titles and logos etc. 

Once the editing process is completed, we can lock the edit. At this point we divide work 

flow in two forms. Figure 2.62 shows the video and audio layer. 

1. Visual workflow 

2. Audio Workflow. 

 

Fig. 2.62 Video and Audio layer in Adobe premiere Software 

1. Visual Effect workflow 

Visual workflow can be divided into two major workflows. 
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Motion Graphics Workflow 

It includes work on Motion graphics, Titles, Overlays or Inlays, Animation, Logo and 

basic effects. 

Visual Effects workflow 

In Visual Effects workflow Rotoscoping, Keying (Color or Chroma Keying), 3D conversion 

(stereoscopic), Animation and Compositing included. 

In Visual effect, first you have to identify the clips that required visual effect, after that 

export identified clip into a format, which is supported by visual effect software. 

Generally, in DPX file format or TIFF File format. 

Export it in an Image sequence in the best possible resolution and file format for visual 

effect. 

2. Audio Workflow. 

Audio workflow can divided in two major segments – Sound Editing and Sound Mixing. 

So before begin to edit sound, you need to understand different recording content, which 

are, 

• Recording dialogue 

1. Wild sound taken without image 

2. Ambient sound like room, tones, nature and many more 

If you are using a sound recorder, then dialogue will be saved separately in AIF or WAV 

format. It is standalone sound. (Figure 2.63) Thus each recording is separate using 

different location and different equipment. So initially, you need to sync the sound.   

 

Fig. 2.63 Audio workflow 

Syncing 

You have seen many programmes in television which is out of sync. So, what does it 

mean? Syncing mean aligning. The lips should be in sync with voice. In older technique, 

clapper board was used for syncing the audio with video. Now electronic slate or time-
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code is used to sync the sound. Syncing dailies is an activity where we bring all the 

recording under their relative visuals. 

Editing 

It is a technique, where we arrange audio and video according to script. After completion 

of editing, you need to export it audio file format such as to .aaf or .wav file for sound 

editing. 

What essentially happens is, the ‘correct’ or ‘preferred’ sounds are placed on the 

timeline, in tracks. This happens in the video editing software first, and then in the DAW 

(Digital Audio Workstation), the audio equivalent of the NLE. Figure 2.64 shows the 

DAW. 

 

Fig. 2.64 Digital Audio Workstation 

Each row is represented in a track. Its interface is same as NLE software and DAW. It 

is job of both video and sound editor to organise the recording into different available 

track. 

All tracks are correctly names, so that sound editing team can understand the editors 

or filmmaker’s attention. Once the edit is locked, the ‘finished’ audio timeline became a 

guide track. Guide track provides the basic intention of filmmaker and it forms the basis 

for the sound editor. 

Sound Editing 

The sound editor assembles and organizes the audio recordings and tracks. The sound 

editing is divided in five phases. 

1. Dialogue 

2. ADR/Dubbing 

3. Ambience 

4. Sound Effects 

5. Music 

1. Dialogue 

It is the most important part of the soundtrack. A skilled video editor export the 

dialogue, edits in various tracks. In case of location sound, a sound recordist records 

audio in two different devices – a lavaliere microphone and shotgun microphone. You 

need, to choose the track that sounds best and is most consistent throughout the shoot. 

If there is a noise on a dialogue track then you may have to use noise reduction tool in 

Digital audio workstation (DAW). 

2. ADR/ Dubbing 

Have you ever shot a scene and get problematic sound from background? Or maybe you 

were in a tight space and things didn’t turn out the way you wanted. When professionals 
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face these problems they use ADR in film. ADR means automated dialogue replacement. 

Sometimes people call it “dubbing”. In this process actors re-record dialogue in the 

studio to improve the audio quality. 

Actors will watch their scene with pre-roll and re-do their lines when cued by three 

countdown beeps (“3…2…1…Go!”). They usually record three or four takes continuously 

as video playback in loop again and again. After recording, producer or sound engineer 

pick the best performance and replace it with original dialogue scene. Even if you are 

using the same microphone for recording, but you need to adjust EQ, compression and 

reverve to match the re-recorded audio with original.   

3. Ambience 

Ambience sound builds the environment of the scene. Whenever we edit dialogues, there 

is always a gap in the background ambient sound. Suppose you are watching a video 

where ambient sound is continuously changes with the dialogue. How restless you feel? 

To make a scene feel contiguous, you need to edit background sounds. 

Like if sound recordist recorded room tone on location, then you can fill this ambience 

sound in blank space between dialogues. If it is recorded by the sound recordist then 

you need to recreate random room tone based on the noise samples taken from existing 

dialogue recording. 

4. Sound effects (SFX) 

It cover a vast field. Whether the sound of car crashing, creating footsteps on Foley stage 

or just capture the sound of nature, it allows sound editor’s to get creative. You may 

use the SFX library in small budget production, however avoid it to use in broadcast 

production as some sounds are easily recognize by audience. 

Major film and TV productions use teams to gather and create their own library of sound 

effects which is used in particular projects like sound effects of Stranger Things, Star 

War universe. It is called custom sound. 

Another interesting sound is Foley, It is the art of recreating original sounds using 

different object like coconut sound for horse footsteps, breaking glass, sword sound etc. 

Foley artists create those sounds in real time by watching the scene on large screen. It’s 

really interesting to recreate sound of bone breaking by twisting some celery. You want 

sound of walking snow; pound your fists into a bowl of corn starch. A Foley artist has 

the subtitle of every sound. 

5. Music 

Music or background fills emotion in the scene. It may be royalty free music or a design 

score. It depends upon the director or producer, what music is to be used and where it 

is present. Always use a beat which match with on screen actions. 

What is Sound Mixing? 

Sound mixing is an art of, 

• Adjusting levels (volume) of different tracks 

• Balancing for various channels. 

• Improvise the quality of sound by adding, manipulating and removing various 

effects and filters in the sounds. 

• Prepare a final master track 
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We can say that mixing means mixing of tracks to make them play together, which is 

suited for artist intent of filmmaker and the story. 

Equipment for mixing 

The equipment used for mixing the video is called Mixer. It is of two types. 

1. Analog – the long mixing consoles as shown in Figure 2.65. 

2. Digital – Digital audio workstation can be a one computer screen, which looks 

like analog console as shown in Figure 2.66. 

 

Fig. 2.65 Analog Audio Mixer   Courtesy: Freepik.com 

 

Fig. 2.66 Digital Audio Workstation Courtesy: Freepik.com 

Mixing Tools 

There are many tools available in mixer. A better tool cost more. Some important 

functions of mixing tools are: 

Levels – It adjust the volume. 

Muting Single Tracks or Stems – It allows sound designer/engineer to listen certain 

section of sound. 

Limiting – The power to set upper and lower limits to levels 

Compression – The ability to compress audio levels into a smaller region by reducing its 

dynamic range for saving space. 

Expansion – The ability to increase the dynamic range, level-wise, if you want to go that 

route. 

Equalization – To adjust various frequencies or bands of frequencies like bass, treble. 

Filtering – It refers, taking out some frequencies of sounds by passing them through 

filters. 

Reverberation – It means, adding reverb or echo to match sounds or generate an effect 
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Pitch – it can change pitch of sound. 

Panning – Controlling space to make sound come alive within several channels like 

stereo, surround. 

Final Mix 

You will get the final mix, also called a Master. But, how many masters are there? If you 

glance through the available digital audio standards for theatrical distribution, you 

might come across the following names: 

1. THX – controlled environment standard – you mix in THX-certified environment 

and playback in one – there is no licensing involved. 

2. Dolby Atmos Cinema 

3. Dolby Atmos OTT (Home Theater) 

4. 5.1 

5. 7.1 and many others 

You need to keep music and effects sound separate in final mix. It allows movies to be 

dubbed in different languages. 

From the master audio, a sound designer can produce other mixes, like DVD, blue-

ray, television, stereo and 5.1 mix. 

It is for this reason that film audio budgets are large, and those who don’t consider them 

in advance find themselves in difficult situation. If your intention is a theatrical release, 

you must include all these mixes as part of your budget. 

Exporting the footage for VFX from your Editing Software 

You have completed your editing and your timeline is locked; (Figure 2.67) now you need 

to export timeline for VFX artist, which will perform Chroma keying, rotoscoping in 

different video clips. 

Here you have to copy your entire timeline in a new sequence and manage the video 

tracks in this way. 

V1= Edited footage (Generic Edit) 

V2= Green screen or Chroma key footage  

V3= Footage which need VFX 

In V1 you might insert the relevant background for Chroma key, which can be placed 

below the V2. 

 

Fig. 2.67 Timeline for VFX in Adobe premiere 

Once sequence is prepared, you can export an XML or AAF from adobe premiere pro. 

This will allow VFX artist to import the sequence into their timeline.  

Step 1. Export the AAF from your timeline sequence; Go to, File > Export > AAF (Figure 

2.68 
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Fig. 2.68 Export AAF for VFX in Adobe premiere 

Step 2. As you click on AAF, a dialog box opens. Here you need to set different AAF 

export settings. After setting, click on OK. (Figure 2.69) 

 

Fig. 2.69 AAF Export Settings 

Step 3. AAF file saves on destination folder. (Figure 2.70) 

 

Fig. 2.70 Destination Folder of AAF File 

Once the AAF or XML is exported, the VFX sequence can easily import on VFX software 

like Adobe after Effects. 

Step 1. Open Adobe after Effects software. (Figure 2.71) 
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Fig. 2.71 Adobe After Effects Software interface 

Step 2. Import AAF file in after effects software. Go toFile> Import> Pro Import after 

Effects as shown in Figure 2.72. 

 

Fig. 2.72 Import AAF File in After Effect 

Step 3. As you click on Pro Import after effects, a dialog box opens. Here you can browse 

the folder and select AAF file and click on import, as shown in Figure 2.73. 

 

Fig. 2.73 Pro Import After Effects Dialogue box 

Step 4. Now, Adobe premiere pro sequence is imported on after effect timeline, as shown 

in Figure 2.74, which allows VFX artist to perform required work. 
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Fig. 2.74 Imported VFX sequence in After Effects 

The best method is to provide working drive or an identical drive to the artist so that 

there is no discrepancy in the file structures. However, it is not always possible. In such 

case, set up clear guidelines, how files will be named and organized. In either case make 

it sure to discuss what frame-rate, raster-dimensions, and delivery codecs will have to 

be used to reduce further complications. High-quality codecs such as ProRes422, or 

ProRes4444 and DPX image sequences optimize media quality throughout the process. 

VFX artist performs their magic and they give you the finished final product file. You 

can place it on your editing timeline. Imagine visual effects in heavy feature film. This 

process may pass through many visual effect houses all around the world and finally 

return to the editing room to be converted into final product. Editing room is a core area, 

where everything in post-production goes through and comeback in various stages and 

after this final version of a film/video is created 

Simple file naming for VFX footage 

Remember that your VFX content will pass different post production studios for visual 

effects, hence it is better to have proper naming in the file during export the video from 

editing software, which would be helpful for VFX artist. (Figure 2.75) 

 
Fig. 2.75 File naming of footage for VFX 

i means input. Shots sent from the editor to VFX have names like this: 

i_HDP_010_BG_v01 

i_HDP_025_E1_v02 

i_HDP_030_E2_v01 

o is for output. When VFX team sends a composite back to the editor they will use 

something like this: 

o_HDP_010_v03 

o_HDP_025_v07 



 

Roto Artist, Grade XI 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

46 

e is for VFX element. Compositing layers created and used only by the VFX team are 

called elements. 

e_HDP_010_beautypass_v01 

e_HDP_010_Smoke_v02 

e_HDP_010_PFX_v01 

So, material coming into the vfx team from editorial is an input. Shots going out of VFX 

to editorial are an output. Everything else is an element. 

2.3.5 Conforming 

Editing is completed now. Motion graphics and visual effects shots are also inserted in 

the timeline. Audio tracks are placed which includes voice over, background music, on 

location sound and sound effects. So what would be the next step? You need colour 

correction for entire sequence. 

There are two options for this. 

1. Colour grading in same Editing Software such as Adobe Premiere Pro, Final Cut 

Pro and Avid in which editing is performed as shown in Figure 2.76. 

2. Colour Grading in Dedicated software’s such as Davinci Resolve, BaseLight. 

Option 1 is hassle free because it is easier to accomplish task on the same software 

rather than jumping from one to another. 

 

Fig. 2.76 Color Correction workspace in Editing Software 

But in option 2, there might be some issues because for using this option, one should 

have to move entire timeline. whose duration may be around 90 to 120 minutes and 

may contains multiple layers which is not an easy for color grading software. It is 

problematic because one should have to transport timeline exactly or duplicating exactly 

into another software like Davinci-Resolve or Base Light. This job is called ‘Conforming.’ 

Conforming is a very crucial job in post-production industry. Once the project is 

conformed, It is ready for Color Grading. 

Practical Activity 5 – To Conform the Adobe Premiere Editing timeline to Davinci 

Resolve. 

Procedure 

Step 1. Export the AAF of timeline. Go to; File > Export > AAF, as shown in Figure 

2.77. 
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Fig. 2.77 Select AAF export of timeline 

Step 2. Now, a dialogue box opens, you can choose the desired AAF Export Settings, 

as shown in Figure 2.78 and Click OK. 

 

Fig. 2.78 AAF export setting 

Step 3. Save the AAF file on desired location, for this browse the location and Click 

on save button, as shown in Figure 2.79 

 

Fig. 2.79 Save the AAF file on desired location 

Step 4. Open Davinci Resolve by clicking on Resolve thumbnail, as shown in Figure 

2.80. 
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Fig. 2.80 Open Davinci Resolve software 

Step 5. Once the software opens, Go to; File> Import Timeline 

And click on Import AAF, EDL, XML, as shown in Figure 2.81. 

 

Fig. 2.81 Import AAF file into the Davinci Resolve 

Step 6. Browse AAF file and Click ‘Open’, as shown in Figure 2.82. 

 

Fig. 2.82 Browse AAF file 

Step 7. Now ‘Load AAF’ dialogue box opens, check the settings on box and click ‘OK’, 

as shown in Figure 2.83. 
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Fig. 2.83 ‘Load AAF’ dialogue box 

Step 8. You can watch complete timeline on Davinci Resolve, as shown in Figure 2.84. 

 

Fig. 2.84 Complete timeline is imported into Davinci Resolve 

2.3.6 Colour Correction or Colour Grading 

It is a technical process that fixes color issues and makes footage appear as real as 

possible. The idea is for colors to look clean and real, as human eyes can see them in 

the real world. 

Colour grading is also technical, but it is more related to creative aspect. It fills emotion 

in a shot, or creates atmosphere. Colour grading choose unnatural ways of coloring 

footage as shown in Figure 2.85. 

For example, you may use darker tones to elevate the storytelling in a horror film, or 

you can use lighter tones when making a comedy film. 
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Fig. 2.85 Colour Grading in Davinci Resolve Software 

2.3.7 Finishing and Mastering 

Once color grading is completed, you need to perform in following ways. 

1. Real-time Finishing 

2. Minor Edits 

3. Minor VFX 

4. Final Color Grading 

5. Final Motion graphics and Titles 

During finishing, we need a combination of software which can work together within 

same interface. This combination is known as ‘Herobox’. All of these software have the 

capability of Motion graphics, Visual Effect and Colour Grading. 

Some Heroboxes are here. 

1. Adobe Premiere Pro + After Effects + Speed Grade 

2. Davinci Resolve + Fusion 

3. Autodesk Flame + Lustre 

2.3.8 Mastering and create delivery format 

It is the next next step after finishing color grading. It is the art of getting best and 

highest quality file, possible from your project. Image sequence is not a kind of format 

which can be playback. So there is a need to create delivery format. These are the 

Delivery format to which film is distributed to Film distributors and television 

broadcasters. 

DCP – It is the modern version of the old 35mm film reel. It is the format movie theaters 

used to project feature films and trailers. Over 90% of the theaters in the world now 

screen from DCPs as shown in Figure 2.86. 

 

Fig. 2.86 Digital Cinema Package (DCP) 



 

Roto Artist, Grade XI 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

51 

Digital Versatile Disc (DVD) – It stores audio and video files in MPEG-2 format. A DVD 

player or a computer equipped with a DVD drive is required to play DVDs as shown in 

Figure 2.87. 

 

Fig. 2.87 DVD 

Blue ray – Blue ray Disc comes in three format – prerecorded, recordable and re-

writable. The pre-recorded disc is called BD-ROM, which contains movies or TV shows 

in high definition format. The recordable Disk is called BD-R. It can be used for archival 

and rewritable disc is called BD RE, which is of same large capacity in a disc format 

that allows repetitive usage as shown in Figure 2.88. 

 

Fig. 2.88 Blueray Disc 

Video on demand (VOD) – It is a delivery system that permits consumers to watch a 

film according to their desire that they choose from a particular library at any time they 

want. VOD may be categorized according to their usage, as follows 

• Download to own (electronic sell-through) 

• Download to rent 

• SVOD – Subscription Video On Demand 

• AVOD – Ad supported Video On Demand   

• Any other digital transmission, that is chosen by the consumers. 

• TVOD – If the consumer pays to watch a single film, it is referred to as 

transactional video on demand. 

YouTube, Netflix, Amazon are the prime examples of VOD services. 

Broadcast/Others – Free to Air Television Free-to-air (FTA) are television (TV) broadcast 

in clear (unencrypted) form, which allows any person with the appropriate receiving 

equipment or receiver to receive the signal and view or listen to the content without 

requiring a subscription, any other ongoing cost, or one-off fee (e.g. Pay-per-view). In 

the traditional sense, this is carried on terrestrial radio signals and received with an 

antenna. 

Summary 

1. Video Production is the process of creating a video based on an Idea, by shooting 

with Video camera and edits it with editing application. 
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2. Video production is divided into three major phases – Pre-production, Production, 

Post Production. 

3. Organising the footage is one of the major tasks in post-production. 

4. Interpret means read your footage in the correct way. 

5. Editing is the process of sorting the footage, assemble it, arrange it according to 

story or script, insert motion graphics, titles, logo, animation and render the final 

project. 

6. Visual Effects workflow includes Rotoscoping, Keying (Chroma Keying), 3D 

conversion (stereoscopic), Animation and Compositing included. 

7. Transfer a timeline between softwares is called conforming. It is used when you 

need colour grading. 

8. The colour grading process adds atmosphere and emotion to shots by colouring 

footage in new, often unnatural ways.  

9. Digital Cinema Package is the modern version of the old 35mm film reel. It is the 

format movie theaters use to project feature films and trailers. 

 

Check Your Progress 

A. Multiple Choice Questions 

1. In Video Production, Storyboard is included in ________ Phase (a) Preproduction (b) 

Production (c) Post Production (d) Editing 

2. Video Production has ____ Phases (a) 2 (b) 3 (c) 4 (d) 5 

3. SSD stands for (a) Solid Stage Drive (b) Solid State Drive (c) Sub Sector Drive (d) 

Single Static Drive 

4. After shooting, data is organized in ______ (a) Editing application software (b) 

Storage device (c) Camera Storage (d) Mobile device 

5. Which of the following is a video editing software (a) Adobe Photoshop (b) Adobe 

Premiere Pro (c) Corel Draw (d) Adobe After Effect 

6. In Adobe Premiere Pro, ‘New Bin’ is created within ______ (a) Effect Control Panel (b) 

Project panel (c) Timeline (d) Source Monitor 

7. In Adobe Premiere Editing, source monitor preview (a) Original Video and Audio Clip 

(b) Edit Video Clip (c) Color Corrected Video Clip (d) Only Audio Clip 

8. In Adobe Premiere Editing, the Razor tool (a) Cut the clip in timeline (b) Select the 

clip in timeline (c) Move the clip in timeline (d) Trim clip in timeline 

9. DCP stands for (a) Digital Camera package (b) Digital Cinema package (c) Digital 

Cinema Print (d) Digital Cinema Process 

10. Example of Herobox softwares. (a) Adobe Premiere Pro+ Davinci (b) Davinci + Fusion 

(c) Autodesk Flame + Fusion (d) After Effect + Flame 

B. Fill in the blanks 

1.  Production phase begins after completion of ____________. 

2.  Storage Area Network transfers block level data between ______ and storage device. 

3.  In Adobe premiere pro, Import Folder display on ________ Panel. 
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4.  Sequence setting of the project determines the __________ 

5.  Frame rate shows number of frames _______ 

6.  Video frame can be resized by ________ tool in adobe premiere pro. 

7.  In Pillerboxing, black bars display on the _____ and________ of a video. 

8.  Total _____ audio and video tracks can be inserted in timeline. 

9.  DVD stands for ________ 

10. Rewritable Blu-ray Disk is called ________. 

C. True or False 

1.  Animation and Visual effects comes in to production phase. 

2.  Footage cannot be imported on adobe premiere project panel. 

3.  Interpret the footage means read your footage in correct way. 

4.  Feature films have 25 fps frame rate. 

5.  In letter-boxing, black bars shows on left and right side of the frame. 

6.  Pen tool can add key frames in both audio and video clip. 

7.  Compositing is a part of editing workflow. 

8.  Color grading is not possible in editing software. 

9.  Transfer of complete timeline from one software to another is called Conforming. 

10. DVD stores audio and video in MPEG-4 Format. 

D. Short answer questions 

1.  What are the different stages of video production? 

2.  Write the process of organizing footage on editing software. 

3.  What is Interpret?   

4.  Write about Editing Workspace. 

5.  Make a list of editing tools. 

6.  Write the difference between sound Editing and Mixing. 

7.  What is Colour Grading? 

8.  What is Conforming? Why it is required? 

9.  What is finishing in Post production? 

10. What is deliverable? Write about some delivery format. 

 
 

Session 3: Rotoscopy – Past, Present and Future 
 

As you know that the computers were invented in the decade of 1970s. Can you think 

how long old is the concept of animated movie. There is lots of contradiction about first 

animated movie. Quarino cristiani ‘El Apostol’ released in Nov, 1917, is a first ever 

animated movie. (Figure 3.1) 

 

Fig. 3.1 Still from Quarino cristiani’s movie ‘El Apostol’ Courtesy: Federico Valle 
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Now, you can understand that animation films were not always made using computers. 

There were many animation techniques like Magic Lantern, Phenakistoscope, Zoetrope 

and Praxinoscope. 

These techniques are subsequently developed and merged with others. Finally, 

Rotoscope is introduced in year 1917. 

Rotoscoping is the process of manually modifying film or video footage. In simple words, 

it is the process of drawing over a piece of footage frame by frame. This produces a very 

smooth motion without any restrictions on the final look of the animation. It is done 

either by hand or through the use of computer software. It was initially developed to 

speed up the animation process that was not true. (Figure 3.2) 

 
Fig. 3.2 Rotoscope Model Courtesy: Author 

3.2 The Origins of Rotoscoping 

The animation was not always so seamless, as it seems today. Artist and tech enthusiast 

Max Fleischer was working as an art editor for popular science monthly, when he came 

with an idea of rotoscoping. His goal was to introduce fluid and naturalistic motion in 

animation cartoons. He was assisted by his talented brothers – Dave, Joe and Charlie 

to develop and test the prototype of rotoscope device. In 1915, Max filed a patent for the 

device and its associated mechanism, which was granted in 1917. (Figure 3.3) 

 

Fig. 3.3 Max Fleischer’s Rotoscope Design Courtesy: Max Fleischer's patent 

drawing 

The rotoscoping process required film footage. But, the problem was, how to playback 

this footage frame by frame. Fleischer did some experiment in his film camera and 

converted it into hand crank projector. During his first experiment, he went to the roof 

of an apartment building with film camera. There, he filmed one-minute test footage of 

his brother Dave in a clown costume and developed it. After developing the footage, they 

had projected the film frame by frame by using hand crank projector through a glass 

panel on an art table. Max placed tracing paper over the other side of glass panel on an 
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art table. Then he traced the image over it. He continued this tracing process till all 

frame were traced. 

After drawing all the images, they need to be photographed them individually. For the 

clone footage test, max converted projector into the camera once again. This time max 

exposed each drawn image into one frame of film. Meanwhile, in this process, he 

manually removes and replaces the lens cap for just the right amount of time, then 

forward the film to next frame. After completion, Max and his brother developed the film 

and played it back using the projector. The result was amazing and a new technique of 

animation had been introduced. During this process an animation character, Koko the 

clown was born. (Figure 3.4) 

 

Fig. 3.4 Koko the Clown an animated character created by Max Fleischer 

Courtesy: Max Fleischer, Dave Fleischer 

Now, max decided he will animate the character while his brother Dave will direct. Both 

had created many successful cartoons, starting from 1919 with the “Out of the inkwell” 

series featuring the character “Koko the Clown”. Further, they created iconic character 

Betty Boop and Popeye in the 1930s while in 1940s they produced famous realistic and 

costly "Superman" short features. 

So, rotoscoping used to create life like character animation, which allows roto artist to 

show creativity and exaggeration in the animation. (Figure 3.5) 

 

Fig. 3.5 Video clip before and after Rotoscoping Courtesy: www.tumbler.com 

Fleischer also used this technique in his film “Gulliver’s Travels” released in 1939. It 

was second full feature length animation film produced in U.S. 

Assignment 1 – Make a list of 10 animation movies, in which rotoscoping is used. 

3.3 Rotoscoping in Other Animation 

During 1930s, there was another animator Walt Disney gave a tough competition to 

Max Fleischer. The first American full feature length animation was Disney's "Snow 

White and the Seven Dwarfs." 
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Before it was animated, They rotoscoped key frames at the beginning and end of 

character actions and animators elaborated the characters & scenery and created all in 

between shots on transparent animation cells. 

During 1930’s another animation company “Walt Disney” adapted this technique with 

some modification. Walt Disney produced first American full feature length animation 

“Snow white and the Seven Dwarfs”. Before creating animation, reference footage was 

taken of actors performing on studio sets in costume. (Figure 3.6 and 3.7) 

 
Fig. 3.6 A character animator working on sequence of Movie ‘snow white and 

seven dwarf’ Courtesy: EARL Theisen/Getty Images 

 

Fig. 3.7 Still from Movie ‘Snow white and seven dwarf’ Courtesy: Walt Disney 

Productions 

Although, it was put to good use, rotoscoping was not always well received. As, we 

mentioned earlier, some considered it a cheat or shortcut, and others complained that 

characters modeled on live actors differed in looks and movement from other moving 

characters, such as traditionally animated animals. 

Some have used much heavier rotoscoping, resulting in movies that look like film 

footage. In the 1970, Ralph Bakshi, whose animated films like ‘Fritz the cat’ and ‘The 

lord of the rings’ targeted more mature audience, because of heavy rotoscoping movie 

looks like a live image. (Figure 3.8) 
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Fig. 3.8 Still from Ralph Bakshi’s movie ‘The lord of the rings’ courtesy: Fantasy 

Films 

The process is also used by animators to learn animation from scratch. But it is not just 

an animation tool. Rotoscoping is also used in live-action films. 

3.4 Rotoscoping in Visual Effects 

Over a time rotoscoping had expanded some new areas, now, it was not only used for 

animation, but was also used a lot in visual effects. 

Filmmakers started using mattes in visual effects. Rotoscoping become a great tool to 

combine different character and scene. 

In movie ‘Return of Jedi (1983) (Figure 3.9) animated walking vehicle matted in real 

forest scene. A ‘hold out matte’ of some of the trees in the forest was hand rotoscoped 

frame by frame to create a matte. These were protected during optical printing, so the 

AT-ATs appear to walk between trees, adding a sense they were really there, in the midst 

of the action. 

 
Fig. 3.9 Animated walking vehicle in real forest movie ‘Return of Jedi’ Courtesy: 

Lucasfilm Ltd. 

In a scene of Alfred Hitchcock's the birds (1963), (Figure 3.10) many birds attack a small 

town. It was impossible to control the birds or even shoot against the chroma key and 

the nature of the shots meant the birds and luma key against a sky was not possible. 

So, rotoscoping was the only option. You may be surprised to know that 500 frames in 

one shot took two artist almost 3 months to complete. 
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Fig. 3.10 Alfred Hitchcock's the birds (1963) Courtesy: Alfred J. Hitchcock 

Productions 

In the original “Star Wars” (1977) (Figure 3.11) film animators drew the glowing blades 

over sticks held by actors to create light saber effect. 

 

Fig. 3.11 Light saber on movie Star war (1977) Courtesy: Lucasfilm Ltd. 

3.5 Digital Rotoscopy 

In the year 2000’s, Filmmaker Richard link produced two major motion pictures, 

‘Waking life’ and a ‘Scanner Darkly’ using the rotoscoping technique as shown in Figure 

3.12. 

 

Fig. 3.12 Still from movie ‘Scanner Darkly’ Courtesy: Warner Independent 

Pictures (WIP) 

In these films, computer replaced the traditional rotoscope. Wacom pens and tablets, 

G5s and digital camera become the major tools. Link used Rotoshop software, developed 

by Bob Sabiston to digitally brings this technique to the film. Take a look, how a live 

image converted in animation by Rotoshop software as shown in Figure 3.13. 
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Fig. 3.13 Steps of digital Rotoscoping Courtesy- Author 

A) Film 

Director Richard Linklater shoots with digital cameras. Since, details are added by 

animators, there are minimal costumes, props, and sets. 

B) Animate 

Artist use digital pen and tablet that is connected with software like rotoshop to trace 

the scene frame by frame. 

C) Enhance 

To enhance the 3-D effect in frames, animator use masking, warping and blending tools 

in software. Then, they add background and adjust the colour. Some elements need 

multiple week to complete the work. 

D) Render 

The completed sequences are processed for eventual output to film. One 15-second 

scene that started out as 26MB file took an hour to convert into whopping 486 MB. 

Recently, in 2019 ‘Undone, Amazon prime web series become the first show to use 

Rotoscoping (Figure 3.14). After watching this series, you will be surprised to see the 

impact. Undone is a kind of show that is stuck in our head. But, Undone is not simply 

made by rotoscoping. The cast had to shoot their scene multiple times to get right 

angles. The computer animators created rough version of the space through, which the 

characters move. Another team of artist creates oil painting to use the backdrop of a 

scene. 

 

Fig. 3.14 Still from Web series ‘Undone’ Courtesy: The Tornante Company 

These days, most visual effects programme have the capability of rotoscoping and 

masking. Even you can work with layer-based software like Adobe After Effect or with 

node-based software like Nuke, Silhouette. 

In the digital age, roto is not used for creating mattes. The same tool can digitally paint 

and be used to remove wires, objects from the film. 

3.6 Rotoscoping Technique in Video game 
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Rotoscoping technique also used in video games to produce more fluid motion graphics 

for video games like 1989 ‘Prince of Persia’ as shown in Figure 3.15. 

 

Fig. 3.15 ‘Prince of Persia’ Video Game Courtesy: Broderbund Ports 

If we flashback, about rotoscopy, we used roto for tracing the image which is used as 

animation, then we used it for matte creation in special effect of film, even today roto 

has maximum use for matte creation and 3D stereoscopy. 

Summary 

1. Rotoscoping is the process of drawing over a piece of footage frame by frame. 

2. Max Fleischer invented rotoscope in 1917 to create fluid and realistic motion in 

animation. 

3. Max created many successful cartoons, such as "Out of the Inkwell" series in the 

1919s, Betty Boop and Popeye in the 1930s, Superman in the 1940s. 

4. Initially rotoscoping was used to create life like character animation. 

5. The first American full feature length animation was Disney's "Snow White and 

the Seven Dwarfs." 

6. Later Rotoscoping was used to add special effects in film. 

7. In the year 2000’s, filmmaker Richard link produced two major motion pictures, 

‘Waking life’ and a ‘Scanner Darkly’ using the rotoscoping technique. 

8. In the digital age, roto is not used for creating mattes. The same tool can digitally 

paint and be used to remove wires, objects from the film. 
 

Check Your Progress 

A. Multiple Choice Questions 

1. World’s first feature length animation film is _____  (a) Snow white and seven dwarf 

(b) The adventure of Prince Achmed (c) El Aposol (d) Sin Dejar Rastros 

2. Which of the following is not the Rotoscoping technique (a) Animation (b) Special 

Effect (c) Stereoscopy (d) Painting 

3. Who invented the Rotoscope (a) Walt Disney (b) Max Fleischer (c) Quirino Cristiani 

(d) Carl Koch 

4. Which motion you get from Rotoscoping technique. (a) Fluid (b) Robotic (c) Stop 

(d) Slow 
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5. In which movie film animation looks live image because of heavy Rotoscoping. (a) 

Snow white and seven dwarf (b) The lord of the rings (c) Gulliver's Travels (d) 

Superman 

6. In movie 'The birds' many birds attack a small town, the birds placed in the scene 

by ______  (a) Chroma key technique (b) Rotoscoping technique (c) Live action (d) 

Animation technique 

7. Filmmaker Richard link produced 'Waking Life' and 'Scanner Darkly' using 

Rotoscoping technique with _________ Software. (a) Photoshop (b) Rotoshop (c) 

Matador (d) Paint brush 

8. In Digital Rotoscoping _____ is not required. (a) Wacom pen and tablet (b) Digital 

Camera (c) Rotoscoping Software(d) Tracing paper 

9. Which of the following is Layer base software (a) Nuke (b) Sillhoutte (c) Adobe After 

Effect (d) Autodesk Flame 

10. Rotoscoping technique used in video game _________ (a) Mario (b) Super Contra 

(c) Alladin (d) Prince of Persia 

B. Fill in the blanks 

1. Movie 'El Apostol' is directed by________ . 

2. Rotoscoping is initially developed to ___________ the animation process. 

3. Max fleischer Rotoscope patent granted in the year _______ 

4. In movie _________ animated walking vehicle matted in real forest scene. 

5. Alferd Hitchcock's the birds takes_____time to rotoscope 500 frames. 

6. In the movie "Star Wars"(1977) animators drew the glowing blades over 

    sticks to create________ effect. 

7. Rotoshop software is developed by_________ 

8. In 2019,_______ become the first web series to use Rotoscoping. 

C. State True or False 

1. Rotoscoping is the technique of painting. 

2. Rotoscoping process required live action footage. 

3. Koko the Clown character created by Max Fleischer. 

4. The first American full feature length animation was ‘Fitz the cat’. 

5. Rotoscoping technique is not used in VFX. 

D. Short answer questions 

1. What is Rotoscope and who invented it? 

2. Write the process of traditional rotoscoping. 

3. Write the difference between animation and VFX? 

4. What is Media and Entertainment Industry? 

5. Write different sector of Media & Entertainment Industry. 

6. Define Indian animation and VFX Industry. 

7. List 5 Indian movies which include VFX. 
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Session 4. Roto Artist – Roles and Responsibility 

Roto artist is like a magician who can place his character anywhere in forest, city, river 

or any virtual world but before placing, he has to trace his character. (Figure 4.1) 

 

Fig. 4.1 Magician placed his character in different places Courtesy: Author 

Roto artist traces an object from live action frames using roto or compositing software 

and overlap the object with computer generated graphics or other live action footage. A 

Roto artist creates shapes around the object and animate these shapes to match the 

movement of objects. 

Roto artist also create clear spaces within the frame to allow all elements of the scene 

to be easily layered by the compositor. The roto-artists basic function is to create roto 

mattes and prepare plates for the compositors using various software. (Figure 4.2 (a), 

(b) and (c)). 

 
Fig. 4.2 (a) Tracing outline of the object in Adobe after effect software, Courtesy: 

Author 

 
Fig. 4.2 (b) Video Frame after rotoscoping Courtesy: Author 
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Fig. 4.2 (c) Composite Video Frame Courtesy: Author 

4.2 Roto artist work profile 

Rotoartist cut a part of frame and insert that part on live action footage or computer-

generated animation. But, the difference between these cut out and rotoscoping is the 

number of frames. Roto-artist does his jobs in video or film footage. So, there are lots of 

frame for cutting while these cut out has single photos for extraction. Roto-artist 

performs following work. 

1. Extract the selected part of a video by tracing every video frame. 

2. Extracted part inserted in other live action footage or Computer-generated 

graphics. This technique known as compositing. 

3. If rotoartist is lucky enough and get a footage where the subject and camera both 

are steady then he has to trace single frame for Rotoscoping. 

4. If the camera and object both are moving, or either one part is moving, then 

rotoartist trace every frame for producing high quality image. 

5. Rotoartist also assist in the preparation of material for compositing. 

6. Rotoartist works with visual effect team where live action footage interact with 

animation or other live action footage. 

4.3 Skills required for Roto Artists 

1. Basic knowledge of software such as Adobe After effect, Silhoutte FX, Nuke, Adobe 

Photoshop. 

2. Knowledge of fine art or photography. 

3. Capable to perform neat and accurate work. 

4. Able to work in a team and communicate with them. 

5. Be methodical, thorough and patient. 

6. Possesses drawing skills, including good line drawing. 

7. Able to work under pressure and desperate to deliver project on time. 

8. Should be proactive and take feedback from another team member. 

4.4 Responsibilities of Roto Artists 

The responsibilities of roto artist are to understand instruction and directions coming 

from production and supervisors. 

Generate and maintain high quality rotoscoping and manual digital mattes. 

Prepare creative solutions to the challenging visual effect problems. 

4.5  Job sector related to Roto Artist 

 1. Visual Effect sector 

Summary 
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1. Roto artist traces an object from live action frames using rotoscoping or compositing 

software. 

2. Rotoartist works with a close coordination with compositor. 

3. Basic function of Roto-artist is to create mattes and prepare plates for the 

compositors. 

4. If the camera and object both are moving, or either one part is moving, then roto-

artist traces every frame to produce mattes. 

 

Check Your Progress 

Short answer questions 

1.  Who is Rotoartist? 

2.  What is the work of Rotoartist? 

3.  Which type of skill Rotoartist required? 

4.  What is the responsibilities of Roto Artist? 

5.  What are the job sector related to Rotoartist? 

 

 

Module 2 

 

 

Creative and Technical 

Requirement 

 

Module Overview 

 

In the first module you have become familiar with Rotoscoping technique. A Roto artist 

has to work in close co-ordination with compositor, VFX artist and others. To 

understand the requirement, you should have technical knowledge of different film 

and video formats. Knowledge of VFX techniques like chroma key and roto are also 

required, so that you can use appropriate method of shooting for VFX. Finally, you 

should have knowledge about the software for digital rotoscoping. 

This Unit explains the technical specification of any video footage. It includes Video 

File Format, Codec, Frame Rate, Resolution and Aspect Ratio. It explains the various 

techniques and tools required for VFX such as Chroma Key and Rotoscoping. 

Introduction to various software like After Effects, Silhouette and Nuke are given. 

Further, you will get the working knowledge of Adobe Photoshop, 2D animation and 

subject isolation by using paint brush and pen tool.  

 

Learning Outcomes 

After completing this module, you will be able to: 

• Understand fundamental concepts and techniques related to video production and 

editing. 

• The tools and techniques for handling and processing raw video footage effectively. 
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• Explore various software options used for rotoscoping and their specific 

functionalities. 

• Explore the techniques for rotoscoping within Adobe Photoshop to integrate or 

manipulate video elements. 

 

Module Structure 

Session 1. Video Basics 

Session 2. Raw Footage – Tools and Technique 

Session 3. Rotoscoping Software 

Session 4. Rotoscoping in Adobe Photoshop 

Session 1. Video Basics 

Generally, we spend around 3 hours to view various videos in a day. You may watch 

videos on many platforms like Television, computer, Smartphone, Multiplex etc. Even 

you can notice signage panel along the road. Sometimes you are watching same content 

in different platforms and formats. For example you may watch same advertisement on 

television, mobile phone and even on the signage also. The exact video content can be 

delivered in different sizes and different format, such as you can watch any movie either 

on a cinema theater or in your mobile phone. There may be difference between all these 

platforms. In this chapter, you will learn about the creative and technical requirement 

of a video. It includes video format, Codec, frame rate, video resolution and aspect ratio. 

1.1 Video Basics 

In these days, everybody is indulging in the activities related to video. If we categorize 

these activities, it can be divided in five segments. 

1. Video Content Creation 

2. Editing 

3. Download 

4. Sharing/uploading video 

5. Play them back on a variety of different devices 

Most of us don't know a lot about them and very frequently run into the trouble. For 

example, if you want to convert a video to playback somewhere/ you need to edit videos 

or want to export a video clip for VFX, then you should have knowledge about these 

video basics. 

1.1.1 Video Content Creation 

Video camera is the main requirement to create video content. Therefore here we will 

discuss about digital camera and video recording techniques. 

Video Camera Types 

The technology of digital camera is ever changing. So we will simply discuss about video 

camera types used in present scenario. 

Smartphone 

Smartphone with inbuilt video cameras are used broadly for video recording purpose. 

But it is not a best option for professional filmmakers. However most of the high end 
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smartphones like iPhone, android have the capacity to record 4k and high definition 

videos. They come with accessories which allow filmmaker to get best from these. A 

smartphone camera is shown in Figure 1.1. 

 

Fig. 1.1 Smartphone Camera 

Consumer Video Cameras 

Consumer video camera is a simple video camera specially designed for personal 

nonprofessional use. It is cheaper and generally come with smaller sensor sizes. The 

image qualities of these cameras are not of high resolution as compare to the 

professional video cameras. 

These cameras are smaller and simple to operate. They are fully automatic, however 

users have some controls like exposure, audio level, focus and white balance. They come 

with fix lens and even you can’t add extra audio inputs in these cameras. A typical 

consumer camera is shown in Figure 1.2. 

 

Fig. 1.2 Consumer camera 

Pro Consumer Video Camera 

Next camera is professional consumer camera. This camera lies between consumer 

camera and professional camera. They have enough features to get professional quality 

image, which is sufficient enough for small video production. It’s cost is also low as 

compared to professional camera. They still come with manual image control, audio 

inputs and audio controls. The other characteristics of these cameras are – large sensor 

size and interchangeable lens. A typical pro consumer camera is shown in Figure 1.3. 

 
Fig. 1.3 Pro consumer video camera 

Super Chip Cameras 

There is another camera, places between pro-consumer and professional camera, which 

we called super chip cameras as shown in Figure 1.4. This camera can be distinguished 

by three factors: 
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• Its sensor size is larger than traditional professional video camera like Beta-cam, 

DVCPRO. Its sensor size is two or three times bigger than professional video camera 

sensor. 

• Like pro consumer camera, it has interchangeable lenses. 

• The price of super chip camera is less than professional cameras. Hence it is af-

fordable than professional camera. Some examples are Panasonic F100, Sony NXR 

HX 200 and many more. 

 
Fig. 1.4 Super chip camera 

These cameras are ideal for high end freelance broadcast work and film making. They 

have the capability to do everything which traditional professional camera can do in 

affordable rates. 

DSLR Video Cameras 

DSLR refers to Digital Single Lens Reflex. Basically, it is photography camera with the 

ability to take high quality videos. These cameras are using predominantly in the past 

few years, because of its outstanding characteristics. A typical DSLR camera is shown 

in Figure 1.5. 

• They have larger sensor size/imaging chips which provide high quality images. 

• You can use professional lenses with these cameras, which allows creative inde-

pendent for the users. 

• These cameras are affordable. You can purchase similar quality DSLR in half of the 

price than pro consumer video camera. 

 
Fig. 1.5 DSLR camera 

Yet there are certain drawbacks with DSLR cameras, 

• As DSLR camera is designed for photography, hence you need extra accessories 

to make it compatible for video shooting. 

• DSLR camera doesn’t have different function such as manual audio control, 

zebra stripes for deciding exposure and motorized zoom control. 
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• These cameras not have XLR audio inputs, which is necessary for professional 

microphone. 

• They also have a limited recording time of just 12 minutes per clip and this is not 

very encouraging if you are in the middle of recording someone. 

Though all these drawbacks, DSLRs are the best option for limited budget to create 

professional quality videos. 

Different Video Camera Controls 

Smartphone or consumer camcorder have limited options to play with visuals, but pro 

consumer video camera, has lots of camera control, as shown in Figure 1.6. 

 

Fig. 1.6 Different video camera control 

Focus – In professional/DSLR cameras, you can get the focusing ring in front of the 

lens. Turn the ring to bring the desired object into focus. To get the sharp focus, first 

zoom in to object, then adjust the focus and finally zoom out till required frame. Focus 

is essential part of camera operation. The expertise can be developed by practice of 

focusing. 

In every camera, there is an option of auto focus, but try to avoid this, because camera 

doesn’t know what the exact things you want to focus. 

Zoom – Zoom is the function which can move your point of view closer to or further 

away from subject. 

The two most common zoom mechanisms are: 

Manual zoom (ring) – Zoom ring is located on the lens housing. It can be rotated 

manually. For zoom control, use left thumb or index finger over ring. You can do super-

fast zooming by using manual zoom. Also, it does not require power hence battery is not 

consumed. Manual zooming needs practice. If you are not perfect on it then it is hard 

to get smooth zooming. 

Servo Zoom (lever) – This is basically a lever is placed on lens housing. To zoom in, 

press front part of the lever and to zoom out, press the rear part. 

Low budget cameras generally have constant zoom speed, whereas a good servo zoom 

can have a variable speed. If you press the lever hard, it results faster zoom. Some lever 

may have labels such as T and W (Tele and Wide). 

Fig. 1.7(a) Manual zoom ring 

Fig. 1.7(b) Servo zoom 
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Iris/aperture – It means the opening of the lens. It allows the light to enter the lens and 

further move towards sensor. By controlling the aperture, amount of light can be con-

trolled. On professional camera, Iris ring is found on the lens housing. Aperture is de-

noted by f no. such as f/1.8, f/2.0. f/3.5, f/1.6, f/8, f/11, f/16.   

Remember that in the lower aperture (F number) the lens opening is bigger and more 

light enter in the lens. In higher aperture, the lens opening is smaller, allowing to enter 

less light in the lens. 

Fig. 1.8 Iris/Aperture ring 

ND Filter – Many professional cameras have built in ND filters. ND filter reduces the 

amount of light that can pass through the lens. ND filter is generally used in bright 

condition where exposure is not controlled by aperture/iris. 

Fig. 1.9 ND filter 

White balance – White balance gives the reference to the camera about the true white 

in different lighting condition. Most consumer camcorder has an auto white balance 

feature. Whereas in professional video camera you can perform both auto and manual 

white balance. To perform manual white balance, perform the following steps before 

beginning of any shoot. 

1. Select the correct ND filter from filter wheel on camera according to the lighting 

condition. 

2. Place a pure white object like thermocol sheet or white paper. Remember that 

that white object should be fairly matte and non-reflective. 

3. Set the exposure and focus. 

4. Press the white balance button on the camera. It will take few second to complete 

the operation. After completion, you will get message on viewfinder. 

5. If you get failure message on view finder then perform all these steps again. 

Shutter speed – For better understanding about the shutter, observe it in still 

photography. Shutter is a kind of mechanical door, which is placed between lens 

and sensor. Shutter controls the duration of light, which expose the sensor. 

In video camera, shutter works differently from still camera, but the result is the same. 

The shutter “opens” and “close” once for each frame of video. As you know there 25 

frames per second in PAL while 30 frames per second in NTSC. 

Thus if the shutter speed is 1.60 second means each frame will be exposed for 1/60th 

second. If you increase the shutter speed such as 1/120, then it will create smooth 

motion and if you reduce the shutter speed like 1/15 second then it will create motion 

blur. 

Fig. 1.10 Different shutter speed 

Once you are familiar with your video camera and its control, you can shoot a video. 

For this you need some basic knowledge of shot sizes. 

Different Shot Sizes 

A shot is a recording of action from particular point of view at one time. It is a series of 

action from camera start to stop. (Figure 1.11) Here is the list of different shot sizes. 

1. Extreme Long Shot (ELS) 

2. Long Shot(LS)/ Wide Shot (WS) 

3. Full Shot (FS) 
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4. Medium Long Shot (MLS) 

5. Medium Shot (MS) 

6. Medium Close-Up (MCU) 

7. Close Up (CU) 

8. Extreme Close Up (ECU) 

 

Fig. 1.11 Different shot sizes 

Extreme Long Shot – It is used to show the subject from distance. This shot covers 

complete location. It is useful for establishing a scene. 

Long Shot (LS)/ Wide Shot (WS) – This type of shot covers the subject from top to 

bottom, although it is not necessary to fill the frame with subject. Here the character 

become in more focus than extreme long shot. 

Full Shot (FS) – It fills the frame from characters/subject head to toe. 

Medium Long Shot (MLS) – Medium long shot frames the subject from knees up. 

Cowboy Shot (MS) – It frames the subject from mid thighs up. It is used in western 70s 

and 80s movie to show gunslinger or holster on his hip. 

Medium Shot (MS) – Medium shot frames the subject from waist up. 

Medium Close Up (MCU) – Medium close-up frames subject from chest or shoulder up. 

Close Up (CU) – It fills the frame with part of subject or character like if you are framing 

a human then it will be the face which covers in Close Up. 

Extreme Close Up (ECU) – It highlight the small area or detail of the subject such as 

eyes or mouth. It is shown in Figure 1.12 different video related activities. 
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Fig. 1.12 People involve in different video related activities 

Once you have recorded your video content, you need to do editing, which is already 

covered in chapter 2 of first unit. 

There are many software used for video editing such as Adobe Premiere, Final Cut Pro 

and many more. You can also edit the footage in mobile by using different mobile app 

such as Adobe Premiere Rush, Filmorego, Kinemaster. In all these activities, most 

crucial thing is video file. A basic video file consists of four parts. 

1. Video stream – It contains the information about video contents appearing on 

screen during playback. 

2. Audio Stream – It stores audio content. 

3. Metadata – It stores the information about the video and audio streams such as 

frame rate, bit rate, format, camera model and subtitle. 

4. Container – It packed all elements together. 

Assignment 1 

Make a list of mobile application for following task. 

(a) Video Recording 

(b) Video Editing 

(c) Sharing Videos 

(d) Video Playback 

1.2 Video File format 

Video files are stored in container format that holds the compressed video stream, audio 

stream, subtitle and metadata. For example, popular MP4 video format contain video 

stream compressed by H264 codec and audio stream by AAC codec. (Figure 1.13 (a) and 

(b))  
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Fig. 1.13 (a) MP4 container format         (b) Metadata of video file 

Here we will discuss about the most popular video formats in these days and which 

formats are best to use in certain situations. Video format can divide in two types. 

1. Video editing 

2. Online distribution. 

This is because editing videos generally demand higher quality files while online 

distribution focuses on smaller file sizes and smoother playback. Table 1.1 lists some of 

the most popular video formats. 

Table 1.1 Most popular video formats 

Format Extension Developed By Platform Description and Use 

MPEG .mpg, .mp4, .Mpeg Motion Picture 

Expert Group 

PC, Mac, 

UNIX, 

Linux 

It includes MPEG1, 

MPEG2 and MP4; used 

for downloaded and 

stream video. 

WebM .webm Google PC, Mac, 

UNIX, 

Linux 

Royalty free, High quality 

open format for use with 

HTML5 

AVI .avi Microsoft PC Oldest and universally 

accepted file format. 

File size tends to be 

larger so not good for 

video streaming 

MOV 

(Quick 

time 

movie) 

.mov Apple PC, Mac, 

UNIX, 

Linux 

Supports virtually all 

codec formats and can be 

played back using 

QuickTime on all systems 

AVCHD .mts, .m2ts Sony and 

Panasonic 

 File based format for 

Digital recording and 

playback of High 

defination video 

ASF 

(Advanced 

systems 

.asf, .wmv Microsoft PC Microsoft’s Windows 

Media Video (WMV) 
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format) 

VOB 

(Video 

Object) 

.vob DVD forum Standalone 

DVD 

player, 

PC, Mac, 

Linux 

Industry standard format 

for standalone DVD 

player 

Ogg 

Theora 

.ogg Open Source PC, Mac Nonproprietary container 

(ogg) and video codec 

(theora) 

HLS 

HTTP Live 

Streaming 

 Apple  Adaptive bitrate 

segmentation, 

Compatible with wide 

range of device like 

computer, Television, 

Mobile and much more 

MPEG-

DASH 

 Open source  Dynamic Adaptive 

Streaming over HTTP, 

More to Know … 

The name MPEG-4 can be very confusing because different people use it for dozens of 

completely different things. 

MP4 container – MPEG-4 Part 14- Video format which contains Video, Audio and 

meta data 

ISO base Media File – MPEG-4 Part 12 used for video streams 

H.264 Codec- MPEG-4 Part 10 – used to compress video file 

Assignment 2 

1. Shoot a video clip from your mobile phone and identify its video format. 

2. Search on internet and list the video format used in film and video production. 

1.3 Codec 

The word codec is a combination of the words- coder and decoder. You can also describe 

as compression and decompression. As the title suggests it creates an encoded video or 

audio stream, making it smaller and easier to manage. In simple language, Codecs are 

like a translator. They work on specific data and convert it in a format which can be 

easily understood by the different media players. Media player or target software, which 

decodes it based on the rules set by that codec, and plays back the video with similar 

quality to the original. (Figure 1.14) 
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Fig. 1.14 Process of Coding and Decoding 

Just like containers, there are hundreds of different codecs. Codec can be classified in 

three categories. Table 1.2 lists some important Codec format. 

1. Video Codec 

2. Audio Codec 

3. Still Image Codec 

Table 1.2 Most Important Codec 

Codec Codec Type Compatible 

Format 

Advantages 

H.264 

(AVC) 

Video Codec MP4 AVC means- Advance Video Coding 

Widely support Video Codec 

Better bitrate than a H.263 

H.265 

(HEVC) 

Video Codec MPEG-H 

HLS 
HEVC- High Efficiency Video Coding 

Half the bitrate of H.264 

Good for high resolution and live streaming. 

ProRes Video Codec ProRes 4444 

ProRes422 (HQ) 

ProRes422 

ProRes422 (LT) 

ProRes422 

(Proxy) 

Encoding with Variable Bitrate. 

Supported by all editing softwares. 

ProRes is a 10bit video codec. it process a lot 

more color data. 

DNxHD Video Codec MXF 

MOV 
Delivers very high HD image quality while 

requiring 20% less storage capacity. 

R3D Video Codec R3D 

REDCODE 
RAW file format Introduced by RED digital 

camera. 

Each color channel data is stored separately, 

and then converted into a full color image 

with the aid of software. 

VP9 

 

Video Codec WebM 

MPEG-DASH 
Developed by Google 

Half the bitrate of VP8 

Good for high resolution and live streaming. 

Used by Youtube 

MP3 Audio Codec MP3 MPEG-2 Audio Layer III 
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Popular with wide support 

Save space without quality loss 

AAC Audio Codec MP4 Advance Audio Coding 

Proprietary Audio Codec 

Widely Supported 

More efficient than MP3 

AC-3 Audio Codec AC-3 Dolby Digital Audio Codec 3 1.1 surround 

sound 

Dolby Digital audio on DVD, Blu-ray and 

other digital video formats. 

AIFF Audio Codec AIFF Typically used in mac OS. 

Lossless audio format 

DPX Image Codec DPX Used to transfer Film image in digital 

medium without quality loss. 

Exported as frame sequence which contains 

a series of still image. 

TIFF Image Codec TIFF Uncompressed image format 

Mutiple layered image can be stored in single 

TIFF file. 

PNG Image Codec PNG It can save the image with transparent 

background. 

GIF Image Codec GIF It contains 256 indexed colour. 

Uses lossless compression. 

1.4 Frame Rate   

Do you ever watch a movie named ‘Taare jameen Par’, (Figure 1.15) where Ishaan 

moves his flip book and the Pencil sketch creates an illusion of motion. 

This is the concept of how video works. Film or video is a series of still pictures, when it 

moves at a certain speed, it looks in a motion. 

 

Fig. 1.15 Flip book of Ishaan (Taare Jameen Par) 

Frame means still image which is captured by video camera in a sequential form. Frame 

rate is the number of frames which is captured in one second. It is usually expressed in 

“frame per second” or FPS. For example, if you shoot a video with a frame rate of 25 fps, 

it means 25 still frame capture in a second. 
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1.4.1 Why frame rate is important? 

Imagine you are watching a cricket match, suddenly a batsman is not able to reach the 

crease and decision is pending to the third umpire. (Figure 1.16) While watching footage, 

umpire observes that few frames are missing when the batsman sliding his bat to crease. 

 

Fig. 1.16 Still from cricket match 

Why this happened? Where are the missing frames? 

The answer is frame rate. Because video is picturized in 50 fps frames, which is not 

sufficient for capturing every detail of fast motion. So, to capture the missing frame, add 

more frames in the video. It means we have to increase frame rate from 50 fps to 120 

fps or even more. So after increasing the frame rate you will get the missing frames 

which will help the umpire to make his decision. 

To experience the real world, when you are watching with your eyes, then keep the frame 

rate 24fps. Movies are usually shown at 24fps. Video that have lot of motion should 

pictured in higher frame rate. Higher frame rate keeps movement smooth and details 

crisp. On the other hand, if we want to show passing long duration in short time, like 

movement of sky, sunrise, sunset then keep the frame rate slower than normal. 

1.4.2 Difference between frame rates 

When you see an object is moving, such as a car is passing on the road or a football is 

moving in the stadium during football match, then you can see the motion is blur in the 

video. It means you need high frame rate. But If you increase the frame rate too high 

things will look unnatural. On the other hand, if you choose a frame rate too low, then 

the video will start looking choppy. (Figure 1.17) 

 

Fig. 1.17 various frame rates 

To help figure out which frame rate is best for you, let’s look at a few common options 

and how they’re used in Table 1.3. 

Table 1.3 various frame rates and their specific uses 

Frame rate Specific Uses 

24fps Feature film, Television shows, most cinematic frame rate. 
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30fps Live TV and sports, soap operas and video recording apps for smart 

phones, like Instagram. 

60fps 60fps, 120fps, and 240fps are all high frame rates used for slow motion. 

Typically, video is recorded in 60fps and then slowed down to 24fps or 

30fps in post-production to create that smooth slow motion effect. 

60+fps Used to create slow-motion video or to record video game footage. 

More to Know 

Since 1927, the standard frame rate for film has been 24 fps. For TV the standard is 

30 fps for NTSC (National Television System Committee – the system used in North 

America, Japan and many other areas around the world), 25 fps for PAL (Phase 

Alternating Line – the system used in Europe, parts of Africa and SE Asia). 

1.4.3 Frame rates for different medium 

Television 

TV and film frame rates are standardized by The Society of Motion Picture and Television 

Editors, also known as SMPTE. PAL and SECAM use 25 FPS in Europe, parts of Africa 

and SE Asia and in Japan they use 29.97 NTSC. (Figure 1.18) 

 

Fig. 1.18 Television Standards 

Film Projectors 

You have seen in Cinema hall a projection light coming from the back and projected on 

screen. This light is coming from the projector. 24fps is the standard frame rate of many 

cameras and Cine projector, which is running in sync speed. 

Streaming video on the Internet 

It is important to remember frame rate and file size while exporting the video. If you 

increase the frame rate then more frames combined in each second and it will increase 

the size of the video and export time. This is especially important to consider when you 

are going to upload video on streaming sites like Youtube, Vimeo and Screencast. 

Assignment 3 

Convert 60 fps video at 30fps and observe the change. 

1.5 Resolution 

Resolution means the number of horizontal lines in the screen. Each lines have specific 

number of pixels in width. 
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Video resolution= Number of horizontal lines x Number of pixels in each line 

If we take a video file of 1080p, then as shown in the Figure 1.19, it has 1080 lines 

horizontally, with each line contains 1920 pixels. 

 

Fig. 1.19 Video Resolution 

For example, 360P, 480P, 720P or 1080P – here these number represent the number of 

horizontal line in a video from top to bottom as shown in Figure 1.20. 

 

Fig. 1.20 Diagram of Image Resolution 

More to Know … 

“i” to represent interlaced and “p” to represent progressive. For example: 480p or 480i. 

Interlaced scanning is simply displaying alternating sets of lines in specific frame rate. 

First even number lines are displayed and then odd number lines, such as 480i video 

with 25fps display the 240 odd lines in 1/50 sec and then 240 even lines in 1/50 

seconds. (Figure 1.21) 

On the other hand 480p Progressive video with 25fps displays the entire 480 lines in 

a second. 

 
Fig. 1.21 Interlace and Progressive Scanning 
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So the quality of any video depends upon the video resolution. The quality defer as the 

video resolution becomes smaller, as shown in Figure 1.22 and Figure 1.23. 

 
Fig. 1.22 Video Resolution (1920x1080) 

 
Fig. 1.23 Video Resolution (640x480) 

Assignment 4 – Identify the resolution of DSLR camera as shown in Figure 1.24. 

 
Fig. 1.24 DSLR camera resolution 

1.6 Aspect Ratio 

In any film or video, aspect ratio means the ratio of horizontal length with respect to its 

vertical width. It is also known as the ratio of frame width to height. 

Aspect Ratio = Frame Width/ Frame Height 

For example, If a video has a resolution of 1920x1080 

Then Aspect Ratio of this video =1920/1080= 16/9 Or 16:9 

You can also define 16:9 aspect ratio as a 1.77:1. It means frame width is 1.77 time 

larger than frame height. It is shown in Figure 1.25. 
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Fig. 1.25 various aspect ratios 

Table 1.4 Most widely used aspect ratios 

Most widely used aspect ratios for Distribution 

Standard Video- 

Television / YouTube/ Internet Video/ Netflix 
16:9 

Cinema standard widescreen 1.85:1 

Cinema “anamorphic” 2.35:1 

IMAX Cinema 1.43:1 

Academy 1.375:1 

Another version of academy 4:3 

Still Camera DSLRs 3:2 

Some mirror-less still cameras 4:3 

Vertical Video 9:16 

1.6.1 Relationship between Resolution and Aspect Ratio 

Do you think, how the width resolution of any video is decided? Like in 480p, number 

of horizontal line is 480. For deciding the width of the video you need to multiply the 

horizontal line with aspect ratio. 

For example, in 480p video with aspect ratio 4/3 the number of pixel in width will 

be=480 x 4/3 =640 pixels 

Resolution of 480p=640 (no. of pixels in width) x 480 (no. of Horizontal lines) 

Table 1.5 Relationship between Resolution and Aspect Ratio 

Name Pixels (width x height) Aspect Ratio Notes 

Standard Definition (SD) 

360P 640x360 16:9 Mobile devices 

480p / 

480i 

640×480 4:3 Resolution for DVD 

Burning 

576p / 

576i 

720×576 (or 704×576) 4:3 PAL 

High Definition (HDTV) 
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720p 1280×720 16:9 HD Resolution 

1080p / 

1080i 

1920×1080 16:9 Standard Resolution for 

HD Television 

Ultra High Definition (UHDTV) 

4K 

(2160p) 

3840×2160 16:9 Exactly 4 × 1080p 

8K 

(4320p) 

7680×4320 16:9 Exactly 16 × 1080p 

8640p 15360×8640 16:9 Exactly 32 × 1080p 

Digital Cinema (DCI) 

2K 2048 × 1080 1.90:1 The first generation of 

digital cinema projectors. 

4K 4096 × 2160 1.90:1 2nd generation digital 

cinema. 

Assignment 5 – Shoot a video from DSLR camera and change its aspect ratio by 

cropping frame. See its impact. 

Summary 

1. Video files are stored in container format that holds the compressed Video 

stream, audio stream, subtitle and metadata. 

2. Some of the most popular video formats are MPEG, MOV and AVCHD. 

3. Codec means compression and decompression. It encoded video and audio 

stream to make it smaller. 

4. Some most important video codec are H.264, H.265, ProRes, DNxHD. 

5. MP3, AAC and AIFF are most vital audio codec. 

6. Frame rate means number of frame captured in one second. It is expressed by 

FPS. 

7. Feature films, TV shows and most cinematic have the frame rate of 24fps. 

8. Frame rate is responsible for creating slow motion and fast motion footage such 

as 120fps creates slow motion video whereas 15 fps video looks fast in motion. 

9. Resolution refers the number of horizontal line in the screen. Each line has 

specific number of pixels in width. For example in 1920x1080, 1080 line in frame 

and each lines have 1920 pixels. 

10. Aspect Ratio means the ratio of horizontal length with respect to its vertical width 

such as 16:9, 4:3 
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Check Your Progress 

A. Multiple Choice Questions 

1. Which of the following is not the part of video (a) video file (b) audio file (c) meta 

data (d) slide 

2. Consumer video camera designed for (a) personal use (b) professional use (c) Both 

personal and professional use (d) consumer use 

3. Zoom ring is located on (a) inside the lens (b) Lens housing (c) Camera body (d) 

outside the lens 

4. MP4 container developed by ______ (a) Microsoft (b) Apple (c) Panasonic (d) Motion 

Picture Expert Group 

5. MOV is a _______ based container (a) Windows (b) Mac (c) Linux (d) Android 

6. Which is a codec for MP4 file (a) H.264 (b)VP9 (c) AAC (d) WMV 

7. AAC is an_________ codec (a) Video (b) Audio (c) Video and audio (d) Text 

8. Full form of FPS (a) Frames per second (b) Fields per second (c) Frames para 

second (d) Frames per shot 

9. Frame rates used for slow motion video. (a) 24 fps (b) 30fps (c) 50fps (d) 60fps 

10. Resolution means (a) Number of vertical lines in screen (b) Number of Horizontal 

pixels in screen (c) Number of vertical pixels in screen (d) Number of Horizontal 

lines in screen 

11. 4K video resolution is ________ (a) 1920 x 1080 (b) 2560 x 1440 (c) 3840 x 2160 

(d) 2048 x 1080 

12. Aspect Ratio is the ratio of frame _________ (a) height over width (b) width over 

height (c) length over width (d) width over length 

B. Fill in the blanks 

1. What appear in screen during playback contains in __________. 

2. DSLR refers to _______. 

3. In any shot,  ________ highlight the small area or detail of the subject. 

4. Industry standard format for stand alone DVD player is ______. 

5. The word codec is a combination of ________ and___________. 

6. H.264 is ________Codec. 

7. TV and Film frame rates are standardized by The______________. 

8. Aspect Ratio= Frame Widthover________ 

9. Aspect Ratio of cinema standard widescreen is________ 

C. State True or False 

1. Pro consumer camera lies between consumer camera and professional camera. 

2. Extreme Long Shot is used to show the subject from distance. 

3. By controlling the aperture, light can be controlled. 

4. Metadata stores the information about the video and audio streams. 

5. WebM video format is developed by Microsoft. 

6. The file extension of asf file format is .wmv. 
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7. VP9 video codec is good for live streaming. 

8. Keep the video camera frame rate 24 fps to experience the natural motion. 

D. Short answer questions 

1. Describe different types of video camera. 

2. Write the drawbacks of DSLR camera when using video recording purpose? 

3. Write about various camera controls. 

4. Explain different shot sizes. 

5. Categorise different video activities. 

6. What is Video file format? 

7. Write the file extension of following video format (a) MPEG (b) AVI (c) AVCHD (d) 

MOV 

8. What is Codec? List different video and audio Codec. 

9. What is Frame rate and why it is important? 

10. What is video resolution? 

11. What is Aspect ratio? 

12. Write down the aspect ratio of (a) Standard Video (b) IMAX Cinema (c) Academy 

(d) Vertical Video 

13. Write the relation between Resolution and Aspect ratio. 

14. Calculate the width of video frame of 720p, 16:9. 

 

Session 2: Raw Footage: Tools and Technique 

Raw footage means the video footage which is captured/shoot during any program 

production. Whenever you are planning for any program, you need to be specific about 

equipment like camera, lighting and others. For instance if you picturize documentary 

in forest then you may need infrared camera, special lighting and specific 

tripod/monopod. Because maybe you need to travel long distance by walking and even 

need to shoot during night. 

Imagine what kind of shooting techniques is used in science fiction movie like Star Wars 

and Avenger endgame. Since in these movies, lots of special effect and visual effects are 

used. During shooting of these type of movies, different production techniques like 

chroma keying are required. 

In this chapter, you will understand the process of capturing the footage for VFX and 

animation using rotoscoping. A few techniques used for picturising special effect and 

visual effects are discussed here. 

2.1 Chroma Keying 

Chroma key is a matte derivation method, which uses specific keying color like blue or 

green for the background. Here we pictured any person or object in front of these 

backgrounds and then extract this person. In Figure 2.1 it’s a technique of visual effects, 

where two videos or images are composited. 
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Fig. 2.1 Steps of Chroma Key 

When shooting in real location is not possible, Chroma key/green screen technique is 

used, which is later used for compositing with background in a scene. For example, to 

create a visual effect scene like train passing while a person/character is crossing the 

railway track or any explosion scene behind the character. In Figure 2.2, observe that 

a boy stand near the lamp post and green screen is appearing in the background. 

 

Fig. 2.2 Chroma key Background (movie- Hugo) 

In Figure 2.3, green screen is replaced by a bridge, dark sky and a train. So you can use 

green screen for creating a scene which is not possible to shoot in live action. 

 

Fig. 2.3 After replacing the Chroma key background with CGI background 

(movie- Hugo) 

2.2 Rotoscoping. 

Rotoscoping means tracing live action footage frame by frame. It is used in in visual 

effect. In animation, it is used for tracing complete frame or any part of frame and then 

painted on it, it looks like 2D animation. In visual effect, it is used to create a matte or 

mask of an element, then it can be extracted out and put it on a different background. 

Today, every film with special effect needs lot of roto work. (Figure 2.4 and Figure 2.5) 
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Fig. 2.4 Tracing the frame and painted over it 

 

Fig. 2.5 Extract the lion and place it into different background through 

rotoscoping 

To take out some elements from live action footage or put some element on it, knowledge 

and skills of this technique is required. An average 20 to 25% times consumes in roto 

work of any VFX or special effect project. 

2.2.1 Comparison between Chroma key and Rotoscoping 

It is difficult to differentiate between these two techniques, as both techniques are 

looking similar. To select the right one, let us discuss some situation. 

In outdoor shooting there are problems like uneven lighting, then rotoscoping can be a 

better option. If it is not possible to shoot with a colored screen or if a decision is made 

after shooting that you want to use only foreground, then rotoscoping foreground image 

is a right technique to create a matte. 

If you want to put something in the middle ground like a person is crossing the road 

and suddenly a lion cross the road, then it takes lot of efforts and time with chroma key 

technique but in rotoscoping, it can be done with the same footage. 

In a studio environment or even in outdoor where the condition is in your control, then 

you can go with chroma, because it is an easy to extract an object. 

Chroma key is a cost cutting technique, if we compare it with location shooting. If you 

shoot it perfectly, then it reduces the work of rotoscoping. 
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More to Know 

In Chroma key, we used Green or Blue background. Green and blue are on the opposite 

end of the color spectrum from red and orange, which is the main color of skin tones. 

In fact, skin tones don’t have any blue or green tone naturally. It is important that the 

foreground person doesn’t wear any costume or don’t have any color which have the 

tones of the background. 

2.2.2 Materials required for Chroma key 

You will need many materials for rotoscoping, which are discussed next. 

A Green or Blue screen 

Blue or green muslin cloths are used for Chroma key. Place it tightly in the background 

Figure 2.6 (a) & (b). Make sure, there should be no wrinkle, folds, crease in the 

background cloth. 

 

Fig. 2.6 (a) Wrinkled Chroma key  (b) Pefect background for chroma key 

background 

Tripod 

Tripod provides stability to the camera. Check the zero level of tripod after setup the 

camera on it. (Figure 2.7 (a) & (b)). 

 

Fig.2.7 (a) Tripod 

 

Fig.2.7 (b) Bubble level for tripod balancing 

Lighting 

Use big soft light sources, which create even lighting in the Chroma key background. If 

you use a hard-light source such as tungsten light, then the light creates the hot spot 

or gradient surround it, which come out with uneven lighting in the background. (Figure 

2.8(a) & (b) 
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Fig. 2.8 (a) tungsten lighting 

 
Fig. 2.8(b) Soft box 

Camera 

You can use Digital Single Lens Reflex (DSLR) camera or video camera for recording. 

Keep in mind that camera should be higher resolution. (Figure 2.9 (a) & (b)) 

 

Fig. 2.9 (a) Video Camera 

 
Fig. 2.9 (b) DSLR Camera 

Software 

For keying or removing green/blue background you can do it on Adobe Premiere easily. 

It is shown in Figure 2.10 and 2.11.  
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Fig. 2.10 Chroma key with Adobe Premiere Editing Software 

 
Fig. 2.11 Complete setup of Chroma key shoots in studio 

 

Practical Activity 1 – Shoot a video with a Chroma key background and remove 

the background using Adobe Premiere software. 

Material Required 

Green/blue screen, Tripod, Lighting, Camera, Software-Adobe Premiere 

Step 1. Get a backdrop 

First, get a piece of muslin cloth of bright shade of green. Blue screen backdrops are 

also available, but they can cause problems if the cameraman’s eyes or clothes are 

blue. To avoid hanging a cloth, a collapsible green screen panel is a good option, as 

shown in Figure 2.12. 

 
Fig. 2.12 Chroma key background panel 



 

Roto Artist, Grade XI 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

89 

Step 2. Pick your camera 

Next, you’ll want to pick a camera that shoots HD quality video (720p or higher). Make 

sure your camera saves out files in a format your green screen software can import. 

Most digital camcorders will work. (Fig. 2.13) 

 
Fig. 2.13 Select video camera 

Step 3. Set up your lighting 

While shooting the green screen should be flat and shadow of the object should not 

cast over the green screen, as shown in Figure 2.14. 

 
Fig. 2.14 Lighting setup for chroma key 

The sketch diagram of Chroma key lighting technique is shown in Figure 2.15. 

 

Fig. 2.15 Chroma key lighting technique 
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Key light – It is main source of light to illuminate the subject. Ideally it is placed in 

45 degree from camera position. 

Fill light – It fills the shadow created by Key light. 

Back light – It is used to separate the subject from background. 

Background light – It is used to illuminate Chroma background evenly. 

Step 4. Shoot the object 

Finally, to shoot the object, place the object minimum 5 feet far from Chroma key 

background, as shown in Figure 2.16, so that the object shadow will not cast over 

background. Now record the video with the camera. 

 
Fig. 2.16 Shoot the video 

Step 5. Edit it in software 

In Adobe Premiere editing software, remove the green screen by using keying effect 

and insert the desired background. The Figure 2.17 shows that the green background 

is replaced with the blue background. 

 
Fig. 2.17 Edit the video in editing software 

 

More to Know… 

As we mentioned key, fill, back and background light. Basically it is three point 

lighting techniques used in studio lighting. You can use different light source such as 

LED light, tungsten halogen lamp in this lighting technique. 

2.3 Rotoscoping tools 

Rotoscoping can be divided into the two forms – (I) Traditional or analog rotoscoping 

and (ii) Digital rotoscoping 
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2.3.1 Traditional or analog rotoscoping 

In traditional rotoscopy the method involved using a movie projector to project a single 

frame on a surface. Then the projected images are traced by hand on the paper and 

rephotographed frame by frame. 

Early visual effects artists used a variation of this method to create their mattes as well. 

This process involved an animation camera focused on a special table. The camera was 

loaded with already processed footage. By installing a light behind the camera, it was 

converted into a projector that would project a single image down onto the pin-registered 

camera bed, where the artist would pencil trace the image onto a peg-registered sheet 

of paper. 

This pencil work was rephotographed frame by frame and tested for its integrity against 

the original. If additional work was needed they would go back and readjust the pencil 

drawings. After finishing, the images are transferred and inked to peg-registered 

animation cells and rephotographed on high-contrast black & white film. 

 

Practical Activity 

Record a video clip of 5 Sec duration to a DSLR or Mobile Camera and Convert it in 

2D animation with traditional rotoscoping. 

Material Required 

DSLR camera, trace paper, Pencil, Adobe photoshop. 

Step 1. Recording the video 

Record the video of a person for 5 second duration in even background. 

Step 2. To convert video into still photograph 

• Open the video file in Photoshop 

• Open Photoshop, go to File > Open and navigate to a folder with video file, 

select it and click Open. 

• Select a start and end point. Here, we have selected 5 seconds from the video 

clip. 

• Define the image size 

• Go to File > Export > Render Video 

• Choose Photoshop Image Sequence instead of Adobe Media Encoder, 

• Select a desired image size, 

• Define a frame rate, 

• Keep Work Area of Photoshop as Range option, and click Render. 

Step 3. Tracing the image 

• Delete all the even number of frames from the folder. This process will cut 

down the time needed for tracing. 

• Print all the remaining frame on the paper with the help of inkjet or laser 

printer. Give the number to each printout. 

• Trace each printout by giving its number again. 

Step 4. Edit and Export 
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• You will need an application like Stop Motion to capture each tracing. Always 

take 2 frames for each drawing to compensate the deleted even number 

frame. 

• After tracing all the frames, render the footage to a final .mp4 format file. 

2.3.2 Digital Rotoscoping 

From analog to digital, rotoscoping concept are the same. The only differences are in the 

tools and media used in digital rotoscoping. Following are the list of tools used in digital 

rotoscoping. 

Computer Workstation 

A computer workstation is an essential machine for digital rotoscoping. (Figure 2.18) A 

computer with latest configuration should be preferred. 

 

Fig. 2.18 Computer workstation setup 

Rotoscoping Software, where you can work in your live visuals as shown in Figure 

2.19 (a) –(f). 

 
Fig. 2.19(a) After Effects          (b) Silhouette FX                        (c) Nuke 

 

 
(d) Mocha                 (e) Autodesk’s Flame                    (f) Blackmagic’s Fusion 

Mouse, track pad or graphics tablet to create traditional rotoscoped animation as shown 

in Figure 2.20 (a) and 2.20 (b). 
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Fig. 2.20 (a) Touch tablet with creative pen   (b) Rotoscoping in tablet 

In 1990, Software likes Colour-burst, Commotion and Matador used for rotoscoping. 

More modern software that can be used for various level of Rotoscoping includes Adobe 

Flash, Adobe Photoshop, Adobe After Effects, Imagineer Systems' Mocha, Silhouette, 

Autodesk's Flame and Smoke, Blackmagic's Fusion and Foundry's Nuke, Ocula and 

Mari, among others. 

Summary 

1. Chroma key is a compositing technique, where we can key the background of 

specific colour like blue or green. 

2. Rotoscoping means tracing live action footage frame by frame. 

3. In animation, Rotoscoping is used for tracing complete frame or any part of frame 

and then painted on it. 

4. In Visual Effects, Roto is used to create matte or mask of an element. 

5. Material required for Chroma key are- green or blue colour muslin cloth, camera, 

tripod and lighting. 

6. In Chroma keying, Use soft light source for background. It creates even lighting in 

background. 

7. In traditional rotoscoping, a movie project was used to project a single frame    on 

to a surface. Then this image traced by hand on to paper. 

8. In Digital rotoscoping, we required Computer workstation, Rotoscoping software, 

mouse trackpad and graphic tablet. 

 

CHECK YOUR PROGRESS 

A. Multiple Choice Questions 

1. Which type of background are used in Chroma key (a) Black and white (b) Red 

and Yellow (c) Red and Orange (d) Blue and Green 

2. Rotoscoping means (a) tracing live action footage frame by frame (b) tracing first 

frame of each video (c) tracing last frame of the video (d) tracing 

3. Tripod provides __________ to the camera (a) Safety (b) stability (c) Motion (d) 

Track 

4. Rotoscoping is better option for ________ (a) Indoor Shooting (b) Outdoor Shooting 

(c) Outdoor location with lots of problem (d) None of the above 

5. Which type of lighting is used in Chroma key background (a) Focus (b) Uneven 

(c) Even (d) Point 
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6. Key light is _____, (a) Main source of light (b) used to separate subject from 

background (c) used to fill the shadow (d) None of the above 

7. Which of the following software is not used for removing Chroma key background 

(a) Adobe Premiere Pro (b) Adobe After effect (c) Silhouette FX (d) Adobe Audition 

8. Which of the following is not required in traditional rotoscoping (a) A movie 

projector to project a frame. (b) a tracing paper (c) Pen or pencil (d) trackpad 

9. Which of the following is not required in digital rotoscoping (a) Computer (b) 

Rotoscoping Software (c) mouse or trackpad (d) projector 

10. In 1990s, which software is used for rotoscoping (a) Adobe photoshop (b) Colour 

burst (c) Corel draw (d) GIMP 

B. Fill in the blanks 

1. Chroma key is a ______ derivation method. 

2. Rotoscoping is a technique of _________. 

3. An average _______ times consumes in roto work of any VFX or Special effect 

project. 

4. When shooting in control environment, you can use________ 

5. The opposite end of the color spectrum from red and orange are ____ and 

______. 

6. Blue or green muslin cloths are used for ________. 

7. Back light is used to separate the subject from ________. 

C. State True or False 

1. Chroma key is a technique of visual effects, where two videos or images  are 

composited. 

2. Chroma key technique is used for creating a scene which could not shoot or 

possible in live action. 

3. Use hard light sources, in chroma key background. 

4. Fill light fills the shadow created by background light. 

5. In Graphic Software, you can work in virtual layers. 

6. Matador is a modern rotoscoping software. 

D. Short answer questions 

1. What is keying? 

2. Why we use green or blue background in Chroma keying? 

3. Compare between Chroma key and Rotoscoping. 

4. List the material required for chroma key. 

5. Write the material required for Digital Rotoscoping. 
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Session 3: Rotoscoping Software 

Rotoscoping or “Roto” is a general term used for extracting a portion of an image 

or video. It is the most important part of the visual effect process. Shifting from 

traditional to digital rotoscopy started in 1990s, Bob sabiston, a computer 

scientist developed a process known as ‘Interpolates rotoscoping’. Sabiston made 

a program named ‘Rotoshop’. The technique of rotoshop is adopted from 

sketching, where artist traced first image and then copied it for next movement. 

It saves the time of sketching the second image. Another program ‘Matador’ was 

used for rotoscopy on hundred of feature film between 1990s to early 2000 

including Jurassic park, forest gump and hulk. Matador was a paint application. 

Its main characteristics were paint, mask creation, animation, image 

stabilization and tracking. 

In comparison to traditional roto artist, a digital roto artist can do the eight time 

more work in 1/4th of time. 

Rotoscoping Software 

Currently many advanced software are being used for rotoscoping. It includes 

After Effect, Silhouette, and Nuke. After Effect is layer base software while Nuke 

and Silhouette are Node base software. 

Layer base Software – In this software each media object represents as a 

separate layer within a timeline, each with its own time bounds, effects, and key 

frames. A screen shot of Layer based Software (Adobe After Effect) is shown in 

Figure 3.1. 

 

Fig. 3.1 Layer based Software (Adobe After Effect) 
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Fig. 3.2 Node based Software (Silhouette FX) 

Node base Software – It is handling the often complex compositing tasks by 

linking together several simple image operations. Each of these operations is 

referred to as a “node,” and together they make up a schematic node-tree that 

appears similar to a flowchart. A screen shot of Node based Software (Silhouette 

FX) is shown in Figure 3.2 

Let’s take an overview of different software used in Rotoscoping. 

3.1 Adobe After Effects 

As its name suggests, it works after editing i.e. in post-production stage. For 

example, to add some fancy titles to the video or to make an informational 

graphic animation video for presentation and some time to bring multiple assets 

together for creating a scene of plane crash then definitely you have to work on 

After Effects as shown in Figure 3.3. 

 

Fig. 3.3 Plane crash scene composite in After Effects 

After Effects is a digital visual effects, motion graphics, and compositing 

software. It has different roles for individuals For example, video editors use After 

Effect for title design, VFX artists use it for rotoscoping and compositing, while 

an animators use it for a 2D cartoon character. 

It was originally created by David Herbstman, David Simons, Daniel Wilk, David 

M. Cotter, and Russell Belfer at the Company of Science and Art (CoSA) in 

Providence, Rhode Island, where the first two versions of the software, 1.0 and 

1.1, were released by the company in Jan, 1993. CoSA along with After Effects 

was then acquired by Aldus corporation in July 1993, which was in turn 

acquired by Adobe in 1994. Adobe release version 3.0 in 1994 and then goes all 

the way to current Adobe After Effect CC 2020. 

3.1.1 Key feature of After Effects 

Chroma key and rotoscoping technique 

Chroma key is a technique of background separation by keying green or blue 

background, as shown in Figure 3.4. While in rotoscoping we trace the natural 

footage and main object is extracted. 
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Fig. 3.4 Chroma Key technique 

Text animation 

You can create dynamic text animation using the many typography tools within 

After Effects. There are lots of filters and effect with a camera and motion 

tracking which creates the illusion of 3D text animation. (Figure 3.5) 

 

Fig. 3.5 Dynamic Text Animation 

Compositing 

Compositing means putting the entire visual element together to establish final 

scene as per screenplay. Figure 3.6 shows all the visual elements like sky, 

clouds, moon and UFOs are arranged in a city landscape scene. 

 

Fig. 3.6 Example of Compositing 

Warp stabilization 

If you shoot handheld video from smartphone or DSLR then definitely it will 

become shaky. Warp stabilizer provides a tool which can correct motion shake 

or jerk in video. It is an effect which can easily apply to the footage and within a 

minute your shaky video will become smooth. 
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3D Camera tracking 

After effects has a powerful camera tracker. It allows to position any object into 

a video clip. The object moves with background movement and feel like it is a 

real object. (Figure 3.7) 

 

Fig. 3.7 Still from 3D Camera tracking 

Color grading 

In color grading, we perform color correction in final edited footage (Figure 3.8). 

 

Fig. 3.8 Colour grading (before and after) 

Motion graphics animation 

Motion graphics means the static graphics which has movement or motion. After 

Effects software allows to create graphics with shape and solid layer or you can 

create it in any graphics software like Photoshop, illustrator and add a motion 

later in After Effects as shown in Figure 3.9. 

 
Fig. 3.9 Motion Graphics 
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3.1.2 Roto feature in After Effect 

Rotoscoping can perform in After Effect by three ways. 

1. Key frame Masking – Frame by frame rotoscoping using pen tool. 

2. Rotobrush and refine rotobrush – It automatically select the object. 

3. After Effect Mocha – It uses spines for selection. 

Table-1 System requirement for adobe after effects CC2019 

Adobe after effects CC2019 runs in windows and Mac OS 

 Windows OS Mac OS 

Processor Multicore Intel processor 

with 64-bit support 

Multicore Intel processor with 64-bit 

support 

Operating 

system 

Microsoft Windows 10 (64 

bit) versions 1703  and later 

Mac OS versions 10.12 (Sierra), 

10.13 (High Sierra), 10.14 (Mojave) 

RAM 16 GB minimum (32 GB 

recommended) 

16 GB minimum (32 GB 

recommended) 

Hard disk 

space 

5GB of available hard-disk 

space (cannot install on 

removable flash storage 

devices). Additional disk 

space for disk cache (10GB 

recommended) 

6GB of available hard-disk space for 

installation (cannot install on a 

volume that uses a case-sensitive 

file system or on removable flash 

storage devices) 

Additional disk space for disk cache 

(10GB recommended) 

Monitor 

resolution 

1280x1080 or greater 

display resolution 

1440x900 or greater display 

resolution 

Internet Internet connection are necessary for required software activation, 

validation of subscriptions, and access to online services. 

3.1.3 Advantage of After Effects in Rotoscoping 

1. We can easily draw mask in after effects. 

2. We can animate mask path and then use this mask to define matte. 

3. The roto brush tool and refine edge tool allow a faster workflow for 

segmentation and creation of matte. 

4. Refine edge tools use for improvement of the existing matte by creating 

partial transparency along an area that contains fine details such as hair. 

5. Motion tracking helps the moving object rotoscoping. 

Practical Activity 1 – Create a composition in After Effect and understand it’s 

interface. 

Procedure 

Step 1. Open Adobe After Effects software by clicking on software icon as 
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shown in Figure 3.10. 

 

Fig. 3.10 Open Adobe After Effects software 

Step 2. Adobe After Effects welcome screen appears, as shown in Figure 3.11. 

 

Fig. 3.11 Welcome screen of Adobe After Effects 

Step 3. Click on New Project, Now software Interface opens. Here you can see 

project window, composition, timeline and tools. It looks like the interface of 

Adobe Premiere, as shown in Figure 3.12. 

 

Fig. 3.12 Adobe After Effects interface 

Step 4. Right click on Project window to import a file or complete folder in the 
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project window, as shown in Figure 3.13 (a) & (b). 

 

Fig. 3.13 (a) Import file and folder into the software 

 

Fig. 3.13(b) Search the desired file 

Step 5. Now Video file is imported in project window. Drag this file over ‘create 

a new composition’. Timeline is created and video clip is displayed on the 

composition panel, as shown in Figure 3.14. 

 
Fig.3.14 Create a composition in After Effects 
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3.2 Silhouette 

Silhouette is best industry standard software for visual effects. Silhouette 2020 

is the latest version available in the market now. It is using stereoscopic 

workflow, where it can perform rotoscoping, paint, warping, keying, matting, 

morphing and 2D-3D conversion. It is a node base software. 

More to know 

Silhouette FX is named for the art form associated with Étienne de Silhouette 

(July 8, 1709 – 1767). The fundamental of silhouette is a matte which appears 

as a silhouette of an object. 

3.2.1 Key feature of Silhouette 

Rotoscoping – In this technique, VFX Artist trace frame by frame footage to 

incorporate in live action sequences or in animation movies. 

Paint Job – Silhouette FX added the paint package within the application. With 

the help of this package, artists can easily remove the wires which are used 

during shooting. Additionally, the advance paint feature helps to remove the 

blemishes in the footage. 

2D to 3D conversion – this ground-breaking feature is added to the application 

during the launch of its Fourth version. With the help of the feature, users can 

convert two-dimensional motion pictures into three-dimension. 

Mocha – The application is added more value by adding Mocha Planar tracking 

system licensed from Imagineer Systems that was integrated into the Fifth 

version. 

Morph & Warp – The recent fifth version of the software added advanced high-

speed shape driven Morphing and Warping technologies. 

3.2.2 Rotoscoping in Silhouette 

In Silhouette, you can easily create sophisticated moving mattes. It’s pen tool 

can create B-Spline, Bézier or X-Spline shapes. It’s tools like changeable edge 

softness on a point by point basis and realistic motion blur help to work with 

complicated shape animations. It’s integrated motion tracking does boring task 

of rotoscoping very easily. 

3.2.3 Advantages of Silhouette 

Designed for Rotoscoping 

Silhouette FX is specially designed for rotoscoping. It is not specialized visual 

effect program, it has a well-organized work flow to achieve the final output. 

Compatible with Other Programs 

Silhouette FX is working in a dual mode. It can be used as a stand-alone 

program, or as a supporting application with Adobe After Effects or Final Cut 

Pro. If you are working with this software then you can easily go to silhouette FX 

for rotoscoping and then after work you can easily move to main software for the 
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visual effects and compositing. Silhouette FX is also used as a support software 

with Discreet fire, Apple Shake and another program. 

One Stop Solution 

Silhouette FX allows to address all the rotoscoping needs in one place which 

definitely reduce the pain. You can make unlimited number of splines and edit 

them on the spot. You can also add feathering anywhere, as well as easily execute 

accurate motion blurs, which required for higher quality images. 

Designed by VFX Artist 

It is designed by a group of visual effects artists knowing better the VFX 

requirement. Silhouette FX is designed in such manner, so that rotoscoping can 

be performed easy and fast with better result. 

Multiple Frames Adjustments 

Rotoscoping has to be done frame by frame. Hence it becomes painful, tiresome 

and boring work. With silhouette FX, you can move multiple frame at once, 

which makes this process faster. 

Table-02 System requirement of Silhouette 2020 

Silhouette 2020 is the latest version of the software, which needs following 

software and hardware requirement. 

 Windows OS Mac OS Linux OS 

Processor Intel or AMD 

processor 

Intel or AMD 

processor 

Intel or AMD processor 

Operating 

system 

Windows 7/10 64 

bit 

Mac OSX 10.9 and 

above 

Linux distributions 

that conform to the 

CY2016 VFX 

Reference Platform 

www.vfxplatform.com 

RAM 4GB or more 4GB or more 4GB or more 

Hard disk 

space 

1GB of available 

disk space for 

caching and 

temporary files 

1GB of available 

disk space for 

caching and 

temporary files 

1GB of available disk 

space for caching and 

temporary files 

Supporting 

Accessories 

Three-button mouse 

or tablet 

Three-button mouse 

or tablet 

Three-button mouse or 

tablet 

Plug-ins Adobe After Effects CC and above 

Licensing Nodelock licenses require an internet connection once every 

60 days 

Required 

Graphics 

Cards 

NVIDIA GTX 460 or better 

AMD Radeon 57xx series or better 

OpenGL 2.1 capable graphics card 
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OpenCL 1.1 capable graphic card 

1GB of graphics memory for film resolution 

Practical Activity 2 – Import a video clip in Silhouette and perform basic Roto. 

Procedure 

Step 1. Open Silhouette software by clicking on its icon. The welcome screen is 

shown in the Figure 3.15. 

 

Fig. 3.15 Welcome screen of Silhouette software 

Step 2. Create New project by clicking on the New Project option. Give the name 

of project and save in the desired location or folder, as shown in Figure 3.16. 

 

Fig. 3.16 Create new project 

Step 3. Now the Silhouette 2020 interface will open as shown in Figure 3.17. 

 

Fig. 3.17 Silhouette 2020 interface 

Step 4. For import the video clip, Go to the, File> Import> media, as shown in 
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Figure 3.18. 

 
Fig. 3.18 Import media into the software 

Step 5. Import the media file by selecting from File > Import > Media. While 

importing the footage, you can only import the image sequence. So convert the 

video file into the image sequence, as shown in Figure 3.19. 

 

Fig. 3.19 Convering video into the desired format 

Step 6. Select the first image from sequence and click on open. It will import 

image sequence on the sources panel, as shown in Figure 3.20 (a) & (b). 

 
Fig. 3.20(a) Select image sequence 
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Fig. 3.20(b) Image sequence has been imported into software 

Step 7 For display the video, you need to create new session. To create a new 

session, go to the Session > New session, as shown in Figure 3.21. 

 

Fig. 3.21 Create a new session 

Step 8. After clicking on new session, a dialogue box will appear. Image sequence 

format is automatically filled in the box according to the video or image property 

as shown in Figure 3.22, write a session name on it and click OK. 

 
Fig. 3.22 New session dialog box 

Step 9. Now image is displayed on the monitor. Observe that two nodes are 
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formed into trees panel, as shown in Figure 3.23. 

 

Fig. 3.23 A new session is formed into software 

Step 10. In the bottom of the software, you can watch different nodes, as shown 

in Figure 3.24. It has different options such as roto, depth, paint. 

 

Fig. 3.24 Different nodes 

Step 11. Select Roto nodes from Silhouette node group and place it between 

source and output under trees panel, as shown in Figure 3.25. 

 

Fig. 3.25 Insert roto node between source and output 

Step 12. Select Bezier tool from roto toolbar, and trace the outline of image, as 

shown in Figure 3.26 (a) & (b). 
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Fig. 3.26(a) Select Bezier tool in toolbar 

 

Fig.3.26 (b) Trace outline of the object using Bezier tool 

Step 13. After tracing, click on the overlay option and select multiply as shown 

in Figure 3.27. 

 

Fig. 3.27 Overlay option 

Step 14. You can move forward in timeline by clicking X and backward by 
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clicking Z and modify the key frame. (Fig. 3.28) 

 
Fig. 3.28 Move forward and backward 

3.3 Nuke 

Nuke is a node based digital compositing and visual effects application developed 

by Digital Domain and used for television and film post-production. The Foundry 

has further developed the software since Nuke was sold in 2003. Nuke's users 

include the companies such as Digital Domain, Walt Disney Animation Studios, 

Blizzard Entertainment, Dream works Animation, Illumination Mac Guff, Sony 

Pictures Imageworks, Sony Pictures Animation, Framestore, Weta Digital, 

Double Negative and Industrial Light & Magic. The Nuke interface is shown in 

Figure 3.29. 

 

Fig. 3.29 Interface of Nuke software 

3.3.1 Key feature of Nuke 

Nodal toolset 

With over 200 creative nodes, Nuke delivers everything to tackle the diverse 

challenges of digital compositing. This includes industry-standard keyers, 

rotoscope, vector paint tools, color correction and more. 
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Fig. 3.30 Nodal Toolset 

Rotoscoping 

With all tools accessible through an intuitive fold down layer system, the 

integrated Roto node gives precise control over even the most complicated roto 

work within Nuke. 

2D Tracker 

Track an correct difficult objects with ease and accuracy using Nuke Unique 

Keyframe tracking. 

Keying 

Nuke provides a wide range of keyers to assist in extracting mattes from images. 

3.3.2 Advantage of Nuke 

Node based Makes Rotoscoping Flexible and simple 

Nuke is famous for its Node based work flow. In node base, things can be 

changed around anyway and anytime. With roto node, rotoscoping is as simple 

as you want. 

Fully Customisable 

Nuke is fully customisable to set up your workspace. The interface allows to work 

in a number of different ways, whether its through colours, layout or work flow. 

Little features like custom coloured back drops and sticky nodes allows to 

organize the script any way. 

Flexibility 

Nuke has excellent flexibility, It works well with other software like Maya, Mari, 

Modo and Houdini. Nuke able to read different file format for example JPEG, 

TIFF, Exr, Mov and even many more. 

No Quality loss 

Whatever file comes in Nuke, comes out in same quality because of Nuke's 32-

bit floating point linear colour channels. There is colour shift or quality loss. 

With variety of nodes, It's easy to do any adjustment in pictures when needed. 

Easy tracking 

Nuke's 2D tracker has variety of options and menus to make tracking easier. 

You can create keyframes from real life footage with 1 or 4 point track. You can 

even import tracking data from other node based software. 

Nuke has a built in camera tracker that can be used to analyze 2D image 

sequence and automatically reconstruct the 3D camera with unknown, 
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approximate or known focal distance and constant or varying constraints. A 

camera calibrator also allows to track and solve from reference stills, making it 

useful for set or object modelling. 

Animate in different ways 

There are numerous ways of animating in Nuke, such as manually setting the 

key frames on the time line or combine tracking data for a more supported result. 

Furthermore, there is the option of combining the curve editor and dope sheet, 

for better and easier control of key frames. The minimum system requirement 

for Nuke is given in the Table 3.3. 

Table 3.3 Minimum System Requirement of Nuke 

 Windows OS Mac OS Linux OS 

Processor x86-64 processor, such 

as Intel Core 2 Duo or 

later 

x86-64 processor, 

such as Intel Core 2 

Duo or later 

x86-64 processor, such 

as Intel Pentium 4 or 

AMD Athlon, with SSE3 

instruction set support 

Operating 

system 

Windows 7/10 64 bit Mac OS10.13 Mac 

OS10.14 

CentOS 3.4 (64-bit), or 

later 

RAM At least 8GB of RAM At least 8GB of RAM At least 8GB of RAM 

Hard disk 

space 

5 GB of available disk 

space for caching and 

temporary files 

5 GB of available disk 

space for caching and 

temporary files 

5 GB of available disk 

space for caching and 

temporary files 

Required 

Graphics 

Cards 

Graphics card with at least 512 MB of video memory and driver support 

for OpenGL 2.0 (minimum requirement). 

Summary 

• After Effects is layer base software while Nuke and Silhouette are Node base 
software. 

• After Effects software is a digital visual effects, motion graphics and 
compositing software. 

• Other Key feature of after effects are- Keying, Rotoscoping, text    animation, 
warp stabilization, 3D camera tracking, colour grading and motion 

graphics. 

• You can use Keyframe masking, Rotobrush and after effect mocha for 
rotoscoping in after effects. 

• Silhouette is the best industry standard software for visual effects. 

• Key features of silhouette softwares are- Rotoscoping, paint job, 2D to 3D 
conversion, Mocha, Morph and warp. 

• Nuke is other software used in rotoscoping. It is node based digital    
compositing and visual effect application. 

• Some features of Nuke are- its node toolset, rotoscoping, 2D tracker and 

keying. 



 

Roto Artist, Grade XI 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

112 

CHECK YOUR PROGRESS 

A. Multiple Choice Questions 

1. Bob sabiston, a computer scientist developed a process known as ____ (a) Frame 
to frame Rotoscoping (b) Digital Rotoscoping (c) Interpoletes Rotoscoping (d) Pose 
to pose Motion 

2. After Effects is ______ based software. (a) Node (b) Layer (c) Workflow (d) Code 

3. Chroma key is a technique of ________ (a) background seperation (b) Animation 
(c) Visual effects (d) Motion graphics 

4. Rotobrush and refine rotobrush tools (a) Manually select the object (b) 
automatically select the object (c) Clone stamp tool (d) Both manually and 
automatically 

5. In After Effects, motion tracking helps (a) in still object rotoscoping (b) in moving 
object rotoscoping (c) in controlling of motion (d) in recording of motion 

6. Silhouette is a _____ software (a) Layer base (b) Node base (c) Vector base (d) still 
graphics 

7. Silhouette Pen tool does not have (a) B-Spline shape (b) X-Spline shape (c) Bezier 
shape (d) Magic wand 

8. Silhouette FX is specially designed for  (a) Compositing (b) Rotoscoping (c) Color 
Correction (d) 2D Animation 

9. Nuke have With over ____ creative nodes (a)100 (b)150 (c) 200 (d) 300 

10. Nuke has _________ floating point linear colour channels (a) 08 bit (b) 16 bit (c) 
32 bit (d) 64 bit 

B. Fill in the blanks 

1. Shifting from traditional to digital rotoscoping started in _______. 

2. After Effects is a digital visual effects, motion graphics, and____________ Software. 

3. In rotoscoping we trace the ___________and main object is extracted. 

4. Motion tracking helps the ___________ rotoscoping. 

5. The fundamental of silhouette is _______ which appears as a silhouette of an 
object. 

C. True or False 

1. Rotoshop software is used for the Rotoscoping work of movie Jurassic Park. 

2. Nuke is Node base software. 

3. Animators use after effect for 2D Cartoon character. 

4. In After effect, Warp stabilizer provides tool which can correct motion shake. 

5. Silhouette is using stereoscopic workflow. 

D. Short answer questions 

1. Write the difference between layer base and Node base Software. 
2. What is After Effect? 
3. What is warp stabilization? 
4. What is motion graphics? 
5. What is Compositing? Give an Example. 
6. What are the advantages in after effects for rotoscoping? 
7. What is Silhouette? 
8. Write the Key feature of Silhouette. 
9. Write the advantages of Silhouette Fx. 
10. What is Nuke? 
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Session 4. Rotoscoping in Adobe Photoshop 
 

Adobe Photoshop is an Image editing and Image Manipulation software. It is very 

common to use because of its powerful Image editing tools. It can handle video clips 

also. It’s motion feature helps to control the video frames. Hence It is also useful for 

creating Rotoscoping Animation and in object separation for VFX. It’s little bit hard to 

understand in the starting of the chapter. So first take a quick look about Photoshop. 

4.1 Adobe Photoshop 

As we mention earlier Photoshop is pixel/raster base Image Editing software as shown 

in Figure 4.1. Its Interface divided in to five segments. 

• Menu 

• Tool Box 

• Option Bar 

• Work Area Bar 

• Layers Panel 

 

Fig. 4.1 Adobe Photoshop Workspace 

More to Know 

Raster Image – Raster image is created by the pixel-based programs or captured with 

camera and scanner. 

Vector Image – Vector graphics are made up of paths with a mathematical formula 

(vector) that tells the path how it is shaped. It is shown in Figure 4.2 

 

Fig. 4.2 Comparison of Vector and Raster Image 

4.1.1 Menu 

The Menu bar is located on the top of the software. It has 11 elements like File, Edit, 

Image, Layer, Type, Select, Filter, 3D, View, Window and help. You can access their sub-
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menu by clicking on the main menu. (Figure 4.3) Menu bar used in different function 

like Open and save file, select filter, Hide or show any panel and many things. 

 

Fig. 4.3 Menu and submenu in Adobe Photoshop 

4.1.2 Tool Bar 

Tool bar is the space where all the tools is placed.  (Figure 4.4) It is divided mainly in 

four groups. 

• Selection Tool 

• Retouching and Painting Tool 

• Drawing and Typing Tool 

• Navigation Tool 

• Crop Tool and measure tools also come in selection tools group. 
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Fig. 4.4 (a) Photoshop Compact Tool bar      (b) Specific Tools used in 

Rotoscoping 

Table 4.1 Different group of Photoshop Tools 

Selection Tools 

Icon Tool and Keyboard 

shortcut 

Use 

 Move (V) Moves the layers and selections 

 Marquee (M) It is a group of selection tool. Which include 

rectangular, elliptical, single row and single column 

selections. 

 Lasso (L) It is a freehand selection tool. It include polygonal 

and magnetic selection tools. 

 Quick Selection Tool 

(W) 

Selection based on colour and textured similarity. 

Crop Tools 

 Crop (C) 

 

Crops the image. 

Measure Tools 

 Eyedropper (I) 

 

Samples colors from an Image 

 

Retouching and Painting Tools 

 
Spot Healing (J) Remove spots from photos 

 Brush (B) Create soft or hard strokes of colour 

 
Clone Stamp (S) Paint with sample of the Image 

 History Brush (Y) Restore part of an Image for earlier stage 

 Eraser (E) Erase pixels. 

 Gradient (G) Fill an area of an Image 

 Blur It Blurs Pixels. 

 Dodge (O) Lighten pixel of an image. It includes Burn and sponge. 

Drawing and Typing Tools 

 Pen (P) Draw a Vector Path 

 Type Tool (T) Create a type layer 

 Path Selection (A) Manipulate a path 

 Custom Shape Tools (U) Provide different shapes option to draw 

Navigation Tools 

 Hand (H) Navigates the page 
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 Zoom (Z) Magnify the Image 

 

4.1.3 Option Bar 

It sets the option of the tools selected in tools panel like if you select brush tool in tool 

bar then it’s option will be displayed below the menu bar. 

Brush Tool  

 

Fig. 4.5 Option bar of brush tool 

Let’s see the functioning of some Rotoscoping specific tools in Table 4.2, as shown in 

Figure 4.4 (b). 

Table 4.2 Tools used in rotoscoping and their function 

Tools Functioning of Tools Image 

Move Tool It moves/duplicates a selected 

image area or layer. 

 

 

Lasso Tool 

It creates freehand selection. 

 

 

Polygonal 

Lasso Tool 

 

It creates polygonal selections. 
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Magnetic 

Lasso Tool 

 

automatically clinging to edges 

of contrast objects and creates 

selection 

 

 

Quick 

Selection Tool 

 

Make a quick selection based 

on tone and colour 

 

Magic Wand 

Tool 

The magic wand tool can be 

used to select similarly coloured 

area based on luminosity values 

 

Eye dropper 

Tool 

It select colour by taking 

samples from image. 

 

Brush Tool It is used for tracing the outline 

of video clip. 

You can also use brush tool for 

paint the object. 
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Color 

Replacement 

Tool 

It replaces color of image 

without changing image detail 

 

Paint bucket 

Tool 

Fills the continuously colored 

area with the forground color or 

pattern. 

 

Gradient tool It fill two colours gradually from 

one to another. 

 

Pen Tool It creates straight lined and 

smooth curved vector shapes 

and paths. 

 

Hand Tool allows you to navigate an edited 

image 

 

4.1.4 Work area Bar 

In Figure 4.1, observe the work area bar. It is a center stage where image editing is 

performed. 

4.1.5 Layer Panel 

Photoshop layer is like a sheet of stacked acetate. Observe the transparent area of layer 

to the layer below. Move a layer to position the content of layer. (Figure 4.6 (a) and (b)) 
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Fig. 4.6 (a) Multiple stacked acetate sheet 

 

Fig. 4.6 (b) Final Image 

In Photoshop, when you open/import any object then It creates a single layer. Later you 

can add multiple layers for color correction, retouching. 

Photoshop layer 

Photoshop layer is like transparent sheets where in you can draw image in different 

slide or paste the image cutout and finally the result appears in single piece of image. 

In Photoshop this transparent slide is like a layer and visibility of below layer depends 

upon the transparency of above layers. (Figure 4.7) 

 

Fig. 4.7 Different Layers in Photoshop 

Video layer 

You can use video layers to add video clip in Photoshop. After importing a video clip as 

a video layer, you can mask the layer, transform it, apply layer effects, paint on 

individual frames, or rasterize an individual frame and convert it to a standard layer. 

Use the Timeline panel to play the video within the image or to access individual 

frames. Video layer is used in Rotoscoping. (Figure 4.8) 
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Fig. 4.8 Video Layer 

4.2 Rotoscoping process in Adobe Photoshop 

After getting overview of Photoshop interface, Tools and layers, Let us now discuss about 

rotoscoping in Adobe Photoshop. As mentioned earlier there are two way to perform roto 

in Adobe Photoshop. 

Roto Animation – It is a kind of 2D animation, where you trace and paint every 

individual frame from live footage/video clip to create Animation. 

Object Separation for VFX – In this technique, you have to trace object in each frame 

and delete the rest. 

In both the cases you have to perform following steps. 

4.2.1 Import the Footage 

In both techniques, you have to require footage, which is original or exported from video 

editing software. In Chapter 7, you have learned how to export video from video editing 

software. To import still photograph for creating roto, first learn about the different 

image capturing devices mentioned as below. 

Digital Camera – To import the image from digital camera to Photoshop, you need to 

connect the digital camera with the help of USB cable or wireless connection. After 

connecting, copy your images from digital camera to your computer's hard drive in a 

specific location. You need to remember the location of file storage for future reference. 

Open the Photoshop software, and click on File > Open. The open dialog box will be 

displayed. Select the required file and click on the Open button. The image will be 

opened. 

You need to be sure to rename manipulated image before saving. Because sometimes 

the original image will be used as future reference. 

Smartphone Camera – The connection of Mobile Cameras is established as the same 

way as digital camera. 

Internet Images – After searching the required file from the internet, save the 

downloaded file in the computer's hard drive. Remember the folder name for future 

reference, as you will need the file for editing in the Photoshop. 

Scan images – A scanner is required to to scan the image. To scan the image, put the 

image facing downside in the scanner glass. Then click on File > Import and select the 

scanner source. In some case, a notification window will be displayed on the screen for 

notifying about the scanned image. In suchcase, adjust the parameters for image to be 

scanned. 
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4.2.2 Video layer used in Rotoscoping 

Once the video clip is imported in Adobe Photoshop, it creates video layers. Now let us 

create a video layer from video clip in Adobe Photoshop CC2020. 

Practical Activity 1 – Create a Video Layer from Video Clip in Adobe Photoshop 

Step 1. Open Adobe Photoshop software, a welcome screen will appear as shown in 

Figure 4.9. 

 
Fig. 4.9 Welcome Screen of Adobe Photoshop 

Step 2. Click on Create New Tab as shown in Figure 4.10. 

 
Fig. 4.10 Create New 

Step 3. Select the New Document, and Click on Create button, as shown in Figure 

4.11. 

 

Fig. 4.11 New Document 

Step 4. Adobe Photoshop software interface will open, as shown in Figure 4.12. 
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Fig. 4.12 Adobe Photoshop Interface 

Step 5. Now go to Layer > Video Layer as shown in Figure 4.1. Here you have two 

options  

(a) New video layers from file. 

(b) New blank video layer 

 

Fig. 4.13 Video Layers option in Adobe Photoshop 

Step 6. To import the video clip, select option (A). As you click on ‘New video layers 

from file’, a Open dialog box appears on screen as shown in Figure 4.14. Select the 

required video and click on ‘Open’ tab. 

 

Fig. 4.14 Open ‘Dialog box’ 

Step 7. Now video will appear on Adobe Photoshop as shown in Figure 4.15. 
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Fig. 4.15 Video is shown on workspace 

Step 4. Go to Window> Timeline, here timeline will be displayed as shown in Figure 

4.16. 

 
Fig. 4.16 Create new Timeline 

Step 9. Timeline appears below the image. Set ‘Timeline frame rate’ as shown in 

Figure 4.17 (a) & (b) and click OK. 

 

Fig. 4.17 (a) Timeline Frame Rate Setting 

 

Fig. 4.17 (b) Timeline Frame Rate dialog box 

Step 10. Now Timeline become trim and you have fewer frames to work, which saves 

your time. 

Step 11. If you want to select a blank video layer, then select option B from step 5 as 

shown in Figure 4.18. 
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Fig. 4.18 Create new Blank Video Layer 

Step 12. Blank video layer is used to trace over video clip frame by frame. Whatever you 

work in single frame is not transferred to another frame. So, you will get the next video 

frame as blank as shown in Figure 4.19. 

 

Fig. 4.19 New Blank Video Layer created 

Now you have learned about how to make a video layer. Let’s create an animation using 

required tools learned earlier in this chapter. 

Practical Activity 2 – Create an Animation from Video Clip using Adobe Photoshop. 

Material Required 

Video Clip, Adobe Photoshop Software 

Procedure 

Step 1. Start the Adobe Photoshop software and observe its welcome screen as shown 

in Figure 4.20 

 

Fig. 4.20 Welcome screen of Adobe Photoshop 

Step 2. Click on the Open button in the welcome screen to open the video file. The 

Open dialog box will be appear, as shown in Figure 4.21. Select the video clip and click 

on Open button to open the selected video clip. 
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Fig. 4.21 Select and open video clip 

Step 3. Video clip will be inserted in the timeline, as shown in Figure 4.22. 

 

Fig. 4.22 Video clip inserted into timeline 

Step 4. Click on the Frames edit box into the timeline and select set timeline Frame 

rate, as shown in Figure 4.23. 

 

Fig. 4.23 Set timeline frame rate 

Step 5. Select the desired timeline frame rate and click on Ok button. (Fig. 4.24) 

 

Fig. 4.24 Frame rate options 

Step 6. Now video clip size reduces according to selected frame rate, as shown in 

Figure 4.25. 
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Fig. 4.25 Reduces Video clip 

Step 7. After importing the video on timeline, insert a blank video layer over it. To 

insert a new blank video layer, Navigate Layer > Video Layers > New blank video 

layer, as shown in Figure 4.26. 

 

Fig. 4.26 Insert a blank video layer 

Step 4. Observe that a blank video layer is inserted in timeline as shown in Figure 

4.27. Rename it in Layer panel. 

 

Fig. 4.27 Blank video layer is inserted in timeline 

Step 9. You can magnify timeline by dragging the slider as shown in Figure 4.28. 

 

Fig. 4.28 Magnify timeline 

Step 10. Select Brush Tool, as shown in Figure 4.29. 



 

Roto Artist, Grade XI 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

127 

 

Fig. 4.29 Select brush tool 

Step 11. Set the size of the brush tool and keep the hardness 100% as shown in 

Figure 4.30. 

 

Fig. 4.30 Set the size and hardness of brush 

Step 12. Select the Brush color by clicking on Foreground color. Here, you can also 

pick the color by color picker and click OK, as shown in Figure 4.31. 

 

Fig. 4.31 Select brush colour 

Step 13. After selecting the brush colour, start tracing the outline. Rotoscoping layer 

is selected, as shown in Figure 4.32. 
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Fig. 4.32 Tracing the outline of the object 

Step 14. Use ‘Hand’ Tool to navigate different part of the frame, as shown in Figure 

4.33 

 

Fig. 4.33 Hand tool to navigate the frame 

Step 15. Now with the help of brush and hand tool, trace an outline of the frame, as 

shown in Figure 4.34. 

 

Fig. 4.34 Tracing outline of the frame 

Step 16. The first frame will be traced, as shown in Figure 4.35. 

 

Fig. 4.35 Tracing of first frame is completed 

Step 17. You can disable the layer 1 by click on eye Icon. Thus, you can display only 
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the outline of First frame, as shown in Figure 4.36. 

 

Fig. 4.36 Disable layer 1 

Step 14. Now you will move on Frame 02, as shown in Figure 4.37. 

 

Fig. 4.37 Frame 02 

Step 19. Once again, trace complete frame, as shown in Figure 4.38. 

 

Fig. 4.38 Tracing of frame 02 

Step 20. Here you can see the traced frame 02, as shown in Figure 4.39. 

 

Fig. 4.39 Frame-02 

Step 21. By this way, You can make an outline of all the frames. (Fig. 4.40) 
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Fig. 4.40 All frame have been traced 

Step 22. Once all the frame are traced, Make a new blank video layer, 

Go to Layer> Video layer> New blank video layer, as shown in Figure 4.41. 

 

Fig. 4.41 Create new blank video layer 

Step 23. It will be inserted in timeline where CTI is placed. Rename it as ‘color’ layer. 

(Fig. 4.42) 

 

Fig. 4.42 Place and rename the blank video layer 

Step 24. Slide the colour layer and place it at starting point by using Move tool, as 

shown in Figure 4.43. 
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Fig. 4.43 Blank layer is positioned at starting point 

Step 25. Now, place ‘Color’ layer below the ‘Rotoscoping’ for this, hold the left click on 

color layer and drag it below rotoscoping layer on layer, as shown in Figure 4.44. 

 

Fig. 4.44 Place colour layer below Rotoscoping layer 

Step 26. Click on ‘Magic wand’ tool and select ‘Rotoscoping’ layer. (Fig. 4.45) 

 

Fig. 4.45 Select magic wand tool 

Step 27. Use ‘Magic wand Tool’ for selecting the various part of video clip as shown in 

Figure 4.46. 
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Fig. 4.46 Selecting various parts of video clip using magic wand 

Step 24. Now select the Color layer on layer panel, as shown in Figure 4.47. 

 

Fig. 4.47 Select colour layer 

Step 29. Choose the required Foreground color by using Color Picker, as shown in 

Figure 4.48. 

 

Fig. 4.48 Select foreground colour using colour picker 

Step 30. Once color is selected, Choose Paint Bucket tool, as shown in Figure 4.49. 
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Fig. 4.49 Paint bucket tool 

Step 31. Fill the color on the selected area by paint bucket tool. You can also use the 

shortcut key Alt+ Backspace, as shown in Figure 4.50. 

 

Fig. 4.50 Fill the colour on selected area 

Step 32. Thus, you can paint First frame, as shown in Figure 4.51. 

 

Fig. 4.51 Paint first frame 

Step 33. You can also see the painted object by disable the original video layer, as 

shown in Figure 4.52. 
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Fig. 4.52 Disable original video layer 

Step 34. Insert a new layer, by click on ‘create a new layer’ in layer panel, as shown 

in Figure 4.53. 

 

Fig. 4.53 Create a new layer 

Step 35. Minimize the Timeline by sliding timeline magnification. (Fig.4.54) 

 

Fig. 4.54 Minimize the timeline 

Step 36. Trim the New layer according to another video layer and Fill white on it, as 

shown in Figure 4.55. 
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Fig. 4.55 Trim the new layer 

Step 37. Now, Fill the Color on the all frame in ‘Color Layer’, as shown in Figure 

4.56. 

 

Fig. 4.56 Fill the Color on the all frame in ‘Color Layer’ 

Step 34. At the end, disable the Rotoscoping layer, as shown in Figure 4.57. 

 

Fig. 4.57 Disable rotoscoping layer 

Exporting a video 

After finishing rotoscoping and coloring all the frames, it is required to disable 

Rotoscoping layer as shown in Figure 4.58. 
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Fig. 4.58 Hide ‘Rotoscoping layer’ 

Click on the File > Export > Render Video button from the Photoshop software and 

choose the Render options and Format as per your needs as shown in Figure 4.59. 

 

Fig. 4.59 Render Video 

After specifying the desired option of render, click on the Render button. The video file 

will be rendered as per the specifications as shown in Figure 4.60. 

 

Fig. 4.60 Render Video setting 

You can import the rendered video into After Effects for compositing and editing the 

rotoscoping file. 

4.3 Object separation for VFX 

In previous practical activity, an animation was created through live video clip. Now, we 

will separate an object from background for visual effects purpose. 
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Practical Activity 3 – Separate an object from live video using Adobe Photoshop. 

Procedure 

For importing the desired video in Adobe Photoshop, Follow step 1 – 6 from Practical 

Activity 1. 

Step 1. Select the outline of the object from Pen tool, as shown in Figure 4.61. 

 

Fig 4.61 Select the outline of the object using pen tool 

Step 2. Join the last point with first point of pen tool, as shown in Figure 4.62(a) & (b). 

Now path is completed. 

 

 

Fig 4.62 (a) & (b) Join last point with starting point 

Step 3. Now Right click on object and select ‘Make Selection’, as shown in Figure 4.63. 

 

Fig. 4.63 Right click on object and select ‘mask selection’ option 

Step 4. After Object selection, Select the ‘selection tool’ from toolbar and right click on 
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the Image. Here you select ‘Select Inverse’, as shown in Figure 4.64. 

 

Fig 4.64 Inverse selection 

Step 5. Once Inverse selection is done, Press delete tab, which will remove the 

background of Object. (Fig. 4.65) 

 

Fig 4.65 Delete the background 

Step 6. Follow these steps to all frames. At the end the object gets separated from the 

video, as shown in Figure 4.66. 

 

Fig 4.66 Delete the background of all frames 

Step 7. Now render the video to use it in Editing or compositing software. Go to, File> 

Export> Render Video (Fig. 4.67) 
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Fig 4.67 Select ‘Render video’ option 

Step 4. In Render Video dialog box, select the location, video format and other settings. 

Then click on ‘Render’, as shown in Figure 4.68. 

 

Fig 4.68 Render video setting 

Step 9. Hence, Finally the Rotoscoping object is exported in the desired format, as shown 

in Figure 4.69. This can be used for visual effects and compositing. 

 

Fig 4.69  Render video in image sequence 

Summary 

1. Photoshop is a pixel/raster base Image Editing software. 
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2. Photoshop toolbar is divided mainly in four groups- Selection tools, Retouching 

and painting, Drawing and typing, navigation tool. 

3. In Photoshop, Video layer is used for rotoscoping. 

4. Video layer can be masked, transformed, painted or rasterized in individual 

frame. 

5. You can create Roto-animation or object separation in Adobe Photoshop. 

 

CHECK YOUR PROGRESS 

A. Multiple Choice Questions 

1. Adobe Photoshop is _________ (a) Image Editing Software (b) 2D Animation 

Software (c) Vector Graphics Software (d) Video Editing Software 

2. In Adobe Photoshop, by default the tool box is placed in the ________ of user 

interface. (a) Left  (b) Right (c) Top (d) Bottom 

3. Polygonal lasso tools comes under the group of ________ in Adobe Photoshop (a) 

Selection tool (b) Retouching and Painting tool (c) Drawing and Typing tool (d) 

Navigation tool 

4. Which of the following tool select colour by taking samples from image (a) Quick 

heal tool (b) Clone stamp tool (c) Eye dropper tool (d) Magic wand tool 

5. Which of the following tool creates straight line and smooth curved vector 

shapes (a) Lasso tool (b) Pen tool (c) Crop tool (d) Magnetic Lasso tool 

6. In Photoshop, __________ gives freedom to work different part of an image 

separately. (a) layer (b) mask (c) smart object (d) gradient 

7. In photoshop, video layer is used in ______ (a) Image Editing (b) Rotoscoping (c) 

Drawing (d) Retouching 

8. Blank video layer is used for ________ over the image in Roto-animation. (a) 

Tracing and painting (b) Cropping and Motion (c) Resize (d) Retouching 

9. To display the timeline in Photoshop, Navigate to ___________. (a) File> timeline 

(b) Window > timeline (c) View> timeline (d) Image> timeline 

10. In Aobe Photoshop,Shortcut Key of Fillng the foreground color in selected area 

is _____________. (a) Alt + backspace (b) Ctrl + backspace (c) Ctrl + B (d) Ctrl + L 

B. Fill in the blanks 

C. State True or False 

1. Adobe Photoshop is a vector base software. 

2. Paint tools comes under group of drawing tools in Adobe photoshop. 

3. Move tool moves the layers and selections. 

4. Option Bar shows the option of selected tool. 

5. Colour replacement tool replaces colour of an image with changing image detail. 

D. Short answer questions 

1. What is difference between Vector image and Raster image? 

2. Draw a detailed diagram of Photoshop interface. 

3. Write down the name of tools used in Retouching and Painting. 
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4. What do you mean by Layers in Photoshop? 

5. Write down the uses of following (a) Pen tool (b) Brush tool (c) Eye Dropper tool 

(d) Paint Bucket tool 

6. What is Roto animation? 

7. List the tools which are used in Roto animation. 

8. Write down the steps of creating a video layer in Photoshop? 

9. What do you mean by timeline frame rate? Why we change it in roto animation? 

10. Write the steps of Render/Export a video from Photoshop software. 

 

 

Module 3 Rotoscoping Basics 

 

Module Overview 

 

In the second Module, you have learned about chroma key technique. In this Unit, you 

will learn about VFX techniques like motion control, encodacam and motion capture. 

Further the major rotoscoping terminology such as comp, matte, tracking, control point, 

spline, shape and many more is also discussed. It will help you to learn rotoscoping 

using the software Adobe After Effect. It is powerful motion graphics and compositing 

software used in rotoscoping. It is a layer base software such as photoshop. You will be 

able to create different shapes for rotoscoping. Further, the concept of matte will help 

to hide or reveal some part of the video footage. You will learn Masking, matte creation 

and colouring by using Adobe After Effects software. At the end, motion tracking and 

wire removal by using paint tool is also demonstrated. Motion tracking minimize the 

tedious task and helps in both rotoscoping and paint work like wire removal. 

 

Learning Outcomes 

After completing this module, you will be able to: 

• Understand key VFX techniques and rotoscoping terminologies essential for visual 

effects work. 

• Describe learn to utilize layers and the Pen tool in Adobe After Effects for creating 

and manipulating visual elements. 

• Explore the processes of masking, matte creation, and coloring in After Effects to 

enhance visual effects. 

• Demonstrate the apply rotoscoping techniques in After Effects to achieve precise 

frame-by-frame animation and visual adjustments. 

• Learn the principles and methods of motion tracking to synchronize visual effects 

with moving elements in video footage. 
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Module Structure 

Session 1: VFX Techniques and Rotoscoping Terminologies 

Session 2: Adobe After Effects – Layers and Pen tool  

Session 3: Masking, Matte Creation and Coloring in After Effects 

Session 4: Rotoscoping Technique in After Effects  

Session 5: Motion tracking  

Session 1: VFX Techniques and Rotoscoping Terminologies 

The art and craft of visual effects is known as special photographic effects, as the work 

was completed photographically on film. The creative team depend excessively on 

special optical cameras also called as optical printers. 

Visual effects work took place primarily in post-production phase although its planning 

is part of pre-production phase. Visual effects is the general category of special effects 

or special visual effects. 

Visual effects have been an integrated part of filmmaker’s toolbox since from prehistoric 

era of cinema. It was 1890s, when first time cinematographer simply cranked a handle 

on a wooden camera. 

The first ever known visual effect was created in 1895 in a short film called The 

Execution of Mary, Queen of Scots. (Figure 1.1) The film contains a scene in which an 

actress portrayed the ill-fated queen puts her head on a chopping block. A hooded 

executioner raises his axe and chopped down her head which rolled free onto the 

ground. The viewers were shocked by this cinema magic: the simple enough trickery of 

stopping the camera at the exact moment and swapping a dummy for the actress, then 

resuming. There was no awareness about jump cuts among the viewers of that era, 

which is easily recognizable by even a 10-year-old- youngster raised in today’s digital 

media environment. 

 

Fig. 1.1 Still from The Execution of Mary, Queen of Scots 

Everyone defines the visual effect differently. It is difficult to know its exact meaning. 

Even the Visual Effects Society has not come up with a satisfactory definition. But most 

of the people in the creative industry agreed on single point, that visual effects include 
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some form of image manipulation. This precept gives rise to the somewhat broader 

definition as, “A visual effect is the manipulation of moving images by photographic or 

digital means that creates a photorealistic cinematic illusion that does not exist in the 

real world”. 

1.1 Basic VFX Techniques and Equipment 

1.1.1 Blue and Green Screen 

The most common used technology in VFX world is traveling matte photography also 

known as blue and green screens or Chroma keying. Both blue and green screen cloths 

available in various shades. The choice of shades depends upon the particular creative 

usage. The best one between them are known as Digital Blue, Digital Green, and for 

television Digital Video Blue. 

The material is selected based on your budget. The standard cloth screen can be 

replaced with some other types of materials. 

• Specially prepared green or blue paint material, which can be used to paint floors 

and walls. It is better to paint complete wall rather than taking the cloth screen on 

rent. These paints are also expensive so use it carefully. 

• Mirrorplex is a hard, silvery, highly reflective plastic material that functions like a 

mirror. It can be placed on floor or hang it as a ceiling piece to reflect normal blue 

or green screen. It is useful to show full length walking of the actor on the floor. In 

such case colour of painted floor will be changed by the stage lighting. Hence 

mirrorplex reflects the pure colour of background.   

• Similar to Mirrorplex, a material called RoscoflexM (#3801) and LEE Mirror silver 

(#271) can be used. They come in 4 x 25 feet rolls and can be adhered to a smooth 

surface with a clear adhesive. 

• Blue or green leotards, gloves, and hoods to cover puppeteers or other people who 

must be in frame but need to be matted from the shot at the end. It is less costly to 

remove a green-suited puppeteer from a scene than to rotoscope out a normally 

clothed person. 

1.1.2 Motion Control 

Motion control systems requires a (i) camera (ii) motorized head, (iii) crane or dolly for 

camera movement, (iv) computer to control and operate. There is a difference between 

normal camera system and a motion control system. 

In motion control system, any part of this system including the camera shutter and 

focus can be controlled by a stepper motor. This motor is controlled by a computer 

program specially written for this purpose. Figure 1.2 shows a real time motion control 

system. Observe a curve track, motion control head, crane and camera. In this motion 

control system, all components are stepper motor driven. 



 

Roto Artist, Grade XI 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

144 

 

Fig. 1.2 Real-time Motion Control System on location with curved track 

Using Motion Control 

Some situations where motion control system plays an important role are. 

• It is used in double role shots. When an actor appears two times in the same 

scene while camera is moving. 

• It is used in dangerous scene, elements and location. For example, in a shot 

where an actor is interacting with dangerous animal, or being surrounded by an 

explosion. 

• When, required to match shots of live action with miniatures and models. Motion 

control system is also useful in shot which needs scaling with either very small 

people or giants to when camera is in motion. 

• This is used to shoot clean plate. It is a kind of blank shot before the action 

occurs on the same. It is helpful in removing wires, special rigs of an actor. 

• It is used in Table Top Photography. It is used in commercial shooting, where 

camera and product need to move in definite relation with each other. This action 

repeats in multiple passes. 

• Crowd enhancement. It is not popular now, because of the development in 

creating computer graphics people, it can be used to multiply a relatively small 

group of people in huge crowd by using same action again and again. 

• Multiple Animals. Use motion control system to achieve the appearance, that 

multiple animals of different species acted together in same shot like Babe: Pig 

in the City (1998) 

• Stop Motion Animation, means creating animation by exposing action frame by 

frame. One of application of motion control technique is to create motion. 

• It is also used to replace large portion of background. For example, in movie 

Hollow man (2000), every scene with the invisible man had to have a background 

pass to allow the compositors to fill in the background. 

1.1.3 Encoda Cam 

Encoda Cam is a real time pre-visualization system. It is a production tool which makes 

possible to record actor in real time on blue or green screen set and combine this live 

performance with previously made background. This background can be a set 

extension, 3D CGI characters, and 3D animation as shown in Figure 1.3. 
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Fig. 1.3 Encoda-Cam system from documentary Space Odyssey 

This Encoda Cam system uses same standard production crane, dollies and camera 

heads that crew are used to work. This system has several advantages. It gives an idea 

to the Director, VFX supervisor and actor to judge how adequately the digital 

background works with the action or character. It is also helpful for camera operator, 

which allows him to know the camera moves with respect to background. In this process 

editor immediately incorporate the take, which director likes in to the cut of the film as 

a placeholder till the final shot is completed. At the end, the recorded camera data sends 

to the visual effect department so that the digital artist will know the exact camera move. 

1.1.4 Motion Capture 

Motion capture is generally known as mocap. It is an evolutionary technology used in 

visual effects. It allows the VFX artist to record and capture the movements of 

performer’s body, limbs and facial expressions. It is recorded digitally in the form of data 

points that get recorded and translated by a computer. In this process the movements 

of the performer are captured by a number of special cameras. These movements are 

detected with the help of special marker attached to the performer. Any change in the 

position of the marker is captured by powerful computers.       

There are millions of data points created by computer from a single performance, that 

is used to animate a computer-generated character. It closely mimics the movement and 

expression of performer. Now, this technique has become evitable tool for the creation 

of photo realistic digital character in feature film, broadcast and video game production. 

Especially, as a substitute for human actors when it would be impossible or too 

dangerous to perform the real action such as Harry Potter and friend swhizzing through 

the air in the Quidditch matches in the HarryPotter movies, or to create imaginary 

characters that have to be animated in a more or less realistic fashion. (Figure 1.4) 

 

Fig. 1.4 Performance is captured in action on a motion capture stage 

1.2 Major Rotoscopy Terminologies 
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A Roto artist must be familiar with a set of terms and definitions. These terms helps to 

understand rotoscoping, and are necessary for success in VFX industry: 

1.2.1 Comp 

It is an abbreviation for composition. (Figure 1.5) This is a general term, used to explain 

a Roto artist’s work area which includes the timeline, viewing area, and layering and 

effects windows. In short anything that is part of interface of any visual effect’s software 

program. Generally, it is applied to Roto artists, compositors, sometimes called compers, 

and motion graphic designers. 

 

Fig. 1.5 Composition in After Effects 

1.2.2 Matte 

A black & white frame or set of frames that tells the program what is visible and what 

is not. The white color region is visible and denoted by color ID 1, black color region is 

not visible and denoted by color ID 0. Gray areas or mid tone region are visible in which 

intensity depends on their numerical position between 1 and 0 i. e. towards white and 

black respectively. Compositors often use the matte to isolate areas within the comp 

according to requirement. (Figure 1.6) 

 

Fig. 1.6 Matte 

1.2.3 Control Points 

It is also called, Simple points. Basically, these are a series of points that defines the 

position. These points are created by the users, determine the curve of the spline. These 

points are basically divided in two categories. 

Non-handled Points. It is very idle for a Roto artist to choose the option that does not 

have individual handle control. It is also known as tangent handles. This type of spline 

gives user a very limited control. It does not allow to change the angle of the incoming 

or outgoing curve, without moving the position of the point itself or its surrounding 

points, as shown in Figure 1.7. When you articulate roto in After Effects, this sort of 

point/spline is called Roto-Bezier. 
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Fig. 1.7 Non handled Point 

Handled Points. This type of point has tangent handles that allows increasing or 

decreasing the angle of the curve through the set point. Depending on the distance, the 

handles are from that point. Depending on how you treat these handled points, the 

curve through the point can be broken, as shown in Figure 1.8. 

 

Fig. 1.8 Handled Point 

1.2.4 Spline 

It is a set or group of points that is connected by a line made up of curves, as shown in 

Figure 1.1. The spline can be animated either from the individual points or the object 

as a whole. There are different kinds of splines and each program label it differently 

based the type of point used to create it. 

Fig. 1.9 Spline 

1.2.5 Shape 

A closed spline refers to the spline as a whole, not only the individual points. 

1.2.6 Edge 

This is the outside of the shape and, the most important aspect of rotoscoping. 

Fig. 1.10 (a) Shape                                        Fig. 1.10 (b) Edge 

1.2.7 Motion path 

This is the route/path taken by object on the screen. (Figure 1.11) For a roto, this path 

should be strictly defined within the X and Y. 
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Fig. 1.11 Motion path 

1.2.8 Key frame 

In timeline, user can set a specific value of the object in each frame by using key frames. 

During Roto, most of times you need to set position and opacity in particular frames 

using keyframes. 

1.2.9 Focus Object 

It is an object to be isolated from the frame or creating a matte. For example, it can be 

any person or a specific part like left arm or legs, even any particular object within frame 

like lamp-post.   

1.2.10 Tracking 

It is the process of creating position, rotation and/or scale. It transforms key- frames 

based on a scenario or an element in the footage. Tracking can be used to apply on 

resulting key-frames to a spline or set of splines. It can also be used to stabilization of 

any footage containing jitter. There are two types of tracking: 

Point Tracking – Generate key frames based on a single user-defined point within the 

footage. 

Planar Tracking – Generate key frames by tracking a number of points and treating 

them as though they were all on the same plane. 

1.2.13 Alpha Channel 

It is technically known as black & white matte. It can be embedded in certain file types 

such as Targa, TIFF, DPX and many more. Most compositing software break down the 

image into RGBA channels. That are acronyms for red, green, blue and alpha. 

1.2.14 Frame Range 

It is the length of required number of frames. It is used for whole length of the shot or 

even a specified smaller portion. 

1.2.15 Interpolation 

Process by which, the computer creates position or visibility keys between user-defined 

key frames. Whether X and Y coordinate or visibility range, the values established by 

the computer is average of the bordering key frames. 

1.2.16 Keying 

A process by which, sections of the footage are removed by singling out a visual 

constant. Mattes are created based on the hue or luminance of the image. This 
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technique is largely used when footage is shot on green screen. But, it can also be used 

in conjunction with roto. When a shot is “keyed,” the computer removes the area of the 

shot that are similar in color or brightness while keeping the unlike areas visible. 

   Fig. 1.12 (a) Chroma key technique    Fig. 1.12 (b) Matte after keying 

1.2.17 Object Mode 

While working in this mode, a Roto artist manipulates the shape as a whole, without 

altering individual points of the spline. It is suggested to work in this mode as much as 

possible. 

1.2.18 Sub-Object Mode 

This mode gives access to the individual points along the spline. It is suggested to 

manipulate splines in this mode as little as possible. However, in some situations, it 

cannot be avoided. 

Summary 

• The first ever known visual effect that seems to have existed was created in 1895 

in a short film called The Execution of Mary, Queen of Scots. 

• The most common used technology in VFX world is traveling matte photography 

also known as blue and green screens or Chroma keying. 

• In motion control system, any part of this system including the camera shutter 

and focus can be controlled by a stepper motor. This motor is controlled by a 

computer program specially written for this purpose. 

• Motion control system is mostly used in filming- Double role shots, live action 

with miniature model, clean plate, table top photography, crowd enhancement 

and stop motion animation. 

• Encoda-cam is a real time pre-visualization system. It is a production tool which 

makes it possible to record actor in real time on blue or green screen set and 

combine this live performance with previously made background. 

• Motion capture allows the VFX artist to record and capture the movements of 

performer’s body, limbs and facial expressions that is used to animate CGI 

character. 

 

CHECK YOUR PROGRESS 

A. Multiple Choice Questions 

1 A process by which sections of the footage are removed by singling out a visual 

constant is ______ (a) keying (b) framing (c) subtraction (d) illusion. 

2 A mode in which roto artist manipulates the shape as a whole, without altering 

individual points along the spline is known as (a) object mode (b) subject mode 

(c) perspective (d) linear mode. 

3 Technical name for a black & white matte is (a) alpha channel (b) gamma 

channel (c) beta channel (d) omega channel. 

4 The course an object takes on the screen is known as (a) motion path (b) track 

path (c) roto path (d) screen path. 

5 Closed Spline is known as (a) shape (b) curve (c) path (d) handle. 

B. Fill in the blanks 
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1 The first ever known visual effect that seems to have survived was created in 

___. 

2 An integrated part of the filmmaker’s creative toolbox is ___________. 

3 A tough, silvery, highly reflective plastic material that acts like a mirror is 

______. 

4 Motion control systems basically consist of a ______________. 

5 Motion capture is usually referred as ______________. 

6 Comp is an abbreviation for __________. 

7 A black-and-white frame or set of frames that tells the program what is visible 

and what isn’t is known as_______________ 

8 A set or group of points connected by a line made up of curves is called as 

_____. 

9 Shape is a _________ spline. 

10 Process of creating position, rotation, scale in short transform key frames based 

on a scenario in the footage is known as __________. 

C. State True or False 

1 The art and craft of visual effects until recently in common is known by the name 

special photographic effects. 

2 A visual effect doesn’t involve image manipulation. 

3 The leading company that supplies these screens worldwide is Composite 

Components Company of Los Angeles. 

4 It is a very expensive to eliminate a green-suited puppeteer from a scene than to 

rotoscope out a normally clothed person. 

5 This oldest of all visual effects techniques is Stop Motion Animation. 

D. Short answer questions 

1 What is the full form of VFX? 

2 What is Blue Screen and Green Screen?   

3 Write the difference between Handled and Non-Handled Points? 

4 What is Alpha Channel? 

5 Write different utilities of Keying. 

6 Define Motion Control and Motion capture. 

7 What are the key terminologies of Visual Effects. 

8 Explain the role of Compositor. 
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Session 2: Adobe After Effects – Layers and Pen tool 
 

A multiple software offers rotoscoping as a tool set. These programs are not necessarily 

rotoscoping software. Since splines are such an integral part of the compositing 

workflow, compositing programs such as Nuke, Shake, Combustion, Flame, and Adobe 

After Effects, all offer some sort of spline-based manipulation. 

2.1 Adobe After Effects 

Adobe After Effect (AE) is the most useful rotoscoping software. Its success derives from 

its many diverse applications and industry standard. After Effects software has many 

useful tools for Roto, paint, compositing, keying and motion graphics. 

In After Effects, combining different mattes is a very simple process. It is a layer based 

composting software, that is simple and concise process for changing the state of layers 

and shapes to create the consequential matte.   

Roto brush tool is an additional feature for rotoscoping in AE. This is a crucial tool 

designed to identify, separate and create mattes without using frame by frame roto. The 

software inputs from loose shape that is drawn by the user, then it automatically 

identifies the matte area and isolate the object. 

It also gives the facilitation to the selective pixels area that can be feathered, pulled in, 

or expanded. This new addition works amazingly for focus objects that don’t have too 

much change in their edges or that have limited movement. Adobe after Effects interface 

is easily customizable for whatever your specific project is needed. 

2.2 Mocha 

Tracking is a necessary tool to create mattes for a shot. But a for a major portion of the 

time, a simple point tracker is not enough to generate usable tracking data. Simply 

because the focus object which is to be isolated, does not have any single point that stay 

visible for the length of the shot or that convey an accurate rendering of that focus 

object’s motion path. Mocha is such a powerful tool when it comes to isolating elements 

and creating usable mattes for those elements. 

Mocha is one of the best dedicated tracking software that currently has the finest planar 

tracking math in the industry. It was originally designed as a planar tracker, from which 

the tracking and stabilizing data can be exported to a wide range of compositing 

programs. 

In planar tracking, an entire set of points is tracked against the singular points of 

regular trackers. The resulting tracking data is then applied to a shape or multiple 

shapes, which then follow the elements with accuracy. 

Mocha is the rotoscoping versions of different products released by Imagineering 

Systems that use planar tracking math to expedite various VFX processes. Although 

Mocha’s Roto tool set isn’t currently as robust as others, the mattes resulting from this 

program are exceptionally serviceable. 

2.3 Adobe After Effects – Layers 

The layer tab is the first part of AE interface. There are many layer types as discussed 

below. Initially they look complex, but easier to depict after practice. 

2.3.1 Shape Layer 
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Fig. 2.1 Shape layer and its control 

The Shape Layer is the first layer to practice. (Figure 2.1) Shape Layers are 2D objects 

such as a rectangle, star, or oval that are drawn with the pen tool or generated with a 

preset shape of After Effects. Shape layers have some unique properties like stroke 

(outline of the shape), fill (the inner area of the shape within the outline) and other 

properties such as corner roundness. It is used to quickly create symmetrical shapes 

and unique patterns. 

2.3.2 Solid Layer 

It is a basic version of Shape Layer, without customizable properties beyond color, 

dimensions, and standard 2D transform properties such as position, scale, and rotation. 

Hence solid layers consume less processing power than shape layers. Solid layer is a 

better choice in such a case where extra features of shape layers are not required. Solid 

layers have specific pixel dimension, as compared to shape layers. (Figure 2.2) 

 

Fig. 2.2 Solid Layer 

2.3.3 Text Layer 

Text layer allows to simply text with some standard formatting options like paragraph 

size and alignment, text spacing, kerning, color, and font. After Effects enriched text 

layer with plenty of animation option to use it over any text layer. Text layer behaves 

like a solid and shape layer. Use its 3D features that is adjusted via position, rotation 

and scale. 

2.3.4 Adjustment Layer 

An Adjustment layer attributes are almost similar to Solid Layer, but instead modifies 

all layers that are below it. Therefore, an Adjustment Layer alone seems like a blank 

image, however when placed this layer above others, its effects are applying on below 

layers. Adjustment layers have same transform properties like position, opacity and 

masks that of solid layers. (Figure 2.3) 
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Fig. 2.3 Adjustment layer 

2.3.5 Null Layer 

It is similar to Adjustment layer, but does not transfer its effects on below layers. It 

controls the transform properties of different layers when they are attached via pick 

whip. To use a null, simply use the pick whip function to attach a layer with null as 

shown in Figure 2.4. After this, any connected layer can be controlled by the null. 

Therefore, any transform adjustment on null will be reflected on attached layers except 

opacity. 

 

Fig. 2.4 Null layer 

2.3.6 Camera Layer 

A Camera Layer is like a Text Layer. Primarily it is used when compositors work on 3D 

compositions. It serves as a virtual camera which replaces the composition’s default 

perspective view. It features with an adjustable position and rotation tool. (Figure 2.5)  

Camera Layers are enhanced with adjustment just as real camera settings such as lens 

type, film size, depth of field, zoom, and other camera features that are used in camera. 

Camera layers gives the feeling of real camera. 

 

Fig. 2.5 Camera layer 

2.3.7 Light Layer 

Similar to Camera layers, light layers also exist in 3D. They provide a light source for 

other 3D layers. There are four types of light layers: 

Point Lights – The most basic Light Layer, Point Lights simply produce light from the 

position they are placed like a light bulb (Figure 2.6). 
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Fig. 2.6 Point Light 

Spot Lights – They are just what they sound like. (Figure 2.7) They cast light in one 

direction, with specified range, width, spill, and more. 

 

Fig. 2.7 Spot Light 

Ambient Lights – These lights produce a universal light source across the entire 

composition, providing flat illumination regardless of the layer’s position. (Figure 2.8) 

 

Fig. 2.8 Ambient Light 

Parallel Light – It lies between Spot and Ambient Lights. Parallel light creates even 

lighting across the entire composition like an ambient light. (Figure 2.9) However, it 

illuminates only one direction like a Spot Light. This light source, similar to Sun. 

 

Fig. 2.9 Parallel Lights 

2.4 Masking 

Masking is an integral part of any post-production work flow, whether that is still images 

in Photoshop or moving images in After Effects. Masking refers to the practice of using 

a mask to protect a specific area of an image. It is a process to utilize a gray scale image 

to define the layer below are visible or invisible and in what ratio. Portions of the layer 

can be partly visible if the value in the mask is something other than black or white. 

Masks are so immensely useful when you are working in the field of visual effects. 

2.5 Shape Layer and Pen Tool 

Shape Layer 

Shape Layer helps to draw and animate any type of shape, such as rectangle, rounded 

rectangle, square, and rounded square. Following activities will illustrate to draw some 

shapes. 

Practical Activity 1 – To Draw a Rectangle  or Rounded  rectangle Shape. 
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Step 1. Select the rectangle tool or the rounded rectangle tool in After Effects, as shown 

in Figure 2.2. 

 

Fig. 2.10 Rectangle Tool 

Step 2. To draw a rectangle or rounded rectangle, drag it diagonally, as shown in Figure 

2.11. 

 

Fig. 2.11 Drawing rectangle 

Step 3. To draw a square or rounded square, press Shift Key+ and drag it diagonally, 

as shown in Figure 2.12. 

 

Fig. 2.12 Drawing square 

Step 4. To draw a rounded rectangle or rounded square, increase or decrease the 

corner roundness before releasing the mouse button. 

Step 5. To increase or decrease the corner roundness, press the Up arrow (↑) key or 

the Down arrow (↓) key, or roll the mouse wheel forward or backward. 

Step 6. To set corner roundness to the minimum or maximum, press the Left arrow 

(←) key or the Right arrow (→) key. 

Step 7. Finish drawing by releasing the mouse button. If drawing a square or rounded 

square, release the Shift key after releasing the mouse button. 

Practical Activity 2 – To draw ellipses and circles 

Step 1. Select the ellipse tool 

Step 2. To draw an ellipse, drag diagonally. 

Step 3. To draw a circle, Shift-drag diagonally. 

Step 4. Release the mouse button to finish drawing. If drawing a circle, release the 

Shift key after releasing the mouse button. 

Practical Activity 3 – To draw polygons and stars 
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Step 1. Select the Polygon tool       or the Star tool 

Step 2. Drag to scale and rotate the polygon or star as you draw it. 

Step 3. Shift and drag to scale the polygon or star, preventing rotation. 

Step 4. To add or remove points, press the Up arrow (↑) key or Down arrow (↓) key, or 

roll the mouse wheel forward or backward, before releasing mouse button. 

Step 5. To increase or decrease the outer roundness, press the Left arrow (←) key or 

the Right arrow (→) key, before releasing mouse button. 

Step 6. To keep the inner radius of a star constant, hold the Ctrl key as you move the 

mouse to increase the outer radius. 

Step 7. To increase or decrease the inner roundness of a star, press the Page Up key 

or the Page Down key. 

Step 8. Release the mouse button to finish drawing. 

Pen Tool 

Pen tool is a path creator. You can create smooth paths that you can stroke with a 

brush or turn to a selection. This tool is effective for designing, selecting smooth 

surfaces, or layout. 

Practical Activity 4 – Create a manual Bezier path using the Pen tool. 

Step 1. Select pen tool in tool panel and the make sure Roto Bezier option deselected 

as shown in Figure 2.13. 

 

Fig. 2.13 Pen Tool 

Step 2. Click in the Composition panel where to place the first vertex, as shown in 

Figure 2.14. 

 

Fig. 2.14 First Vertex 

Step 3. Click the mouse pointer on the place the next vertex, as shown in Figure 2.15 

(a). 

 

Fig. 2.15 (a) Second Vertex 

Step 4. To create a curved segment, hold Alt key and drag the direction line handle to 

create the curve, as shown in Figure 2.15 (b). 
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Fig. 2.15 (b) Drag the direction line handle to create the curve 

Note: To reposition a vertex hold the space bar while dragging before releasing the 

mouse button. 

Step 5. The last vertex added appears as a solid square, indicating as selected. 

Previously added vertices become hollow, and deselected, on adding more vertices, as 

shown in Figure 2.16 (a). 

 

Fig. 2.16 (a) Closed Circle icon appears 

Step 6. Repeat above step until you complete the path. 

Step 7. To complete the path, you have to close it. For that place the pointer over the 

first vertex, as shown in Figure 2.16 (b). When a closed circle icon appears next to the 

pointer, click the vertex. 

 

Fig. 2.16 (b) After clicking First Vertex next to pointer 

Note – They can be closed by double-clicking the last vertex or choosing Layer > Mask 

and Shape Path > Closed. To leave the path open, activate a different tool, or press F2 

to deselect the path. 

Practical Activity 5 – Draw curved manual Bezier path segments with the Pen tool. 

Create a curved path segment by dragging direction lines. The length and direction of 

the lines determine the shape of the curve. 

Drawing the first vertex in a curved path 

Step 1. Select the Pen tool  in After Effects. 

Step 2. Place the Pen tool to begin the curve, as shown in Figure 2.17. 

 

Fig.2.17 Place the Pen tool 
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Step 3. Press Alt key on keyboard and hold the left mouse button. Convert vertex tool 

appears, as shown in Figure 2.18. 

 

Fig. 2.18 Convert vertex tool appears 

Step 4. Drag to modify the length and direction of both direction lines for a vertex, as 

shown in Figure 2.19 and then release the mouse button. 

 

Fig.2.19 Extend direction line 

Create C-shaped curve 

Step 1. To draw the curved segment, place the Pen tool at the starting point and drag 

it to another point as shown in Figure 2.20. 

 

Fig. 2.20 Place the pen tool at the end of curved segment 

Step 2. To create a C-shaped curve, drag in the opposite direction of previous step as 

shown in Figure 2.21, and then release the mouse button. 

 
Fig. 2.21 Dragging away from previous direction line 

Create a S-shaped curve 

Step 1. To create a S-shapted curve, place the pen tool at the starting point. Then 

drag it to forward direction, as shown in Figure 2.22. 

 

Fig. 2.22 Select first point 

Step 2. By holding the Alt key and press the left mouse button, and drag it in opposite 

direction, as shown in Figure 2.23. 

 

Fig. 2.23 Drag the vertex in opposite direction 
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Step 3. Continue dragging the Pen tool from different locations to create a series of 

smooth curves. 

Summary 

• Adobe after Effects (AE) is a layer based compositing software broadly used in 

rotoscoping. 

• Roto brush tool is an additional feature for rotoscoping in After Effects. 

• Mocha is one of the best tracking software of industry standard. 

• Shape layers are two dimensional objects that are drawn with the pen tool or 

generated with after effects pre-set shapes. 

• The Solid Layer is a basic version of the Shape Layer, without customizable 

properties beyond mere dimensions, color, and standard 2D transform properties 

such as position, scale, and rotation. 

• An Adjustment Layer alone looks like a blank image, but when placed above 

others; any of its effects would carry down and apply to them. 

• A Null layer controls the transform properties of different layers when it is 

attached with other layers via pick whip. 

• A camera layer is used when compositors work on 3D composition. It serves as a 

virtual camera which replaces the composition's default perspective view. 

• Masking is a process where we can utilize a gray scale image to define which parts 

of the layer below are visible or invisible and in what ratio it is visible or invisible.

  

CHECK YOUR PROGRESS 

A. Multiple Choice Questions 

1 What are the four types of Light Layers (a) Point, Parallel, Ambient, Spot. (b) Linear, 

Fall, Cone, Disperse. (c) Circular, Conical, Cylindrical, Hexagonal. (d) Box, Point, 

Cylindrical, Spot. 

2 Which of the following cannot be drawn by using Pen tool in After Effects (a) Line  

(b) Curve (c) Shape (d) Dot. 

3 Bezier is used to ______________ the curve of path. (a) control (b) handle (c) move 

(d) transform. 

4 Which tool is used to draw a circular path in Adobe After Effects (a) Ellipse Tool. 

(b) Rectangular Tool. (c) Solid Tool. (d) Circular Tool. 

5 Closed Spline is known as (a) shape (b) curve (c) path (d) handle. 

B. Fill in the blanks 

1 The most popular rotoscoping software is ___________. 

2 A new addition to After Effects is the _______________tool. 

3 A supportive tool to create mattes for a shot is ______________. 

4 In After Effects _________ is an important tool for rotoscoping. 

5 The _________ Layer is a basic version of the Shape Layer. 

6 Adjustment Layer attributes are almost similar to _________. 

7 Camera layers are enhanced with adjustment just as _________ settings. 
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8 Light layers only exist in ____. 

9 Ambient light generate a ________ light source across the entire composition. 

10 Parallel light is hybrid between Spot Lights and _____________. 

C. State True or False 

1 With the help of Shape Layer, you can create any type of shape you want to draw 

and animate 

2 Masking is not an integral part of any post-production work flow. 

3 Spot Light can cast light in any direction. 

4 Parallel light source is similar to Sun. 

5 An Adjustment Layer attributes are almost similar to Solid Layer. 

D. Short answer questions 

1 What is Shape Layer and Solid Layer? 

2 What is Null Layer?   

3 Write the difference between Point Light and Spot Light? 

4 What is Adjustment Layer? 

5 Write different utilities of Camera layer. 

6 Define Pen Tool. 

7 Draw a Curve with the Help of Pen Tool and Control its Shape with Bezier Control. 

 

Session 3. Masking, Matte Creation and Coloring in After 

Effects 

3.1 Matte Creation 

Mattes, masks, keys and alpha channels, are relating to the concept of transparency of 

an image. Matte or mask are required to hide or reveal some part of still picture or 

moving video. A matte is a mask used to blank out part of an image so that another 

image can be superimposed. Sometimes, opacity or transparency information include 

in the form of “Alpha Channel”. 

An RGB image is embedded with alpha channel, having four channels Red, Green, Blue 

and Alpha, instead of three. The Alpha channel embedded in one file is capable to dictate 

the transparency of other files. In this chapter you will understand two types of mattes 

– Luma and Alpha as well as Alpha channels. You will also come to know why you need 

to invert a matte. 

3.2 Luma Mattes 

In Luma Matte, lightness values of the matte image are the source of transparency. 

Generally, the area of the matte that is perfectly white will keep the subject completely 

opaque with fully visible. In other side, area of matte that is completely black will keep 

the subject fully transparent. In such case, black areas of the subject will disappear 

completely. (Figure 3.1) However, if some areas of the matte are gray, there will be partial 

transparency which depends upon the grayness. 
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Fig. 3.1 Luma Matte 

3.3 Alpha Mattes 

It is just like a Luma matte. It controls another image’s opacity. The difference is that 

instead of the subject using the mattes lightness values to control its opacity, the subject 

uses the built-in Alpha channel in the matte image. (Figure 3.2) 

In this instance, it will not matter if the matte image is black and white or if it is rainbow-

colored. The matte image is carrying its own transparency information in an embedded 

Alpha channel. Essentially, this built-in opacity information is passed down from the 

line to the subject image. 

 

Fig. 3.2 Alpha Matte 

Practical Activity 1 – Create Alpha and Luma Matte. 

Step 1. Create a new composition in Adobe After Effects by right click in the project 

panel and select New Composition as shown in Figure 3.3. 

 

Fig. 3.3 Create new composition 

Step 2. Now, select the required composition settings with the help of presets or 

customize the settings according to need, as shown in Figure 3.4. 
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Fig. 3.4 Composition setting 

Step 3. After selection of required presets or filling the customized values in specific 

areas click OK button as shown in Figure 3.5, to make a new composition as specified 

by the user.   

 

Fig. 3.5 Composition settings 

Step 4. Right click in composition panel and select New > Solid, (Figure 3.6) which 

generates the solid layer in composition (Figure 3.7). 

 

Fig. 3.6 Select solid layer by right click in composition panel 
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Fig. 3.7 Solid layer is created 

Step 5.  We require an image with alpha matte and Luma matte. Create an image file 

with Alpha properties in Photoshop. For this open Photoshop program and create a new 

document with the required dimension matching the dimension of composition, as 

shown in Figure 3.8. 

 

Fig. 3.8 Create a new document in Adobe Photoshop 

Step 6. Locate and select the Type tool in the Tools panel or press the T key on 

keyboard to access the Type tool. Type the text, Alpha, as shown in Figure 3.9. 

 

Fig. 3.9 Select type tool in tool panel 

Step 7.  Now select around text by simply clicking on the text layer with holding Ctrl 

key on the keyboard, as shown in Figure 3.10. 
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Fig. 3.10 Makes a selection around text 

Step 8. Go to the channel panel which shows Red Green Blue and RGB channels of 

the image you are working on, as shown in Figure 3.11. 

 

Fig. 3.11 Select Red, green and blue channel 

Step 9. With the selection on, click on the mask icon in bottom right corner, as shown 

in the Figure 3.12. It creates an alpha channel named Alpha1 in the channel panel of 

the document. 

 

Fig. 3.12 click on the mask icon in bottom right corner 

Step 10. Save the document by selecting File> Save As, which opens ‘Save as’ dialog 

box as shown in Figure 3.13. In that dialog box, choose Targa as format, it can save 

alpha or transparency information with the file. 
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Fig. 3.13 Save the document on desired location 

Step 3. Ensure to select Alpha Channels in save option of ‘Save As’ dialogue box, as 

shown in Figure 3.14. Otherwise alpha information doesn’t store in that file. 

 

Fig. 3.14 Select Alpha Channels in ‘Save as’ option 

Step 12. Now select 32 bits/pixel in ‘Targa Options’ dialog box as shown in Figure 3.15 

because 8 bits required for each color channel and extra 8 bit for alpha channel hence 

8 bits for red, 8 bits for green, 8 bits for blue and 8 bits for alpha channel thus 32 

bits/pixel required for that file and click OK to save the file. 

 

Fig. 3.15 Targa options 

Step 13. Now make another document for Luma Matte as shown in Figure 3.16. Repeat 

Step 5 & 6 and type LUMA with the help of text tool. 
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Fig. 3.16 Type Luma into the document 

Step 14. To save the document by selecting File > Save As which opens Save As dialog 

box as shown in Figure 3.17. Select JPEG format and click on Save button.   

 

Fig. 3.17 ‘Save As’ dialog box 

Step 15. Now drag slider to large file option which gives 12 values in Quality which is 

also maximum in drop down value in image option of and click OK button to save the 

document as shown in Figure 3.18. 

 

Fig. 3.18 Saving in document in JPEG options 

Step 16. Go back to After Effects and import these files into your project as shown in 

Figure 3.19. Right Click in project window and select Import > File, as shown in Figure 

3.20. 
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Fig. 3.19 Import file in Project panel 

 

Fig. 3.20 Browse file for import in After Effects 

Step 17. After Effects asks to interpret footage, as shown in Figure 3.21. Click on Guess 

button to select Pre-multiplied. Then click on OK button to import Alpha file. 

 

Fig. 3.21 Interpret footage 

Step 18.  Drag Alpha and Luma layer to the composition panel as shown in Figure 3.22 

and create a new solid layer by right click in composition panel and select New > Solid. 
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Fig. 3.22 Drag alpha and Luma image in composition 

Step 19. Select required composition settings as shown in Figure 3.23 and click OK. 

 

Fig. 3.23 Solid settings 

Step 20. To observe the working of Luma Matte, first bring Luma layer above the Red 

Solid layer on which its effects can observed. Toggle the visibility of Alpha and Luma 

layer by clicking eyeball in the leftmost corner of layer stack. Now go to track matte 

property of the solid layer and select Luma Matte “Luma.jpg”, as shown in Figure 3.24. 

 

Fig. 3.24 Place luma layer above red solid layer and use track matte option 

Step 21. The resultant image is shown in Figure 3.25. 
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Fig. 3.25 Result of luma track matte 

Step 22. Clicking on the transparency will toggle switch in comp view. Observe that 

the area shown black in the previous picture got transparent in Figure. 3.26. 

 

Fig. 3.26 Transparency toggle 

Step 23. When, you toggle the visibility of the Red solid layer and Luma.jpg gives the 

result shown in Figure 3.27. It suggests that black color means no color value for 

transparency and white color value means full color value for transparency. 

 

Fig. 3.27 Matte view 

Step 24. Now bring the Alpha layer above the Red Solid Layer and toggle the visibility 

of these layers according to Figure 3.28. 
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Fig. 3.28 Bring the Alpha layer above the Red Solid Layer 

Step 25. Now, go to track matte property of the solid layer and select Alpha Matte 

“Alpha.tga”, as shown in Figure 3.29. 

 

Fig. 3.29 Select Alpha matte into track matte property of solid layer 

Step 26. The final result is shown in Figure 3.30. 

 

Fig. 3.30 Final result of Alpha Matte 

Step 27. When, you toggle the visibility of the red solid layer and Alpha.tga, it gives the 

result as shown in Figure 3.31. 



 

Roto Artist, Grade XI 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

171 

 

Fig. 3.31 Toggle the visibility of the red solid layer and Alpha.tga 

Step 28. If you create shape layer then it also contains alpha channel, as shown in 

Figure 3.32. 

 

Fig. 3.32 Shape layers also contain Alpha channel 

Step 29. It also suggests that when create a mask then alpha channel is also generated 

with it, as shown in Figure 3.33. 

 

Fig. 3.33 Alpha view of shape layer 

Assignment 

• Select an image and add an element to the composition using Alpha Matte. 
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• Select an image and add an element to the composition using Luma Matte. 

3.4 Colour Correction 

The process of properly coloring footage is made up of three main interconnected tasks. 

Like any other formula, it is a general rule to do each of these tasks in their proper 

order, step by step. 

Digital video coloring steps: 

• Establish picture profile 

• Color correct footage 

• Color grade footage 

Colour correction is a technical process, which solves colour issues and makes the 

footage look as natural as possible. The idea behind the colour correction is to make 

colour clean and real as human eyes see them in real world. Colour grading is also 

technical however it is more related to creative aspect of colour. This process adds 

atmosphere and emotion to the shots by colorize the footage in new and often unnatural 

way by using shape tool. This tool can be found on the top tool bar of Adobe After Effects. 

Finally, the finished video is the result of the combined effort done by colour grading 

and colour correction. 

Practical Activity 2 – Change the Colour of the Car in the given video clip. 

Step 1. Open Adobe after Effects and create a new composition. Import the video clip 

by right clicking in the project panel on which color correction is required. Click 

Import > File, as shown in Figure 3.34 & 3.35. 

 

Fig. 3.34 Import File option 
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Fig. 3.35 File is imported into the After Effects 

Step 2. Create an adjustment layer with Right Click in Layer panel and select New> 

Adjustment layer, as shown in Figure 3.36. 

 

Fig. 3.36 Create Adjustment layer 

Step 3. Select Pen tool to create a mask around the area or subject onto which color 

correction is to be done, as shown in Figure 3.37. 

 

Fig. 3.37 Select Pen tool for creating mask over adjustment layer 

Step 4. Mask around the door of the car is created, as shown in Figure 3.38. 
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Fig. 3.38 Mask is created around the door of the car 

Step 5. Now apply color correction on that adjustment layer by right click on adjustment 

layer and select Effects> Color Correction> Hue/ Saturation, as shown in Figure 3.39. 

 

Fig. 3.39 ‘Hue/Saturation’ option of Colour correction 

Step 6. Go to Effects Control Panel as shown in the Figure 3.40 and adjust the Master 

hue, Saturation and Lightness according to your choice of color which needs to be 

implemented on. 

 

Fig. 3.40 Effect control panel 

Step 7. When, color change in that mask over the adjustment layer it looks like as 

shown in Figure 3.41. Now you have to subtract the window glass area for that create 

a mask around glass window with help of pen tool. 
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Fig. 3.41 Colour change in the mask over the Adjust layer 

Step 8. After creating mask right click on mask layer and select subtract as shown in 

Figure 3.42. 

 

Fig. 3.42 Subtract option 

Step 9. In the result, color corrected image looks as shown in Figure 3.43. 

 

Fig. 3.43 Final result of colour corrected door 

Step 10. Repeat Step 8 this time around the door knob in order to keep that off the 

limits to color correction as shown in Figure 3.44. 
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Fig. 3.44 Subtract the door knob mask 

Step 3. After that you can change the color of the selected area of mask to any other 

color as shown in Figure 3.45. 

 

Fig. 3.45 Select any colour of door 

Step 12. Final image after color correction will look as shown in Figure 3.46. 

 

Fig. 3.46 Colour corrected image of Car 

Assignment 3 

Select a video and apply color correction to the video according to your choice/ 

requirement.   
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Summary 

• A matte or mask is required to hide or reveal some part of video/image. 

• In Luma matte, lightness values of the matte image are the source of 

transparency. 

• The areas of the matte that are perfectly white will cause the subject to be 

completely opaque and conversely the area that is completely black will be 

transparent. If the area of the matte is gray, there will be partial transparency. 

• Alpha matte controls image opacity. In this, subject uses the built in alpha 

channel in the matte image. 

• Color correction is a technical process that solves color issues and makes 

footage appear as naturalistic as possible. 

• The color grading process adds atmosphere and emotion to shots by coloring 

footage in new, often unnatural ways. 

 

CHECK YOUR PROGRESS 

A. Multiple Choice Questions 

1 Which of the following is not used to create the transparency of an image (a) 

Matte (b) Mask (c) Key (d) Null 

2 The Alpha channel embedded in one file is used to dictate (a) Solid (b) Transpar-

ency (c) Colour (d) channel 

3 In Luma matte, source of transparency is (a) Lightness (b) Colour (c) Blackness 

(d) Contrast 

4 What is the shortcut key to access the Type tool in After Effects (a) S (b) T (c) U 

(d) V 

5 in targa file, 32bit/pixel saves each channels in (a) 8 bit (b)16 bit (c) 32 bit (d) 

64 bit 

6 If we create shape layer then it also contains (a) Luma Channel (b) Alpha chan-

nel (c) Red channel (d) Blue channel 

7 The colour grading process (a) Fix colour issues (b) Make footage naturalistic (c) 

add atmosphere and emotion (d) Make footage dramatic   

B. Fill in the blanks 

1 In alpha matte, the subject uses the built in________ in the matte image. 

2 In Photoshop, selection around text can be done by simple click on text layer 

with holding ____ key. 

3 In after effect, you need to place luma layer ______ the solid layer. 

4 In luma matte, black colour means _______. 

5 After placing alpha layer over solid layer, select______ on track matte. 

C. State True or False 

1 Mask is required, When you want to hide or reveal some part of the im-

age/video. 
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2 In luma matte, the area of the matte that is perfectly white causes the subject 

to be completely transparent. 

3 Luma control controls the opacity of other image. 

4 The first step of digital video colouring is Colour correct. 

5 For colour correction in after effects, you need to create a mask on adjustment 

layer. 

6 In After Effects, subtraction between two masks is not possible. 

D. Answer in short 

1. What is Matte creation? 

2. What is luma matte? 

3. What is Alpha matte? 

4. Distinguish between colour corrections and colour grading. 

 

Session 4. Rotoscoping Technique in After Effects 

Rotoscoping is basically a form of animation, where you can apply traditional animation 

principal. The “keyframe” is the common concept in both rotoscopy and animation. 

Generally, character animators begin a sequence by drawing the key-frames and then 

going back to smooth out “in-between” motion. 

Roto-artists draw their first mattes around a key-frame. The roto brush tool in After 

Effects can create a middle frame between key-frames automatically. In case of manual 

rotoscoping you have to create the middle frame manually. Create first and last key-

frame and then create the middle frame, as per the requirement. In this chapter, you 

will learn to draw the keyframe by using manual rotoscoping technique. 

Practical Activity 1 – Rotoscoping Water bottle by using Pen tool and key-frame 

technique. 

Step 1. Create a new composition in Adobe After effects and import the footage on which 

rotoscope work is to be done by using the command Ctrl+I, as shown in Figure 4.1. 

 

Fig 4.1 Create new composition and import footage in After Effects 

Step 2. Select the file in project window and drag and drop that file into timeline, as 

shown in Figure 4.2. 
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Fig 4.2 Drag and drop file into timeline 

Step 3. Go to Edit > Split Layer or press Ctrl+Shift+D to select desired clip from the 

footage as shown in Figure 4.3. 

 

Fig 4.3 Select split layer option in Edit menu 

Step 4. Now you got the clip in the timeline panel as shown in Figure 4.4. 

 

Fig 4.4 splitted layer in timeline 

Step 5. Left click on the top right corner of Timeline Panel and select Composition 

Settings as shown in Figure 4.5, to bring down the composition time value same as of 

clip. 
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Fig 4.5 select composition settings 

Step 6. Now change the value of frames in composition setting e.g. 150 as shown in 

Figure 4.6, which defines the duration on which the rotoscoping work to be done exactly. 

 

Fig 4.6 Change the duration in Composition Settings 

Step 7. Go to the first frame position in timeline by pressing Home button on keyboard. 

Then, click on the pen icon on the top left corner of the screen as shown in Figure 4.7. 

Click and drag the pen tool to begin outlining the object to mask out. Take time to get 

the lines just right and make sure to close the path. Do this by connecting back to the 

first node made. The mask won’t work if the path isn’t closed. The path is closed when 

a small circle appears next to the pen tool when hover over the node. 

 

Fig 4.7 Select Pen tool 

Step 8. Now go to timeline window and select the video layer, press M to open mask 

properties of the layer. Go to Properties and click the stopwatch symbol next to Mask 

path. Observe a keyframe (small diamond) appear on the timeline. To draw precise shape 

of mask, zoom up to optimum level where you can easily depict the outline of the subject, 

which is in this case is 100%. (Fig. 4.8) 
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Fig 4.8 Create mask over the object using Pen tool 

Step 9. Move seek bar 4-6 frames ahead on timeline. Observer that either an object or 

shot moves. Move the mask to make it perfectly outline the object. Adjust the path while 

making sure to observe another key frame appear on the timeline. Then, move the nodes 

around to outline the shape again. Although this process seems to be tedious, the result 

is quite satisfactory, as shown in Figure 4.9. 

 

Fig 4.9 Move the mask according to the object 

Step 10. Now for the bottle body part select pen tool and make outline around it as 

shown in Figure 4.10, which in the result, generate second mask. 

 

Fig 4.10 Create mask over bottle body 

Step 11. Now repeat Step 9 over and over. However, many frames it takes as shown in 

Figure 4.11. 
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Fig 4.11 Adjust mask according to object movement 

Step11. Now change the mask blending mode from none to add as shown in Figure 

4.12, which isolates the subject from background. You can use that rotoscoped 

animation anywhere. 

 

Fig 4.12 Change blending option of mask-1 

4.1 Roto brush and Refine brush tool 

In previous activity, the water bottle is manually extracted from the frame by manually 

drawing Bezier curve on most of the frame with some interpolation. 

However in After Effects, Roto brush tool provides an alternative faster workflow for 

object separation and matte creation. There are two option in Roto brush as shown in 

Figure 4.13. 

 
Fig. 4.13 Roto brush tool 

Roto brush tool is used to draw strokes between foreground and background element. 

After Effects uses this information to create a segmentation boundary between 

foreground and background. 

The best thing, when the object moves or changes shape from one frame to next, the 

segmentation boundary adapts the change to match the object. After creating 

segmentation boundary, you can use Refine matte properties to improve the Matte. 

Following are some basic terms must be known before using this tool. 
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Base Frame – It is the frame on which you first draw a roto brush stroke, as shown in 

Figure 4.14. 

 

Fig. 4.14 Base Frame 

Roto brush Span – When you draw a stroke on base frame then the information about 

the foreground and background is propagated forward and backward through time 

initially 20 frame forward and backward. The range of frame that is influenced by this 

base frame is called as Roto brush span as shown in Figure 4.15. The little arrow drawn 

in layer panel is showing the direction. 

Roto brush span 

 

Fig. 4.15 Roto Brush Span 

You can manually change a span duration by dragging either end of span. 

Roto Brush and Refine Matte overview and workflow 

Step 1. Activate the Roto Brush tool by pressing Alt+W. 

Step 2. Open the working layer in the Layer panel. Double-clicking a layer in the 

Timeline panel when the Roto Brush tool is active opens the layer in the Layer panel, 

as shown in Figure 4.16. 

 

Fig. 4.16 Layer is enabled on layer panel 

Step 3. Play the video in the layer panel and find-out the frame that has greatest amount 

of foreground object in the frame. This time select the first frame of the video, as shown 

in Figure 4.17. 
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Fig. 4.17 Find the appropriate frame 

Step 4. Now draw over the foreground object, when drawing a foreground stroke, the 

Roto Brush tool’s pointer become green circle with a plus sign in the middle, as shown 

in Figure 4.18. 

 

Fig. 4.18 Roto brush pointer with green circle 

Step 5. For larger brush size, press Ctrl key and drag the left mouse button. 

Step 6. Always draw the stroke down the centre of the object, not along with edge. As 

you release the mouse button, magenta outline appears around the foreground object. 

It is the segmentation boundary that separates foreground from the background, as 

shown in Figure 4.19. 

 

Fig. 4.19 Segmented boundary of the object 

Step 7. Alt+drag is used to draw a background stroke on the area to define as the 

background. When drawing a background stroke, the Roto Brush tool’s pointer becomes 

red circle with a minus sign in the middle, as shown in Figure 4.20. 
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Fig. 4.20 Roto brush pointer with red circle 

Step 8. Repeat the steps until the separation of foreground from background is not 

complete. Do the segmentation on base frame as good as possible, as shown in Figure 

4.21, because the segmentation of the other frame depends on the base frame. 

 

Fig. 4.21 Segmentation of the base frames 

Step 9. After completing, the segmentation of base frame, Press Page Down to move 

forward as shown in Figure 4.22. 

 

Fig. 4.22 Forward to other frames 

Step 10. If the segmentation boundary calculated by After Effects for the current frame 

is not up to mark, then make corrective strokes to guide After Effects what is foreground 

and what is background. Draw foreground strokes and background strokes as needed 
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to correct the segmentation. Corrective strokes propagate in one direction, away from 

the base frame, as shown in Figure 4.23. 

 

Fig. 4.23 Corrective strokes 

Step 11. Repeat these steps of moving one frame at a time and making corrective 

strokes until you have created a segmentation boundary for the entire duration that you 

want to segment, as shown in Figure 4.24 (a), (b), (c), (d). 

 

Fig. 4.24 (a) Base Frame/ First Frame 

 

Fig. 4.24 (b) Fig. 30th Frame 

 

Fig. 4.24 (c) Fig. 60th Frame 
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Fig. 4.24 (d) Fig. 120th Frame 

Step 4. You can toggle alpha overlay by clicking the Toggle alpha overlay button on 

viewer (Figure 4.25) 

 

Fig. 4.25 Alpha colour overlay 

Step 13. Observe the object in transparent background by toggle transparency grid, as 

shown in Figure 4.26. 

 

Fig. 4.26  Toggle transparency grid 

Step 14. If needed, select the refine edge tool from option bar, which is a toggle tool to 

Roto Brush Tool, as shown in Figure 4.27. 

 

Fig. 4.27 Refine edge tool 
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Step 15. This tool has the capability to soft the edge where it is used. The resultant 

image after using the Refine Edge Tool is shown in the Figure 4.28.   

 

Fig. 4.28 Resultant image after use of refine edge tool 

Step 16. After completing the task, click on the Freeze button, as shown in Figure 4.29 

in the lower-right corner of the Layer panel to cache, lock, and save the Roto Brush 

segmentation information. 

 

Fig. 4.29 Clicking on Freeze button 

Step 17. As you click on freeze button, Freezing starts frame by frame, as shown in 

Figure 4.30. 

 

Fig. 4.30 Freezing frame by frame 

Step 18. After freezing completed, you can use segmented object either in after effect 

composition or export it with alpha channel that can be used by compositor. 

Summary 

• In After Effects, you need to use Pen tool for creating different shapes. 

• Always breakdown the object in multiple shapes. 

• You can use roto brush and refine brush tool in after effects for quickly separate 
the foreground and background object. 

Assignment 1 

• In After Effects software, breakdown an object in to multiple shapes by using 

Bezier pen tool. 

• Shoot/download a video clip and extract foreground object by using Roto brush 

and refine brush tool. 
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CHECK YOUR PROGRESS 

A. Multiple Choice Questions 

1 It is Common concept in both rotoscoping and Animation (a) Frames (b) Key-

frames (c) Dots (d) Point 

2 You can get split layer option in-(a) File menu (b) Edit menu (c) Layer menu      (d) 

View menu 

3 Someone can change the value of frames in- (a) Import setting (b) Composition 

settings (c) Panel setting (d) Work area setting 

4 Move to seek bar in first frame in timeline by pressing-(a)Home button 

 (b) End button (c) J key (d) L key 

5 Roto brush tool provides an alternative faster workflow for (a) object    seperation 

(b) matte creation (c) paint (d) both a & b   

6 The range of frame that is influenced by this base frame is called as- 

(a) Refine edge frame (b) Roto brush span (c) Fine tune (d) Refine edge matte 

B. Fill in the blanks 

1 Roto-artists draw their first mattes around ________. 

2 In After Effects, press___ on keyboard to open mask properties of the layer. 

3 When the object moves or changes shape from one frame to next, the            

segmentation boundary adapts the change to ________. 

4 When you first draw a roto brush stroke, the frame on which you are drawing 

becomes __________. 

5 Activate the Roto brush tool by pressing_________ on keyboard. 

6  Refine edge tool has the capability to soften the edge. 

C. State True or False 

1 When drawing a foreground stroke, the Roto Brush tool’s pointer become green 

circle with a plus sign in the middle. 

2 Always draw the stroke along with edge, not down the centre of the object. 

3 When you are drawing a background stroke, the Roto Brush tool’s pointer       

becomes red circle with a minus sign in the middle. 

4 The segmentation of the other frame will depends on the base frame. 

5 You can watch object in transparent background by toggle Alpha boundary. 

6 After completing the task using Refine Edge tool, click on the Freeze button. 

D. Answer in short 

1 Write the use of Pen tool in Rotoscoping. 

2 What is mask in any layer? 

3 What is Roto brush tool? 

4 What is base frame? 

5 What is Refine Edge tool? 
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Session 5. Motion tracking 

Motion tracking allows to track the movement of an object. This tracking data can be 

used for the movement of another object such as text, object and many more. You can 

use this data on another layer or an effect control point also. It is also used for stabilizing 

motion, in that case the tracking data is used to animate the tracked layer to 

compensate for movement of an object in that layer. 

After Effects tracks motion by matching image data from a selected area in a frame to 

image data in each succeeding frame. You can use this data for tracking multiple object 

in same layer. 

Practical Activity 1 – Paint a window of Car using Motion tracking. 

Step 1. Create a new composition in Adobe After Effects. To do this right click in the 

project panel and select New Composition as shown in Figure 5.1 and customize the 

composition settings according to the requirement. 

 

Fig. 5.1 new composition in After Effects 

Step 2. Import the video clip on which, motion tracking and rotoscope is to be done, as 

shown in Figure 5.2. 

 

Fig. 5.2 Import file 

Step 3. Select the imported footage file. Right click on it and select Interpret Footage > 

Main, as shown in Figure 5.3. 
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Fig. 5.3 Interpret Footage 

Step 4. In Interpret Footage dialog box, Select Fields and Pulldowns > Separate 

Fields > Off  in pull down menu, as shown in Figure 5.4 & 5.5. 

 

Fig. 5.4 Field and Pull down settings 

 

Fig. 5.5 after setting upper field first into footage 

Step 5. Select the desired duration by pressing In/Out button as mentioned in the 

Figure 5.6. 
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Fig. 5.6 Select desired duration 

Step 6. Now Left click on Ripple Insert Edit as shown in Figure 5.7, which is under the 

timeline of composition window as highlighted in the picture. 

 

Fig. 5.7 Left click on Ripple Insert Edit 

Step 7. Now Right click on clip in timeline panel and select Track Motion, as shown in 

Figure 5.6. 

 

Fig. 5.6 Track motion 

Step 8. In Tracker dialog box, click checkbox named as Position, Rotation and Scale as 

mentioned in the Figure 5.7. 



 

Roto Artist, Grade XI 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

193 

 

Fig. 5.7 Tracker dialog box options 

Step 9. Select current track > tracker 1 as mentioned in Figure 5.8 and adjust the 

target area with mouse left button click a drag. 

 

Fig. 5.8 Current track selection 

Step 10. Now go to analyze and click on forward play button as shown in the Figure 

5.9, which would analyze the change in motion (position, scale, rotation) around the 

tracker region. 

 

Fig. 5.9 Analyze the video clip 

Step 11. Result of Step 10 will look like as shown in the Figure 5.10. 
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Fig. 5.10 Motion tracking result 

Step 12. Create a null object by right click in timeline panel and select New > Null 

Object, as shown in the Figure 5.10. 

 

Fig. 5.11 Create a Null object 

Step 5. Now select the null object and drag it to particular position in the composition 

as shown in Figure 5.12 & 5.13. 

 

Fig. 5.12 Drag the null object in particular position 
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Fig. 5.13 Null object is placed in particular position 

Step 14. Now click on Edit Target, as shown in Figure 5.14. 

 

Fig. 5.14 Click on Edit target 

Step 15. Select Layer > Null 1 into motion target as shown in the Figure 5.15. 

 

Fig. 5.15 Select Null 1 into motion target 

Step 16. Now go to Options. In Tracker and configure settings of Motion Tracker 

Options as mentioned in the Figure 5.16. 
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Fig. 5.16 Motion Tracker Options 

Step 17. Now click on Apply in Tracker Dialog box, as shown in the Figure 5.17. 

 

Fig. 5.17 Click on Apply button into Tracker 

Step 18. Press G on keyboard and select Pen tool. Draw the path around Door of the 

Car as shown in the Figure 5.18, which in result; make a shape layer over the video 

footage. 

 

Fig. 5.18 Select Pen tool and draw the path around door 

Step 19. Go to Parent Option in Shape Layer and Select Null 1, as shown in Figure 

5.19. 
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Fig. 5.19 Select Null-1 into parent option of shape layer-1 

Step 20. Click the Stopwatch of Path in Shape Layer 1, as shown in Figure 5.20, to 

make a key-frame in order to animate the shape layer according to motion tracker 

information. 

 

Fig. 5.20 Click the Stopwatch of Path in Shape Layer 1 

Step 21. Bring seek bar in timeline window to the last frame position as shown in Figure 

5.21 and adjust the shape layer according to the requirement. 

 

Fig. 5.21 Bring seek bar to the last frame into timeline window 

Step 22. Now go forward in timeline and adjust the shape layer path where it is required 

to adjust its shape. Make key frames to that position in the timeline which is depicted 

as shown in the Figure 5.22. 
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Fig. 5.22 Adjust the shape layer path 

Step 23. You can also change the color of the shape layer just by clicking Path fill 

swatch on option bar as shown in the Figure 5.23, which opens the Shape Fill Color 

Dialog box where you can pick any color. 

 

Fig. 5.23 Change the colour of the shape layer 

Step 24. Using Pen tool draw a shape layer over the windows glass area and change the 

setting of Shape Layer 1 as shown in the Figure 5.24. Blending mode to Linear Burn 

and Matte to inverted matte and the setting of Shape Layer 2. Make Null Object as 

Parent. In the end you get motion tracked roto object animation in After Effects. 

 

Fig. 5.24 Draw a shape layer over window glass 

Assignment 1 

Capture any video of your Choice. Change the color of the elements of the objects 

comprised in that footage with the help of Track and Roto Technique. 

5.1 Clone and paint (wire removal) 

Clone Stamp 
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The Clone Stamp tool selects and samples an area of your picture and then uses these 

pixels to paint over any marks. 

Practical Activity 2 – Remove the Television tower in the given video clip using 

motion tracking and Clone tool. 

Step 1. Create a new composition in Adobe Aafter Effects. Right click in project panel 

and select New Composition as shown in Figure 5.25. 

 

Fig. 5.25 Create a New Composition 

Step 2. To apply the wire removal or paint effect, import the desired video footage. Use 

Ctrl+I command to open the import file dialog box as shown in Figure 5.26. 

 

Fig. 5.26 Import the required footage 

Step 3. Right click on the imported clip in the Project Panel and Select New Comp from 

Selection, as shown in Figure 5.27. 
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Fig. 5.27 Select new comp from selection by right clicking on footage 

Step 4. Now select the video clip in composition window next to the timeline window 

and right click on it. Select Track Motion as shown in the Figure 5.28. 

 

Fig. 5.28 Select ‘track motion’ option 

Step 5. A tracker is generated which is shown in the composition layer and also a 

tracker dialog box opens as shown in Figure 5.29, which contains certain parameters 

to control the tracker. 

 

Fig. 5.29 Tracker dialog box 

Step 6. Now place the track points around the area which is to be removed from the 

composition or has to be painted as shown in the Figure 5.30. 
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Fig. 5.30 place the track points around the area which is to be removed 

Step 7. Click on Play button under Analyze option in Tracker dialog box as shown in 

the Figure 5.31. 

 

Fig. 5.31 Click on play button under Analyze option 

Step 8. Step 7 generated tracking points position according to the change in position 

rotation and scale of the footage which is shown in Figure 5.32. 

 

Fig. 5.32 Multiple tracking point is generated 

Step 9. Now go to Motion Source in Tracker Dialog box and select ‘none’ as shown in 

Figure 5.33. 
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Fig. 5.33 Select ‘None’ in motion source 

Step 10. Select Clone Stamp tool from Option Bar as shown in Figure 5.34 & 5.35. 

 

Fig. 5.34 Select Clone Stamp tool 

 

Fig. 5.35 Clone stamp tool in viewer 

Step 11. With the Clone Stamp tool, Select press and hold Alt key on keyboard and 

click the left mouse button near the source pixels which is to paint over the target pixel 

as shown in the Figure 5.36. 
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Fig. 5.36 Paint the object using Clone Stamp tool 

Step 12. Go to Menu Bar and Select Composition > Save Frame As > File, as shown 

in Figure 5.37. This command extracts the image from the footage and works as Clean 

Plate. 

 

Fig. 5.37 Export the clean frame 

Step 5. Command of Step 12 opens Output Module Settings dialog box, Keep the 

settings as shown in Figure 5.38 and click OK button. 

 

Fig. 5.38 Output Module Settings dialog box 

Step 14. Now set the desired storage location, image format and quality as shown in 

the Figure 5.39. 
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Fig. 5.39 Output frame settings 

Step 15. Select the video footage layer and go to Effects Control and select Paint, as 

shown in Figure 5.40. 

 

Fig. 5.40 Select paint in effect control panel 

Step 16. Import the Clean plate made in Step 14 by using Ctrl+I command. (Fig. 5.41) 

 

Fig. 5.41 Import the clean plate 

Step 17. Just use the ignore mode on interpret footage setting dialog box and click OK 

button, as shown in Figure 5.42. 
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Fig. 5.42 Interpret footage setting 

Step 18. Bring the clean plate image in timeline panel with click n drag method as 

shown in Figure 5.43. 

 

Fig. 5.43 Bring clean plate in timeline panel 

Step 19. Go to Window Option in Menu Bar and select Window > Tracker as shown 

in Figure 5.44. 

 

Fig. 5.44 Select tracker 

Step 20. In tracker dialog box select Media source as shown in Figure 5.45. 
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Fig. 5.45 Select motion source in tracker dialog box 

Step 21. Select Tracker 1 in Track Type drop down submenu under Tracker dialog 

box, as shown in Figure 5.46. 

 

Fig. 5.46 Select tracker 1 in ‘current track’ 

Step 22. Now Click Edit Target in Tracker dialog box, as shown in Figure 5.47. 

 

Fig. 5.47 Click on ‘edit target’ 

Step 23. In Motion Target dialog box select the clean plate image as shown in the 

Figure 5.48. 
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Fig. 5.48 Select clean plate in ‘Motion Target’ 

Step 24. Now Click Apply button in Tracker Dialog Box, as shown in Figure 5.49. 

 

Fig. 5.49 Click on ‘Apply’ button in Tracker dialog box 

Step 25. In Motion tracker Apply Options Select X and Y under Apply Dimensions tab 

and click OK button, as shown in Figure 5.50. 

 

Fig. 5.50 Motion tracker apply option 

Step 26. Right click on the Clean plate image layer and select Effect > Distort > 

Transform, as shown in Figure 5.51. 
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Fig. 5.51 Transform option 

Step 27. Now in Effects Control Panel under Transform effect change the rotation to 

90.5 degree, as shown in Figure 5.52. It may differ for your footage but the task is to 

made that layer vertical so that it covers the pixel to paint. 

 

Fig. 5.52 Rotation of clean plate 

Step 28. Select the image layer, right click on it and then select mode as “Difference”, 

as shown in Figure 5.53. 

 

Fig. 5.53 Select ‘Difference’ blending option 

Step 29. The Figure 5.54 shows the difference between the image and footage. Now you 

have to register the image exactly to the footage lying below the image layer. 
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Fig. 5.54 Shows the difference between image and footage 

Step 30. Now set the visibility of the footage layer to none by clicking the eye in the 

leftmost corner of the layer. And Pre-compose the clean plate image layer by selecting 

Composition > Pre-compose, as shown in the Figure 5.55. 

 

Fig. 5.55 Pre-compose the clean plate 

Step 31. In the Pre-compose dialog box choose Move all attributes into the new 

composition and click OK button, as shown in Figure 5.56. 

 

Fig. 5.56 Pre-compose dialog box 

Step 32. Now set the visibility of composed clean plate layer to off as shown in Figure 

5.57 and turn on the visibility of the video footage. 
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Fig. 5.57 Turn off the visibility of Clean Plate layer 

Step 33. Now select Paint tool from the option bar and in the Paint, Panel set the 

Duration from Constant to Single Frame, as shown in Figure 5.58. 

 

Fig. 5.58 Select the Duration ‘constant’ 

Step 34. Also set the source from the available option to the pre-composed layer as 

mentioned in the Figure 5.59. 

 

Fig. 5.59 Select Source option 

Step 35. Now with the help of Paint tool paint over the area which has to be subtracted 

from the video footage, as shown in the Figure 5.60. 
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Fig. 5.60 Paint over the area which need to be subtracted 

Step 36. Repeat Step 35 for each and every frame of the footage until you remove the 

pixels of the master footage according to your requirement and in the end the pixels 

removed from the whole footage and your footage gets clean as required. (Figure 5.61) 

 

Fig. 5.61 Final Frame 

Assignment 2 

Remove certain features/elements of a video composition using wire removal/ paint 

method of Composting in Adobe after Effects. 

Summary 

• Motion tracking helps the roto artist to track the movement of an object, after 

that you can use this tracking data for other objects. 

• Tracking data can be applied over different objects and layers. 

• Clone stamp and paint tool is used while removing wires and rigs in action 

scene. 

• Clone stamp tool selects and samples an area of your picture and later use this 

pixel to paint over any mask. 

• In wire removal, you initially create a clean plate that is used in the process. 
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CHECK YOUR PROGRESS 

A. Multiple Choice Questions 

1 The tracking data cannot be used for the movement of (a) another layer (b) 

effect control point (c) another objects (d) light layer. 

2 Which of the following is not present in tracker dialog box (a) position (b) 

rotation (c) scale (d) orientation. 

3 In After Effects, which key is used to select Pen tool. (a) V (b) H (c) Z (d) G. 

4 The colour of the shape layer can be changed by clicking _______ in option bar 

(a) Fill colour (b) Stroke colour (c) Rectangle tool (d) Refine edge tool 

5 In After Effects, you can import footage by (a) Ctrl+A (b) Ctrl+I (c) Alt+A (d) 

Ctrl+N 

B. Fill in the blanks 

1 You can link properties to tracking data using ________. 

2 One can change the_____ of video footage, by pressing IN/OUT button. 

3 Clone stamp tool select and samples an area of the______. 

4 Track camera option is available on ____________. 

C. Short answer questions 

1 What is Motion tracking? 

2 Which tool would be used in wire removal? 

3 What is clean plate image? 

 

Module 4. Maintain Healthy, Safe and Secure 

Working Environment 

 

Module Overview 

The work culture in VFX industry is different from routine office work, where working 

hours are also not fixed. Continuously working in front of the computer creates health 

problems especially in your eyes. Adopting the safe work practice in the work place, the 

productivity can be increased. 

This Unit deals with the concept of working environment in VFX industry. It focuses on 

safe working practices at work place. It explains about health-related problem caused by 

the wrong practices and its solution. It also gives the knowledge about resources required 

in workplace for smooth working. Further it explains how to deal with computer 

component and problem related to electrical hazards. It also explains workplace safety 

guidelines, workplace hazard and its control. The medical emergency situations and its 

solution is illustrated. 
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Learning Outcomes 

After completing this module, you will be able to: 

• Understand essential practices to ensure health, safety, and security in the workplace. 

• Learn how to implement and maintain quality measures to enhance workplace 

efficiency and standards. 

• Identify strategies to prevent accidents and handle emergencies effectively in the 

workplace. 

 

Module Structure  

Session 1: Health, Safety and Security at Work Place 

Session 2: Workplace Quality Measures  

Session 3. Prevent Accidents and Emergencies 

Session 1. Health, Safety and Security at Work Place 

One evening we were travelling on the busy road of Mumbai city. We were looking at the 

big and tall buildings. My friend was telling me that all these buildings hold different 

VFX companies. Suddenly we find that there was a lot of smoke coming out of the one 

building. People working in that building were running away from the building and 

shouting about the fire. Soon we find that the fire alarm was ringing and fire brigade 

vehicles along with water tanks were approaching the building. People were telling that 

there are lot of casualties and the overall damage to the building was worth of several 

lakhs. This event reminds us the importance of health and safety at the workplace. 

Fig. 1.1 Illustration of fire catches in the office building 

1.1 Introduction to health, safety and security at work place 

Every workplace accident, illness or dispute is a cost to organization, as well as a cost 

to injured individuals and their families. It is our responsibility to create a safe 

workplace. This will improve the work environment and the productivity. Employees 

have to take responsibility for their own health and safety rather than relying solely on 

the “safety officer” or management. 

Health 

Health of an employee is the state of the physical, mental and social well being. Every 

organisation must provide health and safety working environment for their employees 

at the workplace. Health of an employee must be in a good condition so that the 

employees of the organisation will not suffer from any diseases. Cleanliness at the 

workplace is mandatory. The work places must be cleaned in the morning before the 

people start working. If it is neat and clean then the people will feel happy to work in 

that environment. A proper air conditioning is mandatory to provide clean and cool air 

at the workplace. A properly filtered water facility must be available for the employees 

of the company. A fresh food cafeteria must provide the good quality food for the 

employees. This will help to maintain the health of the employee. The organisation 
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should maintain a clean wash-room facility in good condition to be used by the 

employees. 

Safety 

The work environment of the organisation must be safe. It must be free from hazards 

and risk. A hazard is the something that can cause harm to the people. A risk is a 

probability of causing harm to the people. A proper safety guidelines must be prepared 

by the company and it should be strictly followed. At regular intervals of time, the safety 

procedures must be practised by the employees. 

Security 

Every employee working in an organisation must feel that they are secured in the 

company campus. Security is a kind of freedom from any potential harm. Security 

ensures the safety of the people working in the organisation. Every organisation must 

have separate security department. This department should be responsible for various 

security such as personal safety, computer system safety, electrical safety, transport 

safety and other equipment safety. The proper security procedures will reduce liabilities, 

insurance and compensation for an organisation. This will increase the business 

revenue and will reduce the operational charges of the company. 

1.2 Policies and procedures for health, safety and security 

The Department of Information Technology (DoIT) has prepared the policy to provide 

employees with a healthy and safe work environment. 

Definition 

A health, safety and security policy are a written statement by an employer stating the 

company’s commitment for the protection of the health, safety and security of employees 

and to the public. It is an endorsed commitment by management to its employees 

regarding their health, safety and security. 

A health, safety and security program/policy contains the health, safety and security 

elements of an organization and objectives which make it possible for the company to 

achieve its goal in the protection of its workers at the workplace. 

The government has a specific section mentioned in their company laws, which states 

the minimum requirements to be followed for health, safety and security programme. 

Each employer or company should follow these requirements. Apart from that the 

company should also have their own health, safety and security committee to determine 

the hazards present at the workplace. Once these hazards are identified then their 

control measures should be specified in the health, safety and security programme.   

Reasons for Health, Safety and Security Programs or Policies in Workplace 

There are several reasons that can be specified for safety policy as given below. 

• It clearly indicates the company’s commitment for their employee’s health and 

safety; 

• It shows the performance of the business and the safety performance are 

compatible with each other; 

• It clearly states that the company is not only doing the business for profits but 

it is taking care of all its stake holders. 

• The accountability of every one working for the company is outlined for the 

workplace health, safety and security; 
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• Company can comply national policy on Occupational Health and Safety 

(OH&S) of Government of India; 

• Injuries and illness of the employees is prevented through such policy 

A typical policy of an VFX company may contain the following OH&S clauses. 

• Provide adequate resources to ensure continual improvement in its OH&S 

performance. 

• Comply with relevant OH&S legal and other requirements applicable to the 

organisation and drive for ‘beyond compliance’ leadership. 

• Set appropriate OH&S objectives & targets and conduct periodic performance 

reviews against these targets. 

• Adopt measures and processes that focus on the prevention of occupation 

related accidents, injuries, illnesses, and near-misses and strive to 

continuously improve such processes. 

• Ensure OH&S awareness and build competency associated at all levels to 

handle individual OH&S responsibilities. 

1.3 Workplace Safety Hazards 
The most common definition of hazard is ‘a danger or risk’ that is associated with 

something. Something can even be considered a hazard if it would be a trigger for 

causing another hazard to become present, which could hurt someone or something in 

the area. Workplace hazards poses potential harm to people at work, and that can cause 

damage to the work environment and everything else in it. Hazards could cause adverse 

health effects and losses of property and equipment for organizations. 

There is a common way to classify hazards, and not all these are present in all 

workplaces. In some industries like manufacturing and pharmaceuticals, there are 

biological and chemical risks that pose risks to the workers. Physical dangers are 

present as well in many industries where there is exposure to electricity, radiation, 

extreme pressures, noises and magnetic fields. On the other hand, ergonomic hazards 

are present in facilities where there are repetitive movements and where workstations 

are set up haphazardly. But it can be generalized that in all these classifications, there 

are always safety hazards that come up along with the highlighted workplace dangers. 

Physical hazards – It is the risks arising from the physical work environment – floors, 

facilities, walls, and ceilings. Physical hazards could also mean working with machinery 

and electricity-operated machines. Work processes or specific assignments could also 

qualify as areas where physical hazards are present. There is a vast list of physical 

hazards across all industries, but when we look at one specific sector, these dangers 

are also particular to the work setting. 

Falling off heights, slipping and tripping – The reasons for falling are attributed to 

faulty scaffolding and ladders, as a result of contact with electricity, and slipping or 

crashing into anything that throws the worker off balance. On the other hand, trips and 

slips happen right on lower levels, particularly the floor, on ramps and any uneven 

surface in the workplace. Various injuries result from simply tripping over things at 

work, while many more accidents take place when employees slip on the floor, from 

motorized vehicles or from scaffolding or ladders. 
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To avoid falls and slips, all things must be arranged properly. Any spilt liquid, food or 

other items such as paints must be immediately cleaned to avoid any accidents. Make 

sure there is proper lighting and all damaged equipment, stairways and light fixtures 

are repaired immediately. 

 

Electrical hazards – There are many reasons why workers get electrocuted or suffer 

from electric shock at work. For the most part, it’s due to coming in direct contact with 

live wires, or having indirect contact through a conductor. While not all electrical 

accidents lead to death, there are many life-threatening, severe and often permanent 

injuries that could result from it. At work, the common causes of electrical accidents 

are exposed, worn-out wiring, overloading of electrical outlets, ungrounded or faulty 

equipment, and unsafe use of electrical equipment. Employees must be provided basic 

knowledge of using electrical equipment and common problems. Employees must also 

be provided instructions about electrical safety such as keeping water and food items 

away from electrical equipment. Electrical staff and engineers should carry out routine 

inspections of all wiring to make sure there are no damaged or broken wires. 

Fire hazards – Each establishment must comply with housekeeping standards to 

ensure fire safety. Everyone not follows such requirements, and this leads to accidents 

resulting to fire. Such events not only damage of vital workplace equipment, stock and 

other items, and the building; it could also lead to injuries among its employees. To 

avoid fire, it is very important that safety precautions are in place. The whole 

organization must also have first response and emergency mitigation systems in place. 

Employees should be aware of all emergency exits, including fire escape routes, of the 

office building and also the locations of fire extinguishers and alarms. 

Health hazards – Health refers to the physical well-being of the workers, and this 

includes the condition of their skin, eyes, ears and all other body parts. But it also 

includes the health situation of what we cannot see upfront – their respiratory and 

cardiovascular system, and the nervous system. Hazards are present in most 

workplaces that could impact any part of the human body. For example, a noisy 

machine or factory environment could damage the sense of hearing of the workers. In 

the same manner, exposure to bright lights and toxic fumes and vapour could damage 

the eyes and nose. There are also more serious and long-term health issues arising from 

hazardous workplaces, such as damage to the lungs because of the exposure to harmful 

chemicals. 
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Potential Sources of Hazards in an Organization 

Bright light sources behind the display screen can create contrast problems, making it 

difficult to clearly see your work. Apply the following possible solutions to avoid this. 

• Use blinds or drapes on windows to eliminate bright light. Blinds and furniture 

placement should be adjusted to allow light into the room, but not directly into 

your field of view. 

• Use indirect or shielded lighting where possible and avoid intense or uneven 

lighting in your field of vision. Ensure that lamps have glare shields or shades to 

direct light away from your line of sight. 

• Reorient the workstation so bright lights from open windows are at right angles 

with the computer screen. 

• High contrast between light and dark areas of the computer screen, horizontal 

work surface, and surrounding areas can cause eye fatigue and headaches. So, 

use well-distributed diffuse light. 

Hazards using computers – Hazards while using computers include poor sitting 

postures or excessive duration of sitting in one position. These hazards may result in 

pain and strain. Making the same movement repetitively can also cause muscle fatigue. 

In addition, glare from the computer screen can be harmful to the eyes. Stretching at 

regular intervals or doing some simple yoga in your seat can mitigate such hazards. 

Handling office equipment – Improper handling of office equipment can result in 

injuries. For example, sharp-edged equipment if not handled properly, can cause cuts. 

Staff members should be trained to handle equipment properly. A relevant manual 

should be made available by the administration on handling equipment. 

Handling objects – Lifting or moving heavy items without proper procedure or 

techniques can be a source of potential hazard. Always follow approved procedure and 

proper posture for lifting or moving objects. 

Stress at work – In today’s organisations, you may encounter various stress-causing 

hazards. Long working hours can be stressful and so can aggressive conflicts or 

arguments with colleagues. Always look for ways for conflict resolution with colleagues. 

Have some relaxing hobbies for stress against long working hours. 

Working environment – Potential hazards may include poor ventilation, chairs and 

tables of inappropriate height, hard furniture, poor lighting, staff unaware of emergency 

procedures, or poor housekeeping. Hazards may also include physical or emotional 

intimidation, such as bullying or ganging up against someone. The staff should be made 

aware of organisation’s policies to fight against all the given hazards related to a working 

environment. 

Hazard Control 

Hazards that have been identified and assessed as priorities require to implement 

adequate control measures. Control measures should follow the hierarchy with a strong 

emphasis on eliminating hazards at the source, whenever possible. 

• Take all feasible measures to eliminate the hazard, for example, by substituting 

or modifying the process. 
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• If elimination is impractical or remains incomplete, take all feasible measures to 

isolate the hazard, for example, instituting engineering controls such as 

insulating noise. 

• If it is totally impossible to eliminate or isolate the hazard, its likelihood to cause 

injury should be minimized. Ensure that effective control measures are being 

applied, such as installing proper exhaust ventilation and providing personal 

protective clothing and equipment that is properly used and maintained, and 

monitoring exposure among at-risk workers 

Safety Guidelines Checklist 

• Store all cleaning chemicals in tightly closed containers in separate cupboards. 

• Throw rubbish daily. 

• Make sure all areas have proper lighting. 

• Do not wear loose clothing or jewellery when working with machines. 

• Never distract the attention of people who are working near a fire or with some 

machinery, tools or equipment. 

• Where required, wear protective items, such as goggles, safety glasses, masks, 

gloves, and hair nets. 

• Shut down all machines before leaving for the day. 

• Do not play with electrical controls or switches. 

• Do not operate machines or equipment until you have been properly trained 

and allowed to do so by your supervisor. 

• Repair torn wires or broken plugs before using any electrical equipment. 

• Do not use equipment if it smokes, sparks or looks unsafe. 

• Cover all food with a lid, plastic wrap or aluminium foil. 

• Do not smoke in ‘No Smoking’ areas. 

• Report any unsafe condition or acts to your supervisor. 

 

CHECK YOUR PROGRESS 

A. Multiple Choice Questions 

1. Workplace safety is essential in organisation (a) to avoide the accident and injury 

(b) to increase the productivity (b) to improve the work environment (d) All of the 

above (d) 

2. Which of the following is not mandatory to keep the good health of an employee 

(a) cleanliness (b) food court (c) clean and fresh air (b) clean washroom (b) 

3. The security department is not responsible for (a) personal safety (b) computer 

system and equipment safety (c) electrical safety (d) personal belongings (d) 

4. The proper security procedures will increase (a) liabilities, (b) insurance (c) 

business revenue (d) operational charges of the company. (c) 

5. Which kind of hazards can occur in VFX industry (a) biological (b) chemical (c) 

physical (d) ergonomic (d) 
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6. Which of the following can cause hazards while using computers (a) poor sitting 

postures or excessive duration of sitting in one position (b) lifting heavy object (c) 

mishandling of tools and equipment (d) improper handling of office equipment (a) 

7. Which of the following statements is likely to result in an injury to the operator? 

(a) Selecting the right tool for the job (b) Wearing safety goggles or glasses (c) Using 

a tool with loose handles (d) Keeping cutting tools sharp (c) 

8. What are the potential cause of hazards at workplace (a) poor ventilation (b) poor 

lighting (c) poor housekeeping (d) all of above (d) 

B. Fill in the blanks 

1. Health of an employee is the state of the physical, __________ and ________ well 

being. (mental, social) 

2. The work places must be cleaned in the _______ before the people start working. 

(morning) 

3. A proper ____________ provide clean and cool air at the workplace. (air 

conditioning) 

4. A fresh food cafeteria helps to maintain the ________ of the employee. (health) 

5. The work environment of the organisation must be________ and free from ________ 

and __________. (safe, hazards, risk) 

6. The proper security procedures will increase the ____________ and will reduce the 

_______________ of the company. (business revenue, operational charges) 

7. Injuries and illness of the employees is prevented through national policy on 

____________ (Occupational Health and Safety). 

8. Physical hazards occurs due to _______ (physical work environment). 

9. Electrical hazards mostly caused due to coming in direct contact with __________, 

or indirect contact through a ___________ (live wires, conductor). 

10. Hazards while using computers occurs due to _________________ or excessive 

duration of sitting in __________. (poor sitting postures, one position). 

 C. State whether True or False 

1. The employer and employees are responsible for workplace safety. (T) 

2. Any injury at work should be reported to the supervisor immediately. (T) 

3. No matter how big or small the injury; the injured person should receive medical 

attention. (T) 

4. While working with machines and equipment, employees must follow the safety 

guidelines set by the company.(T) 

5. Bright light sources behind the display screen can create contrast problems (T) 

6. Exposure to bright lights and toxic fumes and vapour could damage the mouth 

and ears. (F) 

7. The use of personal protective clothing and equipment can control the hazards 

at workplace. (T) 

8. Do not throw rubbish daily. (T) 

9. Proper handling of office equipment can result in injuries. (F) 

10. Stress at workplace can cause hazard in today’s organisation. (T) 



 

Roto Artist, Grade XI 

 

PSS Central Institute of Vocational Education, NCERT, Bhopal 

 

220 

D. Short Answer Questions 

1. Briefly explain the concept of health, safety and security at workplace. 

2. State the most important reasons for health, safety and security programs in 

workplace 

3. List out the various workplace safety hazards. 

4. List out the potential sources of hazards in an organization. 

5. List some of the VFX workplace hazards. 

6. What are the examples of potential hazards? 

7. Describe information technology workplace hazards? 

8. What are the workplace safety rules? 

9. List out different safety guidelines? 

10. Describe type of emergency with example? 

 

Session 2: Workplace Quality Measures  

In any organisation it is necessary to maintain a good air quality to improve the working 

capabilities of employees. A pollution free air is an essential requirement for any 

organisation. Also, most of the VFX companies makes use of centralised air conditioning 

system to keep the temperature of working place at pleasant level. Water pollution is 

another problem faced by many organisations. Most of the human activities makes 

water polluted. The polluted water may cause the disease. So an organisation must 

ensure to prevent air pollution or water pollution. 

Fig. 2.1 Air pollution and water pollution 

2.1 Air and water quality monitoring process 

Air and water pollution can be analysed by using several methods. There are three 

common forms of analysis – physical, chemical and biological. For such analysis 

samples can be collected in the surrounding region of the organisation. 

The water and air samples can be analysed by performing some physical, chemical and 

bilogical tests. 

The temperature and content of the sample can be easily measured. For example, the 

various gases or percentage of various gases such as oxygen, nitrogen, carbon dioxide 

present in the air can be measured. The PH value of the water can be measured through 

chemical analysis. The effect of air and water on these plants and animals is studied. 

The microbial indicators are used to monitor the health of the ecosystem. 

Guidelines for clean air and clean water. 

A proper guideline may be followed by organisation to keep the surrounding air and 

water clean. Some of the points of such guidelines can be. 

1. Air pollution is mostly caused by production of the dust, mixture of solid particles 

and gases in the surrounding air. So, avoid dust production, generation of solid 

particles and gases in the air. 
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2. Extensive use of automobile vehicles in the campus can lead to the air pollution. 

So, organisation must use limited number of vehicles to avoid air pollution. 

Practice a no vehicle day in every week. 

3. Ozone produced in the air can pollute the air. Many times, it is called as a smog. 

The generation of ozone gas must be kept at low level by the organisation. 

4. Most of the human activities makes the surrounding water polluted. The sewage 

or the waste water can also cause the water pollution. Take care that their waste 

is not mixed with the surrounding water. 

5. Extensive use of fertilizers and pesticide must be avoided as it can make the 

ground water polluted. 

2.2 Importance of cleanliness at work place 

It is always safe to keep your workplace clean to avoid hazardous. The poor handling 

and storage practices result in damages. A clean work station makes your job easier 

and more pleasant. Common areas should be cleaned up by all personnel, when 

necessary. 

• All areas must be kept neat and clean. Each employee is responsible for the 

cleanliness of their work area and all tools and equipment used. 

• Spills and breakage are to be cleaned up immediately. 

• Spaces around machines and equipment should be kept clear and clean at all 

times to permit free movement. 

• Floors should be kept clean and clear to prevent slipping and collision. 

• Lighting fixtures are to be checked regularly to permit clear vision. Faulty lights 

should be reported to administration, so that building maintenance/ facilities 

can be contacted to rectify the situation. 

2.3 OFFICE ERGONOMICS 

Ergonomics is the science concerned with designing and arranging things so that people 

can use them easily and safely. Applying ergonomics can reduce the potential for 

accidents, injury to improve performance and productivity. In an office setting, the 

repetition of a seemingly innocuous task over a period of time can cause an injury. The 

resulting injuries can be physically painful and rehabilitation can be difficult and time 

consuming. The following office ergonomics emphasize the identification of early 

warning. 

Early Warning Signs Potential Cause Try This 

Sore lower back No lumbar support Use back rest of chair, put small 

pillow or lumbar support on 

backrest of chair 

Burning in the upper 

back 

No upper back support from 

chair 

Put document holder or prop up 

so you can see without leaning 

forward 
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Stiff neck Working with head turned 

to side tilting head forward 

holding telephone between 

the ear and shoulder 

Move or raise monitor to centre 

of desk check if headset is 

available 

Sore shoulders Reaching forward for long 

periods or reaching forward 

frequently 

Move closer to the keyboard, 

Bring mouse down to level of 

keyboard or 1” higher 

Arching wrists Working with wrists 

extended too much 

repetition 

Add a wrist rest to the front of 

keyboard and mouse pad rest 

thumbs on front edge of 

keyboard so wrists can’t drop. 

Dry eyes Forget to blink Rest eyes periodically and do 

simple eye exercises 

Eye strain and sore 

eyes 

Glares from overhead lights 

or windows eye glasses not 

correct need vision check 

Re-orient your desk and 

computer so light is not directly 

behind or in front of you. 

Computer Health & Safety Tips 

With the increase use of computer, several health and safety issues related to vision, 

musculoskeletal issues, body aches and pains may occur. Many of these issues are 

preventable and if incurred are temporary. They can be resolved by adopting simple 

corrective action. 

Musculoskeletal Problems 

This problem includes different areas of your body such as neck, back, chests, arms 

shoulders and feet. It occurs because of your wrong posture, uncomfortable chair for 

sitting that is not ergonomically correct while working on the computer. (Figure 2.2) 

 

Fig 2.2 Ideal neck and monitor position 

To avoid this problem, 

• Position your computer such that the monitor end should be at your eye level. 

• Keep the neck neutral with monitor directly ahead to prevent to turn your neck. 

• Keep your monitor at least arm length distance, or 20 to 30 inch away from 

you. 
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• Maximize contact of your back against the backrest of the chair. 

• Adjust height of armrests so that your elbows are at 100-110 degrees open 

angle. 

• Place keyboard at a slight negative tilt if you are sitting upright. 

• While typing, keep your hands slightly lower than elbows, with fingers pointing 

downwards at the floor. 

• Minimize any twisting of your wrists from side to side or up and down. 

• Use a keyboard palm rest as needed only when you are not typing. Do not rest 

your wrists when typing. It leads to wrist strain. 

• Always take small breaks while working on the computer to stretch your muscles, 

keep your blood flowing, and to rest your eyes. 

Occupational Overuse Syndrome 

Occupational overuse syndrome, also known as Repetition Strain Injury (RSI), is a 

collective term for a range of conditions, characterised by discomfort or persistent pain 

in muscles, tendons and other soft tissues, with or without physical manifestations. It 

is usually caused or aggravated by work, and is associated with repetitive movement, 

sustained or constrained postures and/or forceful movements. Psycho-social factors, 

including stress in the working environment, may be important in the development of 

occupational overuse syndrome. 

Repetitive use of muscle may feel pain in your neck, shoulder, wrist or fingers. One of 

the most common conditions related to repetitive use of muscles when using the 

computer is carpal tunnel syndrome. It causes pain, numbness, and tingling in the 

hand and arm as shown in Figure 2.3. 

 

Fig 2.3 Symptoms of carpal tunnel syndrome 

Ensure that you use appropriate posture when typing. For example, your fingers should 

be above the ‘home position’ (asdf and jkl; keys) on the keyboard, when your elbows are 

by your sides. Users should avoid gripping the mouse too tightly. The keyboard and 

mouse should be kept at the same level. In addition, use of ergonomic keyboard and 

mouse help to reduce the risk of wrist related conditions. 

Strain in Legs and Feet 

Sitting to work for long time may cause strain in legs. Position your desk chair to sit 

comfortably with your feet flat on the floor and your lower legs vertical. Use a footrest 

for more support. Make sure that there’s enough space to change position and stretch 

your legs out every now and then, too. 

Eye Strain 

Computer’s bright light, glare and flickering images can cause eye strain and visual 

fatigue. When you constantly focus on screen, you forget about blinking your eyes that 

can cause of drying eyes. Computer Vision Syndrome is caused by poor lighting and 
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glare on the computer screen. Both of these factors place strain on the users eyes, 

causes blurry vision, burning and/or watering eyes, headaches and in some instances 

shoulder and neck pain. It is important to look after your eye health. Specifically wear 

anti-glare glasses to work on computer. 

To reduce the risks of visual problems: 

• Adjust the brightness of computer screen to save your eyes from strain. 

• Reposition the screen to avoid glare from lights or windows. 

• Keep proper distance from computer screen and blink your eyes in an interval. 

• Wear anti-glare glasses while working in computer. 

• Keep the screen clean and use a desk lamp to make it easier to see. 

• Ensure the screen colours are easy to look and characters are sharp & legible. 

• Give your eyes periodic breaks from the screen and perform frequent blinking. 

Look away from the screen into the distance for a few moments to relax your eyes; 

focus on something 30 metres away for 30 seconds every 30 minutes. 

• Keep your monitor between 18 to 24 inches away from your face. Lastly, position 

monitors to avoid glare from sunlight and keep them clean. 

Headaches 

Headache may occur due to muscle tension or pain in the neck. Strain on the eyes or 

vision problem can also cause headaches. Attend regular eye exams to work toward 

correcting any vision problems. Try your best to keep your neck straight in front of the 

computer and take breaks. 

Obesity 

Spending long hours on computers may lead lacks of physical activity and exercise. In 

children prolonged use of computers or electronics in general, is a major contributing 

factor to obesity. You should take a break and try to squeeze in some exercise until you 

go back to work. 

Stress Disorders 

Technology impacts our behaviors and emotions. Prolonged use of computers may be 

accompanied by poor health and increased pressure on you in your workplace, which 

may lead to stress. The longer the stress untreated, the greater the chances of 

contracting more serious health problems. Stress can lead to decreased attention span, 

lack of concentration, dizziness and becoming easily burned out. To tackle this problem, 

promote your own health and prevent future health conditions or by seeking treatment 

options for any stress that you may encounter. Try things from yoga, to natural 

remedies, to medications as prescribed by a medical provider to combat your stress. 

Injuries from Laptop Use 

The growing use of laptops cause more pain and strain. Laptops are designed for short 

periods of use. In present day individuals choose to use laptops over desktops more 

frequently, due to convenience. In laptop the screen and keyboard are very close 

together and there is really no right way to use a laptop because if you position the 

screen at the right height for your back and neck, it will cause you to have to lift your 

arms and shoulders too high to use it and vice versa. It will probably cause a problem. 
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To overcome this problem, you may use desktop that is set up ergonomically-correct, 

while working for long hours. 

Sleeping Problems 

Artificial lighting from computer screens can trick your brain and suppress its release 

of melatonin substance that assists your sleeping patterns. To tackle this, refrain from 

using a computer right before going to bed. 

Health and safety requirements for Computer workplace 

The minimum health and safety requirements for computers including Desktop 

computers, Laptops, Tablets, Smart phones, Television screens and Video monitors are 

as follows: 

Display Screen (Monitor) – Use the modern LED monitors of legible size and with 

adequate spacing between the characters and lines. The image on the screen should be 

stable, with no flickering or other forms of instability. The screen must be free of 

reflective glare and reflections liable to cause discomfort to the user. 

Keyboard – The keyboard should tilt and separate from the screen to find a comfortable 

working position and avoid fatigue in the arms or hands.  The space in front of the 

keyboard must be sufficient to provide support for the hands and arms of the user. The 

keyboard should have a matt surface to avoid reflective glare. The symbols on the keys 

must be adequately contrasted and legible from the design working position. 

Work Surface – The work desk should be sufficiently large, low-reflectance surface and 

allow a flexible arrangement of the screen, keyboard, documents and related equipment. 

The document holder shall be stable and adjustable so as to minimise the need for 

uncomfortable head and eye movements. 

Work Chair – The work chair must be stable and allow the user to move easily and find 

a comfortable position. It should be adjustable in height. The user’s feet must be placed 

flat on the floor or a footrest should be used. 

Space Requirements – The workstation should be designed to provide sufficient space 

for the user to change position and vary movements. The user should have enough desk 

space for the equipment they use. 

Lighting – There must be satisfactory lighting conditions with appropriate contrast 

between the screen and background environment. Possible disturbing glare and 

reflections on the screen or other equipment should be prevented. 

Reflections and Glare – Workstations should be designed so that sources of light, such 

as windows and other openings, transparent or translucid walls, and brightly coloured 

fixtures or walls cause no direct glare and no distracting reflections on the screen. 

Windows shall be fitted with a suitable system of adjustable covering to attenuate the 

daylight that falls on the workstation. 

Noise and Heat – Noise emitted by equipment should not distract the attention. Noise 

cancelling earphones may provide a solution if some noise is unavoidable. The 

equipment may not produce excess heat which could cause discomfort to users. 

Cautions while working on the computer 

It is important to work safely on computer. The static electricity generated just by 

walking on the carpet can damage your computer component. So, use a surge protector 

when you plug your system in. 
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A battery backup system is the best way to protect against a power outage, as it provides 

the system with constant voltage. 

Remove rings, watches and necklaces while working on the computer. These ornaments 

are often made of conductive metals which can damage Computer components by 

striking them static electricity. 

Unplug all power sources and cables from computer. If you are working with plugged in 

computer then it might damage your hardware. (Figure 2.4) Modern processors will 

overheat within 7 sec if heat sink is not attached. 

 

Fig 2.4 Unplug power source from computer 

Watch out for cords and wires 

Loose cords and wires can cause hazard and even electrical hazards as shown in Figure 

2.5. 

 

Fig 2.5 Loose cord that can be hazardous 

If a cord or wire will cross a pathway safety it should be mark it with hazard tape as 

shown in Figure 2.6. 

 

Fig. 2.6 Hazard tape 

Avoid water at all times when working with electricity. (Figure 2.7) Never touch or try 

repairing any electrical equipment or circuits with wet hands. It increases the electrical 

conductivity of the body for the flow of electric currents. 
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Fig 2.7 Avoid water while working with electricity 

CHECK YOUR PROGRESS 

A. Multiple Choice Questions 

1. Which of the following is not required in organisation to keep working 

environment healthy and safety working environment (a) Cleanliness (b) Filtered 

water (c) Clean wash-room (d) Air conditioner 

2. Production of which of the following is not responsible to cause air pollution in 

the surrounding air (a) dust (b) mixture of solid particles (c) gases (d) Air 

conditioner 

3. Repetitive use of muscle may not feel pain in your (a) neck (b) shoulder (c) wrist 

or fingers (d) eyes 

4. The security department organisation is not responsible for (a) other safety (b) 

computer system safety (c) electrical safety (d) transport safety 

5. For an organisation, the proper security procedures will reduce (a) liabilities (b) 

insurance (c) business revenue (d) operational charges of the company 

6. Do not wear ________ when working with machines. (a) jewellery (b) safety glasses, 

(c) masks (d) gloves 

7. Sore lower back cause due to (a) reaching forward frequently (b) no lumbar 

support (c) no upper back support from chair (d) reaching forward for long 

periods 

8. Sore lower back cause due to (a) reaching forward for long periods or reaching 

forward frequently (b) working with wrists extended too much repetition reaching 

forward frequently (c) no lumbar support (d) no upper back support from chair 

9. What should you do with the problem of dry eyes (a) forget to blink (b) rest eyes 

periodically and do simple eye exercises (c) do exercise (d) blink the eyes 

10. If light is coming directly behind or in front of you then you may suffer from (a) 

Eye strain (b) sore eyes (c) dry eyes (d) eye strain and sore eyes 

B. Fill in the Blanks 

1. Air and water pollution can be analysed by using – physical, _________ and 

____________ analysis. 

2. The PH value of the water can be measured through _________ analysis. 

3. The _________ indicators are used to monitor the health of the ecosystem. 

4. Ergonomics is the science concerned with _________ and arranging things. 
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5. Working with wrists extended too much repetition can cause ___________ . 

6. The repetition of a seemingly_______task over a period of time can cause an 

injury. 

7. If a cord or wire will cross a pathway safety it should be mark it with ___________ . 

8. Loose cords and wires can cause _____________ . 

9. Glare and __________ on the screen should be prevented. 

10. The keyboard should have a matt surface to avoid _______ glare. 

C. State whether True or False 

1. The work environment of the organisation must be free from hazards and risk. 

2. Practice a no vehicle day in every week to avoid air pollution. 

3. Applying ergonomics can improve performance and productivity. 

4. Wear rings, watches and necklaces while working on the computer. 

5. Never touch or try repairing any electrical equipment or circuits with wet hands. 

6. Unplug all power sources and cables from computer while working on computer. 

7. Occupational overuse syndrome, also known as repetition strain injury. 

8. The work chair must be stable and allow the user to move easily. 

9. Artificial lighting from computer screens can cause sleeping problems. 

10. The keyboard and mouse should not be kept at the same level. 

Q. 4. Short answer type questions 

1. What causes the water pollution? 

2. What is occupational overuse syndrome? 

3. What are musculoskeletal problems? 

4. What cautions to be taken while working on the computer? 

5. Why there is no right way to use a laptop? 

6. What causes eye strain and how to avoid it? 

7. What type of display screen is suitable to work on computer? 

8. What type of keyboard is suitable to work on computer? 

 

Session 3. Prevent Accidents and Emergencies 

In an organisation, any small accident or unforeseen situation may turn into 

emergencies if not given due attention. The emergencies can be natural such as floods, 

hurricanes, earthquakes or man-made emergencies may include fire, toxic gas releases, 

chemical spills, illness, explosions, and civil disturbances. Such situations may disrupt 

or shut down your operations, or may cause physical or environmental damage. While 

no one expects such emergencies and disasters that can strike anyone, anytime, 

anywhere. The best way to protect yourself, your workers, and your organisation is to 

develop a well thought-out emergency action plan to guide the employees in the event 

of an emergency. This chapter explains the general workplace hazards, its prevention, 

care and how to keep workplace safe. 

3.1 Accidents and emergencies 

An accident is an unplanned, uncontrolled, or unforeseen event resulting in injury or 

harm to people and damages to goods. For example, a person falling down and getting 

injured or a glassware item that broke upon being knocked over. Emergency is a serious 
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or crisis situation that needs immediate attention and action. For example, a customer 

having heart attack or sudden fire outbreak in organization needs immediate attention. 

Each organization has procedures and practices to handle and report accidents and to 

take care of emergencies. Although most of these procedures and practices common 

across the industry, some procedures might be modified to fit a particular type of 

business within the industry. For example, procedure to handle accidents caused by 

slipping or falling will be similar across the industry. You need to be aware of the general 

procedures and practices as well as specific to your organization. 

The following are some guidelines for identifying and reporting an accident or 

emergency: 

Notice and correctly identify accidents and emergencies – You need to be aware of 

what constitutes an emergency and what constitutes an accident in an organization. 

The organization’s policies and guidelines will be the best guide in this matter. You 

should be able to identify such incidents in your organization, and be aware of the 

procedures to tackle each form of accident and emergency. 

Get help promptly and in the most suitable way – Follow the procedure for handling 

a particular type of accident and emergency. Promptly act as per the guidelines. Ensure 

that you provide the required help and support as laid down in the policies. Do not act 

outside the guidelines and policies laid down for your role even if your actions are 

motivated by the best intention. 

Remember that only properly trained and certified professionals may be authorized to 

take decisions beyond the organization’s policies and guidelines, if the situation 

requires. 

Follow company policies and procedures for preventing further injury while 

waiting for help to arrive – If someone is injured, do not act as per your impulse or 

gut feeling. Go as per the procedures laid down by your organization’s policy for tackling 

injuries. You need to stay calm and follow the prescribed procedures. 

Act within the limits of your responsibility and authority when accidents and 

emergencies arise – Provide help and support within your authorized limit. Provide 

medical help to the injured only if you are certified to provide the necessary aid. 

Otherwise, wait for the professionals to arrive and give necessary help. 

Promptly follow instructions given by senior staff and the emergency services – 

Provide necessary services as described by the organization’s policy for your role. Also, 

follow the instructions of senior staff who are trained to handle particular situations. 

Work under their supervision when handling accidents and emergencies. 

Types of Accidents 

The following are some of commonly occurring accidents in organizations: 

Trip and fall – Customers or employees can trip on carelessly left loose material and 

fall down, such as tripping on loose wires, goods left on aisles, elevated threshold. This 

type of accident may result in simple bruises to serious fractures. 

Slip and fall – Slips are mainly due to wet floors, spilling of liquids or throwing of other 

slip-causing material on floors. Slip and fall is generally caused by negligence. It can 

also be due to broken or uneven walking surface, such as broken or loose floor tile. 

People should be properly cautioned against tripping and slipping. For example, a “wet 

floor” sign will warn people to walk carefully on freshly mopped floors. Similarly, “watch 
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your steps” signs can prevent accidents on a staircase with a sharp bent or warn against 

a loose floor tile. 

 

Injuries caused due to escalators or elevators (or lifts) – Although such injuries are 

uncommon, they mainly happen to children, ladies, and elderly. Injuries can be caused 

by falling on escalators and getting hurt. People may be injured in elevators by falling 

down due to sudden, jerking movement of elevators or by tripping on elevators’ 

threshold. They may also get stuck in elevators resulting in panic and trauma. 

Escalators and elevators should be checked regularly for proper and safe functioning by 

the right person or department. If you notice any sign of malfunctioning of escalators or 

elevators, immediately inform the right people. If organization’s procedures are not being 

followed properly for checking and maintaining these, escalate to appropriate 

authorities in the organization. 

Accidents due to falling of goods – Goods can fall on people from shelves or wall 

hangings and injure them. This typically happens if pieces of goods have been piled 

improperly or kept in an inappropriate manner. Always check that pieces of goods are 

placed properly and securely. 

Accidents due to moving objects – Moving objects, such as trolleys, can also injure 

people in the organization. In addition, improperly kept props and lighting fixtures can 

result in accidents. For example, nails coming out dangerously from props can cause 

cuts. Loosely plugged in lighting fixtures can result in electric shocks. 

3.4 Handling Accidents 

Try to avoid accidents in your organization by finding out all potential hazards and 

eliminating them. In case of an injury to a colleague due to an accident, do the following. 

Attend to the injured person immediately depending on the level and seriousness of 

the injury, see that the injured person receives first aid or medical help at the earliest. 

Inform your supervisor about the accident giving details about the probable cause of 

accident and a description of the injury. 

Assist your supervisor in investigating and finding out the actual cause of the accident. 

Help your supervisor to take appropriate actions to prevent occurrences of similar 

accidents in future. 

3.5 Types of Emergencies 

It is important to have policies and procedures to tackle the given categories of 

emergencies. You should be aware of at least the basic procedures to handle 

emergencies. Here are some general emergency handling procedures that you can 

follow: 
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First Aid. First-aid kits should be quickly accesseble to the employees. It should contain 

all the important items for first aid required to deal with common problems such as 

cuts, burns, headaches and muscle cramps. 

Electrical Safety. Employees must be provided instructions about electrical safety such 

as keeping water and food items away from electrical equipment. Electrical staff and 

engineers should carry out routine inspections of all wiring to make sure there are no 

damaged or broken wires. 

Keep a list of numbers to call during emergency, such as those of police, fire brigade, 

security, ambulance etc. 

Regularly check that all emergency handling equipment such as the fire extinguisher 

and fire alarm system are in working condition. 

Ensure that emergency exits are not obstructed and keys to such exists are easily 

accessible. Never place any objects near the emergency doors or windows 

Evacuation 

It is critical for employee to know who is the coordinator or authority to make decisions 

during emergencies. The coordinator should be responsible to handle evacuation 

process. 

General Evacuation Procedures 

Each organization has its own evacuation procedures as listed in its policies. You should 

be aware of these procedures and follow them properly during an emergency evacuation. 

In addition to organization’s policies, here are some general evacuation steps useful in 

such situations, 

• Leave the premises immediately and start moving towards nearest emergency exit. 

• Guide your customers to the emergency exits. 

• If possible, assist the person with disability to move towards the emergency exit. 

• You may carry your hand-held belongings, as you move towards the emergency exit. 

Do not come back to pick up your belongings unless the area is declared safe. 

• Do not use the escalators or elevators (lifts) to avoid overcrowding and getting 

trapped, in case there is a power failure. Use the stairs instead. 

• Go to the emergency assembly area. Check if any of your colleagues are missing 

and immediately inform the person concerned. 

Fire Hazards in the Workplace 

The first step to fire safety is assessing the existence of fire hazards in workplace. In 

most facilities, there are three main types of hazards to evaluate – electrical hazards, 

combustible materials, and flammable materials. 

Electrical issues, such as damaged extension cords, blocked electrical panels and 

heaters, and overloaded circuits often lead to fires. Fires are also commonly caused by 

electrical events such as arc flash. Maintenance of power cords and other electrical 

equipment should be conducted on a regular basis. 

Workplace fires are also commonly caused by improper storage of flammable material 

or combustible dust. Both are dangerous and should be properly handled and stored. 

Dust explosions can be another cause of fire hazard. 

Fire Prevention 
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• All employees must know where the fire extinguishers are located, and how to 

properly use them. 

• Fire extinguishers and First Aid Stations should be clearly marked with signs. 

• Never block access to Exits, fire extinguishers, electric switches and panels. 

• Do not block or stack material against doors, which would prevent them from 

operating properly in event of a fire. 

• Do not use flammable material near electrical panels, switches, lift trucks or any 

electrical equipment. 

• Make sure all equipment is properly grounded where needed. 

• Fire extinguishers must be inspected regularly. 

• Report to your supervisor any defect in electrical, fire prevention or material 

handling equipment. 

• No flammable materials are to be placed around an exit door way. 

Identification of Materials and Ignition Sources 

Materials are classified by risk, and are sorted according to these fire classifications: 

Class A Materials – materials such as wood, cloth, and paper, which won’t ignite on 

their own but will continue to burn once exposed to a heat source. 

Class B Materials – all liquid, grease, and gas materials that burn when exposed to 

ignition sources. 

Class C Materials – electrical materials and equipment. These materials cause fires very 

quickly and present a serious risk of arc flash. 

Class D Materials – any materials that are volatile and able to quickly ignite, such as 

magnesium, potassium, and sodium. 

Examples of ignition sources include: 

Open flames such as gas ovens, lighters in smoking areas, and welding torches. 

Sparks from wood or metal saws and other types of equipment. 

Heat sources such as combustion engines, space heaters, ovens, and machines that 

produce heat during operation. 

Chemical ignition from chemicals that combust under normal working temperatures. 

Select the suitable type of fire extinguisher 

 Water CO2 Dry chemical 

powder 

Carbon 

dioxide 

Mechanical 

foam 

ABC dry 

powder 

Class A Suitable Not suitable Not suitable Suitable Suitable 

Class B Not suitable Suitable Suitable Suitable Suitable 

Class C Not suitable Suitable Suitable Not suitable Suitable 

Class D Not suitable Suitable Not suitable Not suitable Suitable 

Fire Extinguisher 
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A fire extinguisher is a protection device used to extinguish fires. It is a cylindrical 

pressure vessel containing an agent which can be discharged to extinguish a fire. The 

Figure 3.2 shows the different parts of fire extinguisher. 

 

Fig 3.2 Fire extinguisher with its parts labeled 

The following activity will demonstrate the operation of fire extinguisher. 

Practical Activity – Demonstrate the operation of a fire extinguisher. 

Procedure 

Step 1: Identify the safety pin of the fire extinguisher, present in its handle. 

Step 2: Break the seal and pull the safety pin from the handle. 

Step 3: Use the fire extinguisher by squeezing the lever. 

Step 4: Sweep it from side to side. It is shown in Figure 3.3. 

 

Fig 3.3 Steps to open the seal and safety pin 

First Aid for Electrical Emergencies 

Electrical accidents cause countless injuries. Injury could be minimised and many lives 

can be saved if proper rescue techniques and treatment are used. Electrical accidents 

may occur at any time or place. Timely response and treatment of victims is a major 

concern. When an electrical accident occurs, due to the effect of muscle cramping, a 

victim is often incapable of moving or releasing the electrical conductor. There should 

always be an emergency response plan for scheduled electrical maintenance or work. 

(Figure 3.4) 
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Fig. 3.4 An unconscious state because of an electrical shock 

Electrical Rescue Techniques 

Approaching the accident 

• Never rush into an accident situation. 

• Call 108 as soon as possible. 

• Approach the accident place cautiously. 

Examining the scene 

• Visually examine victims to determine if they are in contact with energised 

conductors. 

• Metal surfaces, objects near the victim itself may be energised. 

• Do not touch the victim or conductive surfaces while they are energised. 

• Switch off the electrical circuits if possible. 

Hazards and solutions 

• Be alert for hazards, such as heated surfaces and fire etc. 

• In case you cannot switch off the power source, take extreme care. 

• Ensure that your hands and feet are dry. 

• Wear protective equipment, such as gloves and shoes. Stand on a clean dry 

surface. 

• Use non-conductive material to remove a victim from the conductor. 

High voltage rescue 

• Special training is required for rescues if high voltage is present. (Figure 3.5) 

• Protective equipment, such as gloves and shoes must be worn. (Figure 3.6) 

           

Fig 3.5 Beware of high voltage   Fig 3.6 Gloves and shoes for safety 

First Aid 

• A victim may require Cardio-Pulmonary Resuscitation (CPR). Steps to perform in 

CPR are shown in the Figure 3.7 and 3.8. 
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Fig 3.7 Open the mouth for airway  Fig 3.8 Rescue breathing 

• If the victim is breathing and has a heartbeat, give first aid for injuries and treat 

for shock. 

• Ensure the victim gets medical care as soon as possible. 

• Physician attending the victim must have detailed information to properly 

diagnose and care for the victim.   

Assignment 

Identify and name the steps mentioned in the following figures. 

 

 

CHECK YOUR PROGRESS 

A. Multiple Choice Questions 

1. What are the steps necessary for operating a fire extinguisher? (a) Identify the 

safety pin of the fire extinguisher which is generally present in its handle (b) 

Break the seal and pull the safety pin from the handle (c) Use the fire extinguisher 

by squeezing the lever (d) All of the above (d) 

2. Which of the following is an examples of ignition sources of open flames (a) gas 

ovens (b) lighters in smoking areas (c) welding torches (d) All of the above (d) 

3. In fire classification, all liquid, grease, and gas materials comes under (a) Class 

A materials (b) Class B materials (c) Class C materials (d) Class A materials (b) 

4. In fire classification, materials magnesium, potassium, and sodium comes under 

(a) Class A materials (b) Class B materials (c) Class C materials (d) Class D 

materials (d) 

5. In fire classification, materials wood, cloth, and paper comes under (a) Class A 

materials (b) Class B materials (c) Class C materials (d) Class D materials (a) 
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6. In fire classification, electrical material and equipment comes under (a) Class A 

materials (b) Class B materials (c) Class C materials (d) Class D materials (c) 

7. When do we use a fire extinguisher? (a) In case of flood (b) In case of electric 

shock (c) In case of fire (d) In case of burn injury (c) 

8. What is the primary fire emergency telephone number is? (a) 011 (b) 101 (c) 108 

(d) 111 (b) 

9. Which of the following contains everything you need to know about evacuating 

your facility safely (a) Evacuation Diagram (b) Emergency Action Plan (c) 

Employee Directory (d) Both a and b (d) 

10. The best course of action to take during a medical emergency is to (a) Begin 

first aid immediately (b) Activate the emergency plan for reporting injuries (c) 

Notify the person's family about the situation (d) Both a and b (d) 

B. Fill in the blanks 

1. Emergency is a serious or crisis situation that needs__________attention and 

________.   

2. A ______ sign will warn people to walk carefully on freshly mopped floors.  

3. ____________ signs can prevent accidents on a staircase with a sharp bent or warn 

against a loose floor tile.  

4. The ___________ should be responsible to handle evacuation process.  

5. Workplace fires are commonly caused by improper storage of ______________ 

material or _________ dust. 

6. There should always be an _________________ plan for scheduled electrical 

maintenance or work.  

7. If the victim is breathing and has a heartbeat, give ________ for injuries and treat 

for shock.  

8. A fire extinguisher is a _________________ containing an agent which can be 

discharged to extinguish a fire.  

C. State True or False 

1. The organization’s policies and guidelines is the best guide to handle emergency. 

2. If someone is injured, act as per your impulse or gut feeling. 

3. Keep water and food items away from electrical equipment. 

4. Always switch off the electrical circuits. 

5. Always wear protective equipment, such as gloves and shoes. 

6. A fire extinguisher is a protection device used to extinguish fires. 

7. Flammable materials can be placed around an door exit. 

8. You can determine possible evacuation routes from floor plan diagrams posted 

in your facility. 

D. Short Answer Questions 

1. What is a workplace emergency? 

2. How do you protect yourself, your employees, and your business? 

3. What is an emergency action plan? 
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4. What should your emergency action plan include? 

5. How do you develop an evacuation policy and procedures? 

6. How do you establish evacuation routes and exits? 

7. What are the various types of fire extinguisher and their extinguishing 

material? 

8. What are the steps for operating a fire extinguisher in case of a fire emergency. 

9. Compare the different type of fire extinguisher. 

10. List the different class of fire. 

11. List out electrical rescue techniques? 

12. What is the first aid for electrical emergencies? 

 

 

 

Vocabulary Words 

Mock Drill/Fire Drill – Practice how to respond/react in case of an emergency, such as 

a fire 

Fire Extinguisher – A small container usually filled with special chemicals for putting 

out a fire. 

Exit – The way to go out of a building or room 

First Aid Kit – A container, which has medicines and ointments 

Fire Escape Route – The way out in case of a fire 

Emergency – A sudden, urgent and unexpected event 

Spilt Liquid – Soft drink/water/coffee/tea etc. that has fallen on the floor 

Routine inspections – Regular checking 

Damaged equipment – Torn wires or broken plugs 

Stairways – Staircase/ stairs to go to the next floor 

Light fixtures – Bulbs, tube lights etc. 

Injury – Getting hurt/bleeding 

Kitchen equipment – Vessels used in the kitchen, such as wok, knives, cutting board 

Cleaning Supplies – Liquid soap, dish washing liquid etc. 
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Glossary 

2D animation: Art of creating movement in two dimension space. It includes characters, 

creatures, Visual effects and background. 

3D animation: Process of creating three dimensional moving pictures in digital 

environment. Some popular 3d animation includes Pixar’s toy story, Robots in 

transformers. 

Alpha matte: It creates the matte using alpha channel. 

Analog signal: Continuous signal; Here one time-varying quantity (such as voltage, 

pressure, etc.) represents another time-based variable. 

Animatic: A series of images edited together with dialogues and sound is called 

animatic. 

Animation: Method of capturing consecutive drawings, models, puppets movement, to 

create an illusion of motion in a sequence. 

Aspect Ratio: Ratio of horizontal length with respect to its vertical width. 

Background Painting: An artwork done in the background of an animation is called 

background painting. 

Bin- In the Premiere Pro project panel, bins serve as file folders to hold and organize 

your media assets. Bins can hold any combination of media: video, audio, still images, 

and even other bins. 

Bitrate: Bitrate means the number of bits per second. It determines the size and quality 

of video and audio files; higher the bitrate provides better quality with larger file size. 

Camera Sensor: a solid-state device which captures the light and converts it in to 

digital image. 

CEL: It is a cellulose sheet used to paint characters. In practice, it is now a day. Plastic 

sheet in combination with the outline and coloring of a character, object, and/or special 

effect. 

CGI (Computer Generated Imagery): Creation of three dimensional still graphics and 

animated visuals with computer software. It is most commonly used in creating 

characters, scenes and special effects in films and video games. 

Clean-Up: The process of refining the rough artwork of 2D animation is called Clean-

up. 

Compositing: Combining different layers and object in to a single video frame. 

Composition: Positioning character with respect to the background and camera is 

called composition. 

Digital Signal: When the signal becomes discrete, both the time and amplitude domain. 

Generally, it is represented in binary form. 

DPX File: Digital Picture exchange file; Kodak developed .dpx file extension for digital 

intermediate and visual effects works. DPX files have a collection of still images. 

Frame: Individual picture/still from a sequence of video or film. 
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Frame Rate: rate of change of still frames in an animation is called frame rate. It is 

measured in frames per second (fps). 

Graphics Tablet: This is a device used to draw sketches. 

Key Frame: Beginning and end poses for a particular animation sequence are called 

key frames. 

Keying: Special compositing effect. This Technique is used widely to remove the 

background based on colour, luminance and even mask. 

Luma Matte: it creates the matte based on luminance of the layer. 

Matte: Matte is used in filmmaking to combine two or more still/video elements in to 

single frame. 

Modeling: Creation of three-dimensional models for animation using specialized 

software is called modeling. 

Non-volatile storage: type of computer memory that do not require continuous power 

supply to retain data. Some examples are SSD, USB sticks, and memory cards. 

NTSC: National Television Standards Committee; It is a standard video format used in 

the United States, Japan and many other countries. NTSC picture is made up of 525 

interlaced lines and is displayed at a rate of 29.97 frames per second. 

PAL: Phase Alternate Line; It is video format standards used in many European 

countries. It is made up of 525 interlaced lines and is displayed at a rate of 29.97 frames 

per second. 

Pixel: The smallest indivisible portion of an image is called pixel. 

ProRes 422: It is high quality lossy video compression format developed by Apple. 

ProRes is a line of intermediate codecs, which means they are intended for use during 

video editing. 

ProRes 4444: It is extremely high quality version of ProRes. This codec features full 

resolution, mastering quality RGBA colour. 

Raster: Rastering is the projections of various pixels on CRT screen to form an image. 

Rasterize: Rasterizing converts a vector layer to pixels in Photoshop. 

Rendering: Conversion of 3D models into two-dimensional images with 3D effects is 

called rendering. 

Rigging: Process of adding joints to a static three-dimensional model to aid movement 

during posing is called rigging. 

Rotoscoping: Creation and manipulation of background images of an animation is 

called rotoscoping. This can be done manually as well as using computer software. 

Script: Written document used to create any video or audio programs; basically it is a 

chronological run-down of scenes, shots, action and dialogue. 

Stereoscopic: technique for creating or enhancing the illusion of depth in an image by 

means of stereopsis for binocular vision. Two offset images separately present to the left 
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and right eye of the viewer. These two-dimensional images are then combined in the 

brain to give the perception of 3D depth. 

Storyboard: Visual representation of film sequence, which is breakdown in individual 

boxes. 

Surge protector: device designed to protect electrical devices from voltage spikes. 

Travelling Matte: to mask the shapes of moving objects, such as human beings. This 

technique allows actors to find themselves in imaginary situations like in space ships, 

flying through the air and many more. 

Title Cards: Title cards are also called FIR of an animation. Title cards give brief 

information about the animation. 

Tween: The transition of one frame to another in animation is called tween. 

Vector: Some of the artwork is created by vectors rather than pixels. This allows cleaner 

and smoother animation because images are displayed by mathematical equation 

solutions. 
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Answer 
 

Module 1. Rotoscopy Technique 

Session 1. Animation and Visual Effects 

A. Multiple Choice Questions 

1. (d) 2. (a) 3. (d) 4. (c) 5. (a) 6. (b) 7. (b) 8. (b) 9. (a) 10. (a) 

B. Fill in the Blanks 

(1) Post (2) 1500-2000 (3) 17.2 (4) 90 (5) Technicolor India (6) Classic comic strip Lot-

pot (7) 75 Crore (8) Digital ink and Paint artist (9) Morphing Artist (10) Rigging Artist 

C. State True or False 

1. (F) 2. (T) 3. (F) 4. (F) 5. (T) 6. (F) 

 

Session 2. Post Production Process 

A. Multiple Choice Question 

1. (a) 2. (b) 3. (b) 4. (b) 5. (b) 6. (b) 7. (a) 8. (a) 9. (b) 10. (b) 

B. Fill in the Blanks 

(1) Pre-Production (2) Server, Storage device (3) Project (4) Technical specification and 

response (5) Per second (6) Motion control (7) Left, Right side (8) 99 (9) Digital versatile 

disc (10) BD RE 

C. True or False 

1. (F) 2. (F) 3. (T) 4. (F) 5. (F) 6. (T) 7. (F) 8. (F) 9. (T) 10. (F) 

 

Session3. Rotoscopy – Past, present and future 

A. Multiple Choice Question 

1. (c) 2. (d) 3. (b) 4. (a) 5. (b) 6. (b) 7. (b) 8. (a) 9. (c) 10. (d) 

B. Fill in the Blanks 

(1) Quirino Cristiani (2) Speed up (3) 1917 (4) Return of Jedi (5) 3 Month (6) Light saber 

effect (7) Bob Sabiston (8) Undone 

True or False 

1. (F) 2. (T) 3. (T) 4. (F) 5. (F) 

 

Session4. Roto Artist – Roles and Responsibility 

A. Multiple Choice Question 

1. (d) 2. (a) 3. (b) 4. (d) 5. (b) 6. (a) 7. (b) 8. (a) 9. (d) 10. (d) 11. (c) 12. (b) 

Fill in the Blanks 

(1) Video Stream (2) Digital Single lens Reflex Camera (3) Extreme close up (4) VOB (5) 

Coder, Decoder (6) Video (7) Society of motion pictures and television editors (8) Height 

(9) 1.85:1 

C. True or False 
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1. (T) 2. (T) 3. (T) 4.(T) 5. (F) 6. (T) 7. (T) 8. (T) 

Module 2. Creative and Technical Requirement 

Session 2. Raw Footage – Tools and Technique 

A. Multiple Choice Question 

1. (d) 2. (a) 3. (b) 4. (c) 5. (c) 6. (a) 7. (d) 8. (d) 9. (d) 10. (b) 

Fill in the Blanks 

(1) Matte (2) Visual Effects (3) 20 to 25% (3) Chroma key (4) Green, Blue (5) Chroma key 

(6) Background 

C. State True or False 

1. (T) 2. (T) 3. (F) 4. (F) 5. (T) 6. (F) 

D. Match the column 

1. (d) 2. (a) 3. (b) 4. (e) 5. (c) 

 

Session 3. Rotoscoping Software 

A. Multiple Choice Questions 

1. (c) 2. (b) 3. (a) 4. (b) 5. (b) 6. (b) 7. (d) 8. (b) 9. (c) 10. (c) 

B. Fill in the Blanks 

(1) 1990s (2) Compositing (3) Natural Footage (4) Moving object (5) A Matte 

C. True or False 

1. (F) 2. (T) 3. (T) 4. (T) 5. (T) 

 

Session 4. Rotoscoping in Adobe Photoshop 

A. Multiple Choice Question 

1. (a) 2. (a) 3. (a) 4. (c) 5. (b) 6. (a) 7. (b) 8. (a) 9. (b) 10. (a) 

B. Identify the Image and Match it. 

1. (b) 2. (d) 3. (e) 4. (a) 5. (c) 

C. True or False 

1.(F) 2.(F) 3.(T) 4.(T) 5.(F) 

 

Module 3. Rotoscoping Basics 

Session 1. VFX Techniques and Rotoscoping Terminologies 

A. Multiple Choice Questions 

1. (a) 2. (b) 3. (a) 4. (a) 5. (a) 

B. Fill in the Blanks 

(1) The execution of Mary, queen of scots (2) Visual Effects (3) Mirrorplex (4) A Computer 

(5) Mocap (6) Composition (7) Matte (8) Spline (9) Closed (10) Tracking 

C. True or False 

1. (T) 2. (F) 3. (T) 4. (T) 5. (T) 

 

Session 2. Adobe After Effects – Layers and Pen tool 
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A. Multiple Choice Question 

1. (a) 2. (d) 3. (a) 4. (a) 5. (c) 

B. Fill in the Blanks 

(1) After Effects (2) Roto brush (3) Tracking (4) Shape layer (5) Solid (6) Solid layer (7) 

Real camera (8) 3D (9) Universal (10) Ambient light 

C. True or False 

1. (T) 2. (F) 3. (F) 4. (T) 5. (T) 

 

Session 3. Masking, Matte Creation and Coloring in After Effects 

A. Multiple Choice Questions 

1. (d) 2.(b) 3.(a) 4.(b) 5.(a) 6.(b) 7.(c) 

B. Fill in the Blanks 

(1) Alpha channel (2) Ctrl (3) Above (4) Fully transparent (5) Alpha matte 

C. True or False 

1. (T) 2. (F) 3. (T) 4. (F) 5. (T) 6. (F) 

 

Session 4. Rotoscoping Technique in After Effects 

A. Multiple Choice Questions 

1. (b) 2. (b) 3. (b) 4. (a) 5. (d) 6. (b) 

B. Fill in the Blanks 

(1) Key-frames (2) M (3) Match the object (4) Base frame (5) Alt+W (6) Soften the edge 

C. True or False 

1. (T) 2. (F) 3. (T) 4. (T) 5. (F) 6. (T) 

 

Session 5. Motion tracking 

A. Multiple Choice Questions 

1. (d) 2. (d) 3.(c) 4. (a) 5.(b) 

B. Fill in the Blanks 

(1) Expression (2) Duration (3) Picture (4) Tracker dialog box 

 

Module 4. Maintain Healthy, Safe and Secure Working Environment 

Session 1. Health, Safety and Security at Work Place 

A. Multiple Choice questions 

1. (d) 2. (b) 3. (d) 4. (c) 5. (d) 6. (a) 7. (c) 8. (d) 

B. Fill in the blanks 

1. mental, social 2. morning 3. air conditioning 4. health 5. safe, hazards, risk 6. 

business revenue, operational charges 7. Occupational Health and Safety 8. physical 

work environment 9. live wires, conductor 10. poor sitting postures, one position 

C. State True or False 

1. T 2. T 3. T 4. T 5. T 6. F 7. T 8. T 9. F 10. T 
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Session 2. Workplace Quality Measures 

A. Multiple Choice questions 

1. (b) 2. (d) 3. (b) 4. (c) 5. (b) 6. (c) 7. (b) 8. (a) 9. (c) 10. (c) 

B. Fill in the blanks 

1. chemical, biological 2. chemical 3. microbial 4. designing 5. arching wrists 6. 

innocuous 7. hazard tape 8. electrical hazards 9. reflections 10. reflective 

C. State True or False 

1. T 2. T 3. T 4. F 5. T 6. F 7. T 8. T 9.T 10. F 

 

Session 3. Prevent Accidents and Emergencies 

A. Multiple Choice questions 

1. (d) 2. (d) 3. (b) 4. (d) 5. (a) 6. (c) 7. (c) 8. (b) 9. (d) 10. (d) 

B. Fill in the blanks 

1. immediate, action 2. wet floor 3. watch your steps 4. coordinator 5.  flammable, 

combustible 6. emergency response 7.  first aid 8.  cylindrical pressure vessel 

C. State True or False 

1. T 2. F 3. T 4. F 5. F 6. T 7. F 8. T 

 

 

 

 

 

 


